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ภาพที่ 2-13 ภาพแสดงแถบเครื่องมือจัดรูปแบบของโปรแกรมไมโครซอฟท์ 

เอกซ์เซล 

22 

ภาพที่ 2-14 ภาพแสดงเสน้โค้งเบซิเยร์ อันดับ 1 35 

ภาพที่ 2-15 ภาพแสดงเสน้โค้งเบซิเยร์ อันดับ 2 37 

ภาพที่ 2-16 ภาพแสดงความตอ่เน่ืองแบบ 0 0,C G       41 

ภาพที่ 2-17 ภาพแสดงการต่อเน่ืองแบบ 1C  ( 1C -Continuity) 42 

ภาพที่ 2-18 ภาพแสดงการต่อเน่ืองแบบ 1G  ( 1G  -Continuity) 42 

ภาพที่ 2-19 ภาพแสดงความตอ่เน่ืองแบบและราบเรียบแบบ 1C  43 

ภาพที่ 2-20 ภาพแสดงความตอ่เน่ืองแบบและราบเรียบแบบ 1G  43 

ภาพที่ 2-21 ภาพแสดงจุดเอกพจน์ 44 

ภาพที่ 2-22 ภาพแสดงจุดปลายแหลม 44 
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สารบัญภาพ (ต่อ) 

 หน้า 

ภาพที่ 2-23 ภาพแสดงจุดมุม 44 

ภาพที่ 2-24 ภาพแสดงจุดเปลี่ยนเว้า 45 

ภาพที่ 2-25 ภาพแสดงจุดเปลี่ยน 45 

ภาพที่ 2-26 ภาพแสดงมุมระหว่างเวกเตอร์ 46 

ภาพที่ 2-27 ภาพแสดงเสน้โค้งในการปิดล้อมวัตถุที่พิจารณาจาก จุดเอกพจน์,  

จุดปลายแหลม, จุดมุม, จุดเปลี่ยนเว้า และจุดเปลี่ยน 

49 

ภาพที่ 2-28 ภาพแสดงเสน้โค้งออฟเซ็ตของเสน้โค้งเบซิเยร์  อันดับ 2 50 

ภาพที่ 2-29 ภาพแสดงการหมุนของพิกัดจุด 2 มิติรอบจุดก าเนดิ 50 

ภาพที่ 2-30 ภาพแสดงเสน้โค้งปิด 52 

ภาพที่ 2-31 ภาพแสดงเสน้โค้งอยา่งง่าย 52 

ภาพที่ 2-32 ภาพแสดงที่ไมใ่ช่เสน้โค้งอยา่งง่าย 52 

ภาพที่ 2-33 ภาพแสดงเสน้โค้งราบเรียบเป็นส่วน ๆ 53 

ภาพที่ 2-34 ภาพแสดงโดเมนที่ต่อเน่ือง 53 

ภาพที่ 2-35 ภาพแสดงโดเมนที่ไมต่่อเน่ือง 53 

ภาพที่ 2-36 ภาพแสดงโดเมนที่ต่อเน่ืองอย่างง่าย 54 

ภาพที่ 2-37 ภาพแสดงโดเมนที่ต่อเน่ืองทวีคูณ 54 

ภาพที่ 2-38 ภาพแสดงสนามเวกเตอร์ 1 1ˆ ˆ( , )
2 2

F x y yi xj      56 

ภาพที่ 2-39 ภาพแสดงสนามเวกเตอร์ 1 3ˆ ˆ( , )
2 2

F x y yi xj    57 

ภาพที่ 2-40 ภาพแสดงสนามเวกเตอร์ ˆ ˆ( , )F x y yi xj    58 

ภาพที่ 2-41 ภาพแสดงบรเิวณ R 58 

ภาพที่ 2-42 ภาพแสดงสนามเวกเตอร์ ( , ) ˆx yF xj   59 

ภาพที่ 2-43 ภาพแสดงสนามเวกเตอร์ ( , ) ˆx yF yi    62 

ภาพที่ 2-44 ภาพแสดงสนามเวกเตอร์ 1 1ˆ ˆ( , )
2 2

F x y yi xj    64 

ภาพที่ 2-45 ภาพแสดงพ้ืนที่แบบรูปหลายเหลี่ยม 68 

ภาพที่ 2-46 ภาพแสดงพ้ืนที่แบบรูปหลายเหลี่ยมและเสน้โค้ง 68 
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สารบัญภาพ (ต่อ) 

 หน้า 

ภาพที่ 3-1 แบบชุดเดรสกระโปรงทรงสอบ 70 

ภาพที่ 3-2 แบบชุดเดรสกระโปรงทรงบาน 71 

ภาพที่ 3-3 โปรแกรมเบลนเดอร ์ 71 

ภาพที่ 3-4 การลบวัตถุ 72 

ภาพที่ 3-5 น าแบบชุดที่ออกแบบในกระดาษลงในโปรแกรมเบลนเดอร ์ 73 

ภาพที่ 3-6 ลากเสน้โค้งเบซิเยร์ตามแบบชุด 74 

ภาพที่ 3-7 ลากเสน้โค้งเบซิเยร์ตามแบบชุดคร่ึงชุด 75 

ภาพที่ 3-8 สร้างพ้ืนผิว 76 

ภาพที่ 3-9 การใส่สีและสะท้อนชุดเดรสกระโปรงทรงสอบดา้นหนา้ 77 

ภาพที่ 3-10 แบบชุดเดรสกระโปรงทรงสอบด้านหนา้ท าการออกแบบจาก

โปรแกรมเบลนเดอร์ 

78 

ภาพที่ 3-11 แบบชุดเดรสกระโปรงทรงสอบดา้นหลังท าการออกแบบจาก

โปรแกรมเบลนเดอร์ 

78 

ภาพที่ 3-12 โปรแกรมเบลนเดอร์ 79 

ภาพที่ 3-13 การลบวัตถุ 80 

ภาพที่ 3-14 น าแบบชุดที่ออกแบบในกระดาษลงในโปรแกรมเบลนเดอร์ 81 

ภาพที่ 3-15 ลากเสน้โค้งเบซิเยร์ตามแบบชุด 82 

ภาพที่  3-16 ลากเสน้โค้งเบซิเยร์ตามแบบชุดคร่ึงชุด 83 

ภาพที่ 3-17 สร้างพ้ืนผิว 84 

ภาพที่ 3-18 การใส่สีและสะท้อนเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 85 
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สารบัญภาพ (ต่อ) 

 หน้า 

ภาพที่ 3-19 แบบเสือ้ดา้นหนา้ของชุดเดรสกระโปรงทรงบานท าการออกแบบจาก

โปรแกรมเบลนเดอร์ 

86 

ภาพที่ 3-20 แบบเสื้อด้านหลังของชุดเดรสกระโปรงทรงบานท าการออกแบบจาก

โปรแกรมเบลนเดอร์ 

86 

ภาพที่ 3-21 โปรแกรมเบลนเดอร์ 87 

ภาพที่ 3-22 การลบวัตถุ 88 

ภาพที่ 3-23 น าแบบกระโปรงที่ออกแบบในกระดาษใส่ในโปรแกรมเบลนเดอร์ 89 

ภาพที่ 3-24 ลากเสน้โค้งเบซิเยร์ตามแบบชุด 90 

ภาพที่ 3-25 สร้างพ้ืนผิว 91 

ภาพที่ 3-26 เพ่ิมหน้าและปรับขนาดตามแบบชุด 92 

ภาพที่ 3-27 การใส่สี 92 

ภาพที่ 3-28 แบบกระโปรงของชุดเดรสกระโปรงทรงบานท าการออกแบบจาก

โปรแกรมเบลนเดอร์ 

93 

ภาพที่ 3-29 โปรแกรมเบลนเดอร์ 93 

ภาพที่ 3-30 หุ่น 94 

ภาพที่ 3-31 การน าแบบชุดลงในโปรแกรมเบลนเดอร์ 94 

ภาพที่ 3-32 จัดวัตถุ (Plane) ให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบดา้นหนา้ 95 

ภาพที่ 3-33 การสะท้อนชุด 96 

ภาพที่ 3-34 สร้าง Loop Cut 97 

ภาพที่ 3-35 ลบหน้าและลบจุด 97 

ภาพที่ 3-36 สร้างหน้าขึ้นใหม่ 98 

ภาพที่ 3-37 เพ่ิมจุด 98 

ภาพที่ 3-38 ลบหน้าและสร้างหน้าขึ้นมาใหม่ 98 

ภาพที่ 3-39 จัดจุดให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบดา้นหนา้ 99 
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สารบัญภาพ (ต่อ) 

 หน้า 

ภาพที่ 3-40 . สร้าง Loop Cut เพ่ิม 99 

ภาพที่ 3-41 สร้างช่องหลักส าหรับการเย็บ 100 

ภาพที่ 3-42  การตัดชุดเดรสกระโปรงทรงสอบ 100 

ภาพที่ 3-43 จัดวัตถุ (Plane) ให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบดา้นหนา้ 101 

ภาพที่ 3-44 การสะท้อนชุดเดรสกระโปรงทรงสอบดา้นหนา้ 102 

ภาพที่ 3-45 สร้างจุดตัดของขริบชุด 103 

ภาพที่ 3-46 การสร้างหน้าขึ้นใหม่ 103 

ภาพที่ 3-47 จัดจุดให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบดา้นหลัง 104 

ภาพที่ 3-48 การเพ่ิมจุด 104 

ภาพที่ 3-49 จัดจุดให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบดา้นหลัง 105 

ภาพที่ 3-50 สร้าง Loop Cut 105 

ภาพที่ 3-51 สร้างช่องหลักส าหรับการเย็บ 106 

ภาพที่ 3-52 ย้ายรูปแบบชุดเดรสกระโปรงทรงสอบดา้นหนา้กลับมาที่เดมิ 106 

ภาพที่ 3-53 การเช่ือมเป็นเสน้ดา้ย 107 

ภาพที่ 3-54 การต้ังค่าชุด 108 

ภาพที่ 3-55 การปรับแตง่ชุด 109 

ภาพที่ 3-56 การ Apply 109 

ภาพที่ 3-57 การปรับชุดมคีวามสวยงามขึน้ 110 

ภาพที่ 3-58 การเพ่ิมหน้าของวัตถุที่ขาดหายไป 111 

ภาพที่ 3-59 การจัดจุดเพ่ือท าให้จุดเกิดความสวยงาม 111 

ภาพที่ 3-60 โปรแกรมเบลนเดอร์ 112 

ภาพที่ 3-61 หุ่น 112 

ภาพที่ 3-62 การน าแบบชุดลงในโปรแกรมเบลนเดอร์ 113 
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สารบัญภาพ (ต่อ) 

 หน้า 

ภาพที่ 3-63 จัดวัตถุ (Plane) ให้ตรงกับแบบเสื้อด้านหน้าของชุดเดรสกระโปรง  

                 ทรงบาน 

113 

ภาพที่ 3-64 การสะท้อนเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 114 

ภาพที่ 3-65 สร้าง Loop Cut 115 

ภาพที่ 3-66 การลบหน้าและลบจุด 115 

ภาพที่ 3-67 สร้างหน้าขึ้นใหม่ 116 

ภาพที่ 3-68 การเพ่ิมจุด 116 

ภาพที่ 3-69 ลบหน้าและสร้างหน้าขึ้นมาใหม่ 116 

ภาพที่ 3-70 จัดจุดให้ตรงกับแบบเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 117 

ภาพที่ 3-71 สร้างช่องหลักส าหรับการเย็บ 117 

ภาพที่ 3-72 การตัดเสื้อของชุดเดรสกระโปรงทรงบาน 118 

ภาพที่ 3-73 จัดวัตถุ (Plane) ให้ตรงกับแบบเสือ้ดา้นหลังของชุดเดรสกระโปรง        

                 ทรงบาน 

118 

ภาพที่ 3-74 การสะท้อนเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 119 

ภาพที่ 3-75 การสร้างจุดตัดของขริบชุด 120 

ภาพที่ 3-76 การลบหน้าและลบจุด 120 

ภาพที่ 3-77 การสร้างหน้าขึ้นใหม่ 121 

ภาพที่ 3-78 การจัดจุดให้ตรงกับแบบเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 121 

ภาพที่ 3-79 จัดจุดให้ตรงกับแบบเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 122 

ภาพที่ 3-80 การสร้างช่องหลักส าหรับการเย็บ 122 

ภาพที่ 3-81 การย้ายรูปแบบเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบานกลับมาที่   

                 เดมิ 

123 

ภาพที่ 3-82 การรวมวัตถุทั้ง 2 วัตถุ 123 
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สารบัญภาพ (ต่อ) 

 หน้า 

ภาพที่ 3-83 การเช่ือมเป็นเสน้ดา้ย 124 

ภาพที่ 3-84 การต้ังค่าแบบชุด 124 

ภาพที่ 3-85 การต้ังค่าชุด 125 

ภาพที่ 3-86 การปรับแตง่เสื้อ 126 

ภาพที่ 3-87 การ Apply 126 

ภาพที่ 3-88 การชุดมคีวามสวยงามขึน้ 127 

ภาพที่ 3-89 การเพ่ิมหน้าของวัตถุที่ขาดหายไป 128 

ภาพที่ 3-90 การต้ังค่ากอ่นการเช่ือมกระโปรง 129 

ภาพที่ 3-91 การเช่ือมกระโปรง 130 

ภาพที่ 3-92 การดงึกระโปรงลง 130 

ภาพที่ 3-93 สร้าง Loop Cut กระโปรง 130 

ภาพที่ 3-94 การต้ังค่ากระโปรง 131 

ภาพที่ 3-95 การปรับแตง่ชุด 131 

ภาพที่ 3-96 การจัดจุดเพ่ือท าให้จุดเกิดความสวยงาม 132 

ภาพที่ 3-97 ลายของชุดเดรสกระโปรงทรงสอบ 133 

ภาพที่ 3-98 Edit Mode ของชุดเดรสกระโปรงทรงสอบ 134 

ภาพที่ 3-99 การ Mark seam 135 

ภาพที่ 3-100 บรเิวณ Mark seam 136 

ภาพที่ 3-101 การลงสขีองชุด 137 

ภาพที่ 3-102 การเลอืกหน้า 138 

ภาพที่ 3-103 การกาง UV 139 

ภาพที่ 3-104 Unwrap 139 

ภาพที่ 3-105 เคลื่อนย้ายชุดเดรสกระโปรงทรงสอบดา้นหนา้ทับดา้นหลัง 140 
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สารบัญภาพ (ต่อ) 

 หน้า 

ภาพที่ 3-106 การหมุน 141 

ภาพที่ 3-107 เลอืกลายผ้า 141 

ภาพที่ 3-108 Shading 142 

ภาพที่ 3-109 การปรับลายผ้า 142 

ภาพที่ 3-110 จัดชุดให้ตรงตามลายที่ต้องการ 145 

ภาพที่ 3-111 เลอืกหน้าของวัตถุด้านหน้า 145 

ภาพที่ 3-112 การเพ่ิม Material 144 

ภาพที่ 3-113 กาง UV สว่นท้ายของชุดเดรส 144 

ภาพที่ 3-114 เลอืกวัตถุทั้งหมดและท าการหมนุ 145 

ภาพที่ 3-115 การจัดจุดของวัตถุให้เป็นเสน้ตรง 145 

ภาพที่ 3-116 ใส่ลายผ้าสว่นท้ายของชุดเดรสด้านหนา้ 145 

ภาพที่ 3-117 จัดจุดให้ตรงกับลายผ้าสว่นท้ายของชุดเดรสด้านหน้า 148 

ภาพที่ 3-118 Shading ลายผ้าสว่นท้ายของชุดเดรสด้านหน้า 148 

ภาพที่ 3-119 การปรับลายผ้าสว่นท้ายของชุดเดรสด้านหน้า 147 

ภาพที่ 3-120 ลายผ้าสว่นท้ายของชุดเดรสดา้นหน้า 147 

ภาพที่ 3-121 ลายชุดเดรสกระโปรงทรงสอบ 149 

ภาพที่ 3-122 ลายชุดเดรสกระโปรงทรงบาน 150 

ภาพที่ 3-123 Edit Mode ของชุดเดรสกระโปรงทรงบาน 151 

ภาพที่ 3-124 Mark seam ชุดเดรสกระโปรงทรงบาน 152 

ภาพที่ 3-125 บรเิวณที่ Mark seam ชุดเดรสกระโปรงทรงบาน 153 

ภาพที่ 3-126 การลงสขีองชุดชุดเดรสกระโปรงทรงสอบ 154 

ภาพที่ 3-127 การเลอืกหน้า 155 

ภาพที่ 3-128 การกาง UV 156 
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สารบัญภาพ (ต่อ) 

 หน้า 

ภาพที่ 3-129 Unwrap 156 

ภาพที่ 3-130 เคลื่อนย้ายชุดเดรสกระโปรงทรงบานดา้นหนา้ทับดา้นหลัง 157 

ภาพที่ 3-131 การหมุน 158 

ภาพที่ 3-132 เลอืกลายผ้า 158 

ภาพที่ 3-133 Shading 158 

ภาพที่ 3-134 การปรับลายผ้า 159 

ภาพที่ 3-135 จัดชุดให้ตรงตามลายที่ต้องการ 159 

ภาพที่ 3-136 เลอืกหน้าของวัตถุด้านหน้า 160 

ภาพที่ 3-137 การเพ่ิม Material 160 

ภาพที่ 3-138 ลายชุดเดรสกระโปรงทรงบาน 161 

ภาพที่ 3-139 โปรแกรมเบรนเดอร์ 162 

ภาพที่ 3-140 การเก็บจุดในโปรแกรมเบรนเดอร์ 162 
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บทท่ี 1 

 

บทน า 

 

1.1 ความเป็นมาและความส าคญัของปัญหา 

ปัจจุบันคอมพิวเตอร์กราฟิกเป็นเทคโนโลยีที่สนใจของคนทั่วโลก ไม่ว่าจะเป็น  ด้าน

การศึกษาดา้นการแพทย ์ดา้นอุตสาหกรรม การคมนาคม การเกษตร และอื่น ๆ อีกหลายดา้น 

ซึ่งในรายวิชาการศึกษาอิสระเลม่นี้ เป็นการน าเทคโนโลยีด้านคอมพิวเตอร์กราฟิกช่วยในการ

สร้างสรรค์งานทางอนิเมชั่น และถูกใช้กันอย่างแพร่หลายในงานที่เกี่ยวข้องกับคอมพิวเตอร์ ซึ่ง

ในส่วนของการออกแบบชุดจะใช้เส้นโค้งเบซิเยร์ (Bezier Curve)  ซึ่งเป็นเส้นโค้งที่มีลักษณะ

เฉพาะตัว จะต้องน าโปรแกรมเบลนเดอร์ (Blender Program) เข้ามาช่วย และจุดเด่นของ

โปรแกรมเบลนเดอร์ (Blender Program) นี้ก็คือเป็นโปรแกรม Open Source ที่สามารถดาวน์

โหลดมาใช้งานได้ฟรี และยังมีความสามารถทัดเทียมกับโปรแกรมสร้างงาน 3 มิติอื่น ๆ ซึ่งมี

ผู้ใช้งานโปรแกรมนีก้ันอย่างแพร่หลาย และจุดเดน่ที่น่าสนใจของโปรแกรมเบลนเดอร์ (Blender 

Program) มีดังน้ี  

 • เป็นโปรแกรมที่ใช้ทรัพยากรระบบและพื้นที่ในการติดต้ังโปรแกรมน้อย และหาดาว

โหลดได้จาก https://www.blender.org/2-8/ 

 • มีความสามารถในการสร้างงานได้หลากหลายรูปแบบ เช่น การสร้างการ์ตูน               

อนิเมช่ัน ที่สามารถคลื่นไหวได้ตามต้องการ งานดีไซน์ (ออกแบบลายผ้า โลโก้ เสื้อผ้า                

และอื่น ๆ ) งานสถาปัตยกรรมและตกแต่งภายใน การสร้างสเปเชียลเอ็ฟเฟ็กต์ และการ                             

สร้างเกม  

จากที่กล่าวมาเบื้องต้นจึงท าให้ผู้คณะผู้จัดท าเกิดความคิดที่จะออกแบบชุดโดยใช้เส้น

โค้งเบซิเยร์ (Bezier Curve)  และน าโปรแกรมเบลนเดอร์ (Blender Program) เข้ามาช่วยในการ

ออกแบบชุด 

https://www.blender.org/2-8/
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1.2 วัตถุประสงค์ของการวิจัย 

     1.2.1 เพ่ือใช้เสน้โค้งเบซิเยร์ (Bezier Curve) ในการออกแบบชุด 

     1.2.2 เพ่ือศึกษาการเช่ือมเสน้โค้งเบซิเยร์ (Bezier Curve)  ให้ราบเรียบโดยการใช้นิยามของ

การเช่ือมกันของเสน้โค้งเบซิเยร์แบบ 0 0
C และ G  

     1.2.3 เพ่ือท าการหาเสน้โค้งปิดล้อมวัตถุ (Bounding Box) ของแบบชุดโดยพิจารณาจาก จุด

ปลายแหลม (Cusp Point), จุดมุม (Corner Point), จุดเปลี่ยนเว้า (Inflection Point), จุดเปลี่ยน 

(Turning Point) และ เสน้โค้งออฟเซ็ต (Offset Curves) 

     1.2.4 เพ่ือท าการหาพ้ืนที่ของแบบชุด 

     1.2.5 เพ่ือท าการหาพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ (Bounding Box) ของแบบชุด และ

เปอร์เซ็นการสูญเสยีผ้าที่เกิดจากการสร้างเส้นโค้งปิดลอ้มวัตถุ (Bounding Box) 

1.3 ขอบเขตของการวิจัย 

     1.3.1 ออกแบบชุดโดยใช้เสน้โค้ง Bezier ในโปรแกรมเบลนเดอร ์(Blender Program)  

     1.3.2 ศึกษาการเช่ือมโค้งเบซิเยร์ (Bezier Curve)  ให้ราบเรียบโดยการใช้นิยามของการ

เช่ือมกันของเสน้โค้งเบซิเยร์ (Bezier Curve) แบบ 0 0
C และ G  

     1.3.3 หาพืน้ที่ปิดล้อมของเสน้โค้งเบซเิยร์ (Bezier Curve) จากแบบชุด 

1.4 ประโยชน์ที่ได้รับจากการวิจัย 

     1.4.1 สามารถประยุกต์ใช้ความรู้ต่าง ๆ ที่เกี่ยวกับเสน้โค้งเบซิเยร์ (Bezier Curve) มา

ออกแบบชุด



บทท่ี 2 

 

เอกสารและงานวิจัยท่ีเกี่ยวข้อง 

 

การวิจัยในคร้ังน้ี มุ่งศึกษาการประยุกต์ใช้เส้นโค้งเบซิเยร์ (Bezier Curve) ในการ

ออกแบบชุด คณะผู้จัดท าได้ท าการศึกษาแนวคิด ทฤษฎี และเอกสารที่เกี่ยวข้องเพ่ือมาเป็น

แนวทางในการศึกษาการวิจัย ดังต่อไปนี้ 

2.1 โปรแกรมเบลนเดอร ์(Blender Program) 

     2.1.1 ประวัตแิละความเป็นมาของโปรแกรมเบลนเดอร ์(History of the Blender Program) 

     2.1.2 จุดเดน่ของโปรแกรมเบลนเดอร ์(Highlights of the Blender program) 

     2.1.3 อินเทอร์เฟสของโปรแกรมเบลนเดอร์ (Blender program interface) 

     2.1.4 การปรับแตง่หน้าต่างของเบลนเดอร์ (Blender Button window customization)  

     2.1.5 ค าสั่งพ้ืนฐานโปรแกรมเบลนเดอร์ (Basic commands blender programs) 

     2.1.6 ตัวอย่างการสร้างงานเบื้องต้นในโปรแกรมเบลนเดอร์ (Example of creating a basic  

             Job in the Blender program) 

2.2 โปรแกรมจีโอจีบรา (Geogebra Program) 

     2.2.1 ภาพรวมของโปรแกรม 

     2.2.2 ระบบพชีคณิต 

2.3 โปรแกรมไมโครซอฟท์ เอกซ์เซล (Microsoft Excel) 

     2.3.1 ประวัตแิละความเป็นมาของโปรแกรมไมโครซอฟท์ เอกซ์เซล (History of the  

             Microsoft Excel)  

     2.3.2 จุดเดน่ของโปรแกรมไมโครซอฟท์ เอกซ์เซล (Highlights of the Microsoft Excel) 

     2.3.3 การใช้งานโปรแกรมไมโครซอฟท์ เอกซ์เซล เบื้องต้น (Using the Microsoft Excel  

             program) 
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2.4 เสน้โค้งเบซิเยร์ อันดบั n (Bezier Curve Order n) 

     2.4.1 ประวัตแิละความเป็นมาของเสน้โค้งเบซิเยร์ (History of the Blender Program) 

     2.4.2 ทฤษฎบีททวินาม (Binomial theorem) 

     2.4.3 เสน้โค้งเบซิเยร์ อันดับ n (Bezier Curve Order n)  

     2.4.4 การแปลงฐานของพหุนามเบิร์นสไตน์ (Bernstein Polynomial) อันดับ n  

     2.4.5 อนุพันธ์อันดับ r ของเสน้โค้งเบซิเยร์ (derivative order r of the Bezier curve) 

     2.4.6 ความตอ่เน่ืองของเสน้โค้งเบซิเยร์ (The continuation of the Bezier curve) 

     2.4.7 ความราบเรียบของเสน้โค้งเบซิเยร์ (The smooth of the Bezier curve) 

2.5 เสน้โค้งเบซิเยร์ อันดับ 1 (Linear Bezier curves) 

     2.5.1 เสน้โค้งเบซิเยร์ อันดับ 1 (Linear Bezier curves) 

     2.5.2 การแปลงฐานของพหุนามเบิร์นสไตน์ (Bernstein Polynomial) อันดับ 1  

     2.5.3 อนุพันธ์อันดับ 1 ของเสน้โค้งเบซิเยร์ (derivative order 1 of the Bezier curve) 

     2.5.4 อนุพันธ์อันดับ 2 ของเสน้โค้งเบซิเยร์ (derivative order 2 of the Bezier curve) 

2.6 เสน้โค้งเบซิเยร์ อันดับ 2 (Quadratic Bezier curve) 

     2.6.1 เสน้โค้งเบซิเยร์ อันดับ 2 (Quadratic Bezier curve) 

     2.6.2 การแปลงฐานของพหุนามเบิร์นสไตน์ (Bernstein Polynomial) อันดับ 2 

     2.6.3 อนุพันธ์อันดับ 1 ของเสน้โค้งเบซิเยร์ (derivative order 1 of the Bezier curve) 

     2.6.4 อนุพันธ์อันดับ 2 ของเสน้โค้งเบซิเยร์ (derivative order 2 of the Bezier curve) 

     2.6.5 ความตอ่เน่ืองของเสน้โค้งเบซิเยร์ (The continuation of the Bezier curve) 

     2.6.6 ความราบเรียบของเสน้โค้งเบซิเยร์ (The smooth of the Bezier curve) 

     2.6.7 การคอมโพสติเส้นโค้งเบซิเยร์ อันดับ 2 (Composite Bezier Curve Order 2) 

2.7 สูตรที่เกี่ยวข้องกับการวิเคราะห์เสน้โค้งในการปิดล้อมวัตถุ (Bounding Box) และทฤษฎีของ

กรีน (Green’s Theorem) 

     2.7.1 เสน้โค้งในการปิดล้อมวัตถุ (Bounding Box) 

            1. จุดเอกพจน์ (Singular point), จุดปลายแหลม (Cusp Point), จุดมุม (Corner Point), 

จุดเปลี่ยนเว้า (Inflection Point) และ จุดเปลี่ยน (Turning Point) 

            2. เสน้โค้งออฟเซ็ต (Offset Curves) 

     2.7.2 ทฤษฎีของกรีน (Green’s Theorem) 
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2.1 โปรแกรมเบลนเดอร์ 

     2.1.1 ประวัติความเป็นมาของโปรแกรมเบลนเดอร ์

โปรแกรมเบลนเดอร์ เป็นซอฟต์แวร์เสรี ส าหรับงานคอมพิวเตอร์กราฟิกสามมิติ 

สามารถใช้สร้าง โมเดลสามมิติ, คลี่ UV, ท าพืน้ผิว (Texture), จัดการการเคลื่อนไหวแบบ

ใช้กระดูก, จ าลองการไหลของน้ า, จ าลองผิวหนัง, คอมพิวเตอร์แอนิเมชัน, เร็นเดอร์, พาทิ

เคิล, การจ าลองด้วยคอมพิวเตอร์อื่น ๆ, การตัดต่อ, ตกแต่งวีดิทัศน์, ภาพผ่านระบบคอม

โพสิต, และยังใช้สร้าง แอปพลเิคชันแบบสามมิติได้อีกดว้ย โปรแกรมเบลนเดอร์ท างานได้

บนหลายระบบปฏิบัติการ, เช่น Microsoft Windows, Mac OS X, GNU/Linux, IRIX, Solaris, 

NetBSD, FreeBSD, OpenBSD และมีการพอร์ตอย่างไม่เป็นทางการไปยังระบบ BeOS, 

SkyOS, AmigaOS, MorphOS และ Pocket PC Blender มีคุณลักษณะทัดเทียมกับโปรแกรม

สามมิติระดับสูงอื่น ๆ เช่น Softimage|XSI, Cinema 4D, 3 ดีเอสแมกซ์, Lightwave และ 

Maya โดยมีคุณลักษณะส าคัญ เช่น การกระทบกันระหว่างของไหล, ผ้าถูกลมพัดพร้ิว, 

และโครงสร้างยืดหยุ่นต่าง ๆ มีระบบ modifier แบบเป็นช้ันส าหรับปรับโมเดล, ระบบ

จัดการภาพเคลื่อนไหวคุณภาพสูง, ระบบจัดการวัสดุและการคอมโพสิตแบบ node และ

รองรับ ภาษาไพทอน ส าหรับเขียนสคริป Blender ต้องการ OpenGL ในการท างาน ในปี

พ.ศ. 2550 Blender เป็นซอฟต์แวร์แอนิเมชันสามมิติที่ถูก install มากที่สุดในโลก 

โปรแกรมเบลนเดอร์ ถูกพัฒนาขึ้นเพ่ือใช้ภายในอนิเมชันสตูดิโอ NeoGeo และ Not a 

Number Technologies (NaN) ในประเทศฮอลแลนด์ โดย Ton Roosendaal ซึ่ง เคยเขียน

โปรแกรมจ าลองภาพโดยการค านวณทิศทางแสงบนเคร่ือง Amiga ในปี 1989 โดยช่ือ 

"Blender" ได้รับแรงบันดาลใจมาจากเพลงของ Yellow จาก album Baby Roosendaal ก่อตัง้ 

NaN ขึน้เมื่อเดือนมิถุนายนปีพ.ศ. 2541 ขึ้นเพ่ือพัฒนาและเผยแพร่โปรแกรม Blender โดย

ในระยะแรก Blender เป็นแชร์แวร์จนกระทั่ง NaN เลิกกิจการในปีพ.ศ. 2545 กลุ่มผู้ถือหุ้น

ตกลงจะขายสิทธิ์ในการจัดการ Blender license ให้เป็นแบบ GPL ในราคา €100,000 

ในขณะนัน้ (พ.ศ. 2545) และหลังจากที่ Roosendall ได้เริ่มระดมทุนจากการรับบริจาคระยะ

หน่ึง ก็ได้ประกาศว่าวันที่ 7 เดือนพฤศจิกายนพ.ศ. 2545 ว่าได้รับเงินบริจาคเพียงพอ และ 

Blender ก็กลายเป็นซอฟต์แวร์เสรีและไดรั้บการพัฒนาต่อมาจนถึงปัจจุบันภายใต้การดูแล

ของ Blender Foundation ในระยะแรก Blender Foundation ได้สงวนสิทธิ์ที่จะใช้ dual license 

(การใช้ license แบบคู่ขนานคืออาจท าสัญญากับบางนิติบุคคลด้วยสัญญาที่ไม่ถูกบังคับ
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โดยข้อก าหนดของ GPL) แต่ทางเลอืกน้ีไม่ได้ถูกใช้กระทั่งยกเลิกไปในปีพ.ศ. 2548 ปัจจุบัน 

โปรแกรมเบลนเดอร์จึงอยูภ่ายใต้สัญญาแบบ GPL เท่านัน้ 

     2.1.2 จุดเด่นของโปรแกรมเบลนเดอร์ 

โปรแกรมเบลนเดอร์ เป็นโปรแกรมสร้างงาน 3 มิติที่มีความสามารถในการสร้าง

โมเดลรูปทรงต่าง ๆ ทั้งยังก าหนดพื้นผิวหรือลวดลายให้กับวัตถุได้ , สามารถปรับแสง , 

ก าหนดมุมมอง , สร้างช้ินงานแอนิเมช่ัน พร้อมใส่เอ็ฟเฟ็กต์สร้างความเหมือนจริงและชวน

ติดตาม จนกระทั่งประมวลผลออกมาเป็นชิ้นงาน 3 มิติที่สมบูรณ์แบบ นอกเหนือจากน้ัน 

ยังรองรับการสร้างเกม เน่ืองจากมีเคร่ืองมือที่ช่วยในการท าโมเดลส าหรับเกมและการ

ท างานอื่น ๆ ที่เกี่ยวกับเกม เป็นโปรแกรมที่ใช้ทรัพยากรระบบและพื้นที่ในการติดต้ัง

โปรแกรมน้อยโดยจุดเดน่ที่น่านใจของโปรแกรมเบลนเดอร ์มีดังนี ้

-  มีความสามารถในการสร้างงานได้หลายรูปแบบ เช่น การสร้างการ์ตูนแอนนิเมชั่น 

งานดีไซน์ งานสถาปัตยกรรมและตกแต่งภายใน การสร้างสเปเชียลเอ็ฟเฟ็กต์ และการ

สร้างเกม เป็นต้น 

-  ท างานไดห้ลายแพลตฟอร์ม เช่น Windows, Mac, Linux และอื่น ๆ 

2.1.3 อินเทอร์เฟสของโปรแกรมเบลนเดอร์ 

อินเทอร์เฟสของโปรแกรมเบลนเดอร์ จะมีลักษณะแตกต่างจากโปรแกรม 3 มิติตัว

อื่นอยู่มาก คือจะเป็นลักษณะของหน้าต่างที่จะแสดงค่าต่าง ๆ ตามแต่ละหน้าต่างไป และ

เราสามารถที่จะเลือกรูปแบบ ของการจัดวางให้มันแสดงผลไดต้ามที่เราต้องการ พูดง่ายๆ

อีกอย่างคือ มีความยืดหยุ่นในจากจัดการกับอินเทอร์เฟสได้มาก เพ่ือให้เหมาะกับการ

ท างานในแตล่ะแบบที่จะแตกต่างกันออกไป 

 

ภาพที่ 2-1 อินเทอร์เฟสมุมมอง 3 มิติ ในโปรแกรมเบลนเดอร ์2.8(Beta) 
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อินเทอร์เฟสที่เราได้เห็นในครั้งแรกที่เปิด โปรแกรมเบลนเดอร์ขึ้นมาน้ัน จะเป็นการ

น าเอาอินเทอร์เฟส 3 อย่าง เข้ามาประกอบเข้าด้วยกัน ท าให้เกิดเป็นอินเทอร์เฟสอย่างที่

เห็น อินเทอร์เฟสทั้ง 3 ที่ไดก้ล่าวไปน้ันก็คือ สว่นเมนูด้านล่างของการต้ังค่าของผู้ใช้ (User 

Preferences) ที่ถูกจัดวางเป็นแถบเมนูด้านบนของอินเทอร์เฟส ส่วนของพื้นที่ท างานตรง

กลางก็คือมุมมอง 3 มิติ (3D View) และสว่นสุดทา้ย ดา้นล่าง ก็คือ (Buttons Window) จาก

การเรียงตัวกันของ อินเทอร์เฟสทั้ง 3 ท าให้เกิดเป็นอินเทอร์เฟสที่เราไดเ้ห็นในตอนเร่ิมต้น 

ที่เปิดโปรแกรมเบลนเดอร์ขึน้มา 

อินเทอร์เฟสของโปรแกรมเบลนเดอร์ น้ันสามารถแบ่งออกเป็นหน้าต่างย่อย ๆ ได้

ตามต้องการ ตามที่ได้บอกไว้แล้วว่า มันยืดหยุ่นสูงส าหรับวิธีในการแบ่งอินเทอร์เฟสออก 

ให้เป็นหน้าต่างย่อยๆน้ัน เพียงแค่คุณน าเมาสไ์ปวาง บริเวณขอบของหน้าต่าง หรือรอยต่อ

ระหว่างหน้าต่าง ให้เคอร์เซอร์ (cursor) เปลี่ยนรูปแบบเป็นลักษณะของ ลูกศรที่มี 2 หัว 

จากน้ันคลิ๊กขวา จะเกิดเมนูขั้นมา จากเมนูนีคุ้ณสามารถ แบ่งหน้าต่างออกมาจาก 1 เป็น 2 

ได้ด้วยการกดแยกพ้ืนที่ (Split Area) หรือคุณอาจรวมหน้าต่าง จาก 2 ให้รวมเป็น 1 ก็ได้ 

ดว้ยการกด รวมพื้นที่ (Join Areas) 

     2.1.4 การปรับแต่งหน้าต่างของเบลนเดอร์  

Buttons Window จะเป็นหน้าต่างที่เราจะต้องเข้าไปยุ่งเกี่ยวด้วยบ่อยที่สุดรองจาก 

มุมมอง 3 มิติ (3D View) ในการใช้โปรแกรมเบลนเดอร์ท างานต่าง ๆ ที่จะต้องจัดการกับ

โมเดล หน้าต่างของ Buttons Window จะใช้ส าหรับ ปรับแต่งค่าต่างๆเกี่ยวกับโมเดลที่เรา

ท า รวมถึงการต้ังค่าบางอย่าง เช่น การเรนเดอร์, พืน้ผิว, ลวดลาย ฯลฯ 

 
ภาพที่ 2-2 Button window customization Blender 2.8 (Beta) 
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     2.1.5 ค าสั่งพ้ืนฐานโปรแกรมเบลนเดอร์ 

ค าสั่งพ้ืนฐานที่ใช้ส าหรับจัดการกับวัตถุส าหรับโปรแกรมสร้างโมเดล 3 มิติ ทุกตัว

ควรจะมีก็คงจะหนีไม่พ้น การคัดลอก (Duplicate), (Duplicate Link), การเคลื่อนย้าย 

(Grab/Move), การหมุน (Rotate) และ การเปลี่ยนขนาด (Scale) การจะใช้ค าสั่งเหล่านี้กับ

วัตถุ (Object) แต่ละช้ิน จะสามารถกระท ากับมันได้ ทั้งในระดับของโหมดวัตถุ  (Object 

mode) และโหมดแกไ้ข (Edit mode) ขึน้อยู่กับว่าต้องการจะท าอะไรกับวัตถุน้ัน ๆ 

2.1.5.1 การคัดลอก 

เป็นค าสั่งที่ใช้ส าหรับคัดลอกสิ่งที่เลือก โดยการเลือกสิ่งที่ต้องการก่อน 

จากน้ันกด Shift+D วัตถุที่เลือกจะถูกคัดลอกออกมา ให้เลื่อนเมาส์เพ่ือน าวัตถุที่ถูก

เลือกออกมา ไปวางในบริเวณที่ต้องการ นอกจากการ Duplicate ในแบบธรรมดา

แล้ว ยังมีการ Duplicate อีกรูปแบบหน่ึงคือ Duplicate Link การท า Duplicate Link 

น้ันก็คล้ายกับการคัดลอกวัตถุแบบธรรมดา แต่ว่าวัตถุที่ถูกคัดลอกด้วยค าสั่ง 

Duplicate Link น้ัน จะถูกเช่ือมโยงรายละเอียดของวัตถุให้เหมือนกัน กล่าวคือ เมื่อ

แก้ไขรายละเอียดของวัตถุชิ้นหน่ึง วัตถุอีกชิ้นที่ถูกเช่ือมโยงกันด้วยค าสั่ง Duplicate 

Link น้ันก็จะถูกแก้ไขรายละเอียดตามไปดว้ย 

 

ภาพที่ 2-3 การใช้ค าสั่ง Duplicate กล่องสี่เหลี่ยมออกมา 
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2.1.5.2 Duplicate Link 

การใช้ค าสั่ง Duplicate Link น้ันจะมีวิธีใช้งานเหมือนกันค าสั่ง Duplicate 

ธรรมดา เพียงแต่เปลี่ยนจาก Shift+D เป็น Alt+D เท่าน้ัน ในการสั่ง Duplicate น้ันจะ

เป็นการย้ายแบบธรรมดาคือ ย้ายไปตามทิศทางของเมาส์ที่คุณลากไป แต่คุณ

สามารถที่จะก าหนด แกนที่คุณจะย้ายได้ดว้ย แกนที่ว่าก็คือแนวแกนของวัตถุคือ X , 

Y และ Z โดยการจะย้ายวัตถุตามแนวแกนต่างๆนี ้เพียงแค่คุณกด X , Y หรือ Z ตาม

หลังจากที่คุณได้กด Shift+D หรือ Alt+D เพ่ือสั่ง Duplicate 

 
          ภาพที่ 2-4 การใช้ค าสั่ง Duplicate Link กล่องสี่เหลี่ยมทีแ่ก้ไขวัตถุเพียงชิน้เดยีว 

2.1.5.3 การเคลื่อนย้าย 

เป็นค าสั่งที่ใช้ส าหรับเคลื่อนย้ายวัตถุ เลือกวัตถุที่ต้องการก่อน จากน้ันกด G 

จะเข้าสู่ค าสั่งเคลื่อนย้าย นอกจากจะสั่งด้วยปุ่ม G แล้วยังสามารถสั่งเคลื่อนย้าย 

ด้วยเมาส์ได้อีกด้วย ด้วยการเลือกวัตถุไว้ก่อน จากน้ันคลิ๊กเมาส์ค้างไว้บนพื้นที่ว่าง

ของมุมมอง 3 มิติ แลว้ลากเป็นเส้นตรง (ลากตรง แนวต้ังแนวนอน หรือทะแยงก็ได้) 

จะเข้าสู่ค าสั่งเคลื่อนย้ายเช่นเดียวกับการกด G ในการสั่งเคลื่อนย้ายแบบธรรมดา 

คือย้ายไปตามทิศทางของเมาส์ที่คุณลากไป แต่คุณสามารถที่จะก าหนด แกนที่คุณ

จะย้ายได้ด้วย แกนที่ว่าก็คือแนวแกนของวัตถุคือ X , Y และ Z โดยการจะย้ายวัตถุ

ตามแนวแกนต่างๆน้ี เพียงแค่คุณกด X , Y หรือ Z ตามหลังจากที่คุณได้กด G เพ่ือสั่ง

เคลื่อนย้าย 
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2.1.5.4 การหมุน  

เป็นค าสั่งที่ใช้ส าหรับหมุนวัตถุ เลือกวัตถุที่ต้องการ จากน้ันกด R จะเข้าสู่

ค าสั่งการหมุน วัตถุจะหมุนตามการเคลื่อนที่ของเมาส์ สามารถสั่งหมุน ไดด้้วยการ

ลากเมาส์เช่นเดียวกับค าสั่งเคลื่อนย้าย เพียงแต่ทิศทางในการลากเมาส์ของค าสั่ง

การหมุน น้ันจะต้อง ลากเมาสว์นเป็นวงกลม หรือลากเป็นเสน้ต้ังฉาก ก็จะเข้าสู่ค าสั่ง

การหมุน 

 

ภาพที่ 2-5 การใช้ค าสั่งการหมุน กล่องสี่เหลี่ยมที่หมุนตามแกน Z 

2.1.4.5 การเปลี่ยนขนาด 

เป็นค าสั่งที่ใช้ส าหรับเปลี่ยนขนาดของวัตถุ ซึ่งใช้ได้ทั้งย่อและขยาย เลือก

วัตถุที่ต้องการ จากน้ันกด S จะเข้าสู่ค าสั่งการเปลี่ยนขนาด ถ้าต้องการย่อวัตถุลง 

ให้ขยับเมาส์เข้าใกล้จุดศูนย์กลางของวัตถุที่เลือก และถ้าต้องการขยายให้ขยับเมาส์

ออกห่างจากวัตถุที่เลือก สามารถสั่งการเปลี่ยนขนาดด้วยเมาส์ได้เหมือนค าสั่ง

เคลื่อนย้ายและการหมุน แต่ทิศทางของการลากเมาสเ์พ่ือสั่งการเปลี่ยนขนาด น้ันคือ

การลากเป็นเส้นตรงไปกลับ คือลากเส้นไปตรงๆ แล้วลากกลับมาที่เดมิ การสั่งการ

เปลี่ยนขนาดแบบปกติน้ัน วัตถุจะถูกย่อหรือขยายออกทุกๆดา้นเท่าๆกัน แต่สามารถ

เลอืกที่จะย่อ/ขยายออกในแกนใดแกนหน่ึง เช่น แกน X หรือ แกน Z ไดด้ว้ยการกด X 

, Y หรือ Z ที่คีย์บอร์ด หลังจากที่คุณกด S เพ่ือสั่งการเปลี่ยนขนาด 
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2.1.6 ตัวอย่างการสร้างงานเบื้องต้นในโปรแกรมเบลนเดอร ์

 

 

 

       ภาพที่ 2-6 ภาพแสดงการท างานพ้ืนหลังและการเรนเดอร์เป็นภาพน่ิงแบบที่ 1 
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ภาพที่ 2-7 ภาพแสดงการท างานพ้ืนหลังและการเรนเดอรเ์ป็นภาพน่ิงแบบที่ 2 

2.2 โปรแกรมจีโอจบีรา 

โปรแกรมจีโอจีบรา เป็นโปรแกรมช่วยงานทางคณิตศาสตร์ โดยเฉพาะด้านเรขาคณิตทั้ง 2 

มิติ และ 3 มิติ ซึ่งมีประสิทธิภาพสูง ข้อดีที่ส าคัญคือ สามารถน าข้อมูลเชิงเรขาคณิต (เช่น

ข้อมูลเกี่ยวกับระบบพิกัด (Coordinate)) ไปใช้ต่อได้ในโปรแกรมอื่น เ ช่น แมธิแมติกา 

(Mathematica) (แต่อาจจะต้องมีการแปลงข้อมูลบ้าง) นอกจากนี ้ยังสามารถส่งออก (Export) 

วัตถุใน 2 มิติ ออกเป็นเลเท็กซ์ (LaTeX) ได้ผ่าน package ‘TikZ’ และบันทึกรูปภาพเป็นไฟล์

ประเภทต่าง ๆ ได้ด้วย ซึ่งสามารถน าไปใช้ได ้โดยที่ไฟลรู์ปภาพไม่แตก 

2.2.1 ภาพรวมของโปรแกรม  

เมื่อเปิดโปรแกรมขึ้นมาใหม่ ๆ เราจะพบหน้าต่างแถบกล่องเคร่ืองมือ (Toolbox) ซึ่ง

เป็นสองมิติ  
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ภาพที่ 2-8 ภาพแสดงเมื่อเปิดโปรแกรมขึน้มาในที่นีใ้ช้เป็นเครื่องคิดเลขกราฟิก 

     2.2.2 ระบบพชีคณิต 

มุมมองพีชคณิตคุณสามารถป้อนนิพจน์พีชคณิตโดยตรงโดยใช้ฟิลด์อินพุตแบบรวม

(แอปพลเิคชันจีโอจีบรา เว็บและแท็บเล็ต) หรือแถบป้อนข้อมูลที่ดา้นลา่งของหน้าต่างจีโอ

จีบรา (GeoGebra Desktop) หลังจากกดปุ่มใส่กุญแจส าคัญในการป้อนข้อมูลเกี่ยวกับ

พีชคณิตของคุณจะปรากฏในมุมมองเมนู พีชคณิตดูในขณะที่การแสดงกราฟิกของมันจะ

ปรากฏขึ้นโดยอัตโนมัติในกราฟิกดู  มุมมองกราฟิก 

ป้อนข้อมูลโดยตรง ตัวอย่างใส่ : y = 2 x + 3 จะช่วยให้คุณสมการเชิงเส้นใน

มุมมองเมนู พีชคณิตดูและสายที่สอดคล้องกันในกราฟิกดูมุมมองกราฟิก 
 

ค าสั่ง จีโอจีบรายังมีช่วงกว้างของค าสั่งที่สามารถใช้ในการสร้างวัตถุในพีชคณิตดู

มุมมองเมนู เพียงเร่ิมพิมพ์ช่ือของค าสั่งลงในแถบป้อนข้อมูลหรือฟิลดป์้อนข้อมูลและ จีโอ

จีบราจะเสนอรายการค าสั่งที่ตรงกับอินพุตของคุณ 
 

เครื่องมือ ถึงแม้ว่ามุมมองพีชคณิตจะไม่มีแถบเคร่ืองมือ (Toolbar) แต่คุณสามารถ

สร้างวัตถุที่อ้างอิงได้ เลือกเคร่ืองมือจากที่กราฟิกดูแถบเคร่ืองมือและคลิกที่วัตถุใด ๆ ที่

เหมาะสมในมุมมองเมนู พีชคณิตดูเพ่ือที่จะสร้างใหม่วัตถุขึ้นอยู่กับ 
 

การดัดแปลงวัตถุทางคณิตศาสตร์ คุณสามารถปรับเปลี่ยนการแสดงเกี่ยวกับ

พีชคณิตของวัตถุทางคณิตศาสตร์โดยตรงในพีชคณิตดู  มุมมองเมนู  เปิดใช้งานโหมด ยา้ย

เคร่ืองมือและดับเบิลคลิกวัตถุฟรีในพีชคณิตดูมุมมองเมนู ในกล่องข้อความที่ปรากฏคุณ

สามารถปรับเปลี่ยนการแสดงพีชคณิตได้โดยตรง หลังจากกดปุ่ม  Enter ทั้งการแสดง
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พีชคณิตในมุมมองเมนู มุมมองพีชคณิตและการแสดงกราฟิกของวัตถุในมุมมองกราฟิก 

มุมมองกราฟิกจะปรับให้เข้ากับการเปลี่ยนแปลงของคุณโดยอัตโนมัติ หากคุณดับเบิลคลิก

ที่วัตถุที่ต้องพ่ึงพาในมุมมองเมนู มุมมองพีชคณิตหน้าต่างข้อความจะปรากฏขึน้เพ่ือให้คุณ

สามารถก าหนดวัตถุใหม่ได้ 
 

การแสดงวัตถุทางคณิตศาสตร์ โดยค่าเร่ิมต้นวัตถุทางคณิตศาสตร์ที่จัดโดยชนิด

ของวัตถุในพีชคณิตดูมุมมองเมนู algebra.svg ในจีโอจีบร้า เดสก์ท็อป, คุณอาจจะใช้บาร์

สไตล์ตัวเลือก albarbraview Stylingbar วัตถุการจัดเรียง by.svg เรียงล าดับโดยในการ

สั่งซือ้อีกคร้ังจัดเรียงวัตถุโดยการอ้างอิง , ช้ันหรือสั่งซื้อก่อสร้าง 

2.3 โปรแกรมไมโครซอฟท์ เอกซ์เซล 

2.3.1 ประวัติและความเป็นมาของโปรแกรมไมโครซอฟท์ เอกซ์เซล 

ไมโครซอฟท์ เอกซ์เซล (Microsoft Excel) เป็นโปรแกรมประเภทตารางการค านวณ 

(สเปรดชีต) พัฒนาโดยบริษัทไมโครซอฟท์ และเป็นโปรแกรมหน่ึงในชุดไมโครซอฟท์ 

ออฟฟิศ ส าหรับจัดการและค านวณข้อมูลในรูปแบบตาราง อีกทั้งสามารถจัดท ากราฟ 

แผนภูมิเ พ่ือแสดงผลข้อมูลได้ โดยเวอร์ชันล่าสุดคือ ไมโครซอฟท์ เอกซ์เซล 2016 

(Microsoft Excel 2016) 

ไมโครซอฟท์ เอกซ์เซล เป็นโปรแกรมประเภทตารางการค านวณ   (สเปรดชีต)  

พัฒนาโดยบริษัทไมโครซอฟท์ และเป็นโปรแกรมหน่ึงในชุดไมโครซอฟท์ ออฟฟิศส าหรับ

จัดการและค านวณข้อมูลในรูปแบบตาราง อีกทั้งสามารถจัดท ากราฟแผนภูมิเพื่อแสดงผล

ข้อมูลได ้โดยเวอร์ชันลา่สุด คือ ไมโครซอฟท์ เอกซ์เซล 

ไมโครซอฟท์ เอกซ์เซล เป็นโปรแกรมที่ได้รับความนิยมในด้านการการค านวณทาง

คณิตศาสตร์โดยใช้ฟังก์ชันพ้ืนฐาน บวกลบคูณหารยกก าลังรวมถึงฟังก์ชันทางคณิตศาสตร์

ระดับสูง เช่น เคร่ืองหมายทางคณิตศาสตร์ (Modulo) ตรีโกณมิติ (Sin, Cos, Tan) ฟังก์ชัน

ทางสถิติ เช่น ค่าเบี่ยงเบนมาตรฐาน ฟังก์ชันทางการเงิน เช่น การคิดค่าเสื่อมราคาการ

ค านวณค่าปัจจุบัน ฟังก์ชันในการตัดต่อค า  เช่น Concatenate ฟังก์ชันในการค้นหาข้อมูล 

เช่น ค้นหา (Lookup), ฟังก์ชันส าหรับการค้นหาและการอ้างอิง (vlookup) และ ค้นหาค่าใน

แถวบนของตาราง (hlookup) ส าหรับสว่นที่ถอืว่าเป็นส่ิงที่เยี่ยมยอดของ  

https://th.wikipedia.org/wiki/%E0%B8%AA%E0%B9%80%E0%B8%9B%E0%B8%A3%E0%B8%94%E0%B8%8A%E0%B8%B5%E0%B8%95
https://th.wikipedia.org/wiki/%E0%B9%84%E0%B8%A1%E0%B9%82%E0%B8%84%E0%B8%A3%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%97%E0%B9%8C
https://th.wikipedia.org/wiki/%E0%B9%84%E0%B8%A1%E0%B9%82%E0%B8%84%E0%B8%A3%E0%B8%8B%E0%B8%AD%E0%B8%9F%E0%B8%97%E0%B9%8C_%E0%B8%AD%E0%B8%AD%E0%B8%9F%E0%B8%9F%E0%B8%B4%E0%B8%A8
https://th.wikipedia.org/wiki/%E0%B8%9A%E0%B8%A7%E0%B8%81
https://th.wikipedia.org/wiki/%E0%B8%9A%E0%B8%A7%E0%B8%81
https://th.wikipedia.org/wiki/%E0%B8%84%E0%B8%B9%E0%B8%93
https://th.wikipedia.org/wiki/%E0%B8%84%E0%B8%B9%E0%B8%93
https://th.wikipedia.org/wiki/%E0%B8%A2%E0%B8%81%E0%B8%81%E0%B8%B3%E0%B8%A5%E0%B8%B1%E0%B8%87
https://th.wikipedia.org/w/index.php?title=Modulo&action=edit&redlink=1
https://th.wikipedia.org/wiki/%E0%B8%95%E0%B8%A3%E0%B8%B5%E0%B9%82%E0%B8%81%E0%B8%93%E0%B8%A1%E0%B8%B4%E0%B8%95%E0%B8%B4
https://th.wikipedia.org/wiki/%E0%B8%84%E0%B9%88%E0%B8%B2%E0%B9%80%E0%B8%9A%E0%B8%B5%E0%B9%88%E0%B8%A2%E0%B8%87%E0%B9%80%E0%B8%9A%E0%B8%99%E0%B8%A1%E0%B8%B2%E0%B8%95%E0%B8%A3%E0%B8%90%E0%B8%B2%E0%B8%99
https://th.wikipedia.org/w/index.php?title=%E0%B8%84%E0%B9%88%E0%B8%B2%E0%B9%80%E0%B8%AA%E0%B8%B7%E0%B9%88%E0%B8%AD%E0%B8%A1%E0%B8%A3%E0%B8%B2%E0%B8%84%E0%B8%B2&action=edit&redlink=1
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ไมโครซอฟท์ เอกซ์เซล คือ การใช้งานในรูปแบบของฐานข้อมูล ซึ่งสามารถจัดการ

ฐานข้อมูลที่มีขนาดไม่ใหญ่มาก คือ มีประมาณไมเ่กิน 65,000 ตาราง ไมว่่าจะเป็นตัวกรอง 

การเรียงล าดับข้อมูล (Sort) ค านวณยอดรวม (Subtotal) และตารางไพวอต (Pivot Table) 

เป็นค าสั่งส าหรับสรุปข้อมูลให้อยู่ในรูปแบบที่ดูได้ง่ายสามารถหมุนเปลี่ยนตามต้องการ  

นอกจากน้ียังสามารถท ากราฟในแบบต่าง ๆ เช่นเส้นตรง วงกลม กราฟรูปแท่ง กราฟแท่ง

เทียนที่ใช้กับการวิเคราะห์หุ้นก็ท าได้ กราฟพืน้ที่สามารถท ากราฟต่าง ๆ ให้อยู่ในรูปแบบ 2 

มิติ หรือ  3 มิติไดด้ว้ย รวมถึงท ากราฟ 2 ชนิดในรูปเดยีวกันไดด้ว้ย  

ในปี พ.ศ. 2522 บรษิัท วิสคิอร์ป ได้ประกาศแนะน าโปรแกรมตารางท างานโปรแกรม

หน่ึงช่ือ วิสิแคลค์  ส าหรับใช้งานกับเคร่ืองไมโครคอมพิวเตอร์แอปเปิล วิสิแคลค์ เป็น

โปรแกรมตารางท างานที่ยึดหลักว่าผู้ใช้ไม่จ าเป็นต้องมีความรู้ทางด้านโปรแกรมมาก่อน

เลย การใช้งานจึงท าได้ง่ายและน่ีเองเป็นหลักที่ท าให้วิสแิคลค์ประสบความส าเร็จมีผู้นิยม

ใช้กันมากในยุคน้ัน ต่อมาปี พ.ศ. 2525 บริษัทไมโครซอฟต์ ซึ่งเป็นบริษัทใหญ่ในการผลิต

ซอฟแวร์ และประสบความส าเร็จทางด้านการพัฒนาคอมพิวเตอร์มาแล้วมากมาย  และ

ซอฟแวร์ตัวหน่ึงที่อยูใ่นกลุ่มตารางท างาน คือ แลติแพลน (Multiplan)  

ต่อมาบริษัทไมโครซอฟต์ได้พัฒนาระบบปฏิบัติงานวินโดว์ เพ่ือให้ใช้งานได้ง่ายขึ้น 

โดยเน้นรูปแบบการท างานเป็นกราฟิกและได้มีการพัฒนาโปรแกรมท างานภายใต้

ระบบปฏิบัติการวินโดว์น้ี โปรแกรมท างานนี้ช่ือว่า ไมโครซอฟท์ เอ็กซ์เซล ซึ่งก าลังเป็นที่

นิยมแพร่หลายในปัจจุบัน 

2.3.2 จุดเด่นของโปรแกรมไมโครซอฟท์ เอกซ์เซล 

ไมโครซอฟท์ เอกซ์เซลเป็นโปรแกรมส าเร็จรูปที่ใช้เนือ้ที่ขนาดใหญท่ างานไดบ้นเคร่ือง

คอมพิวเตอร์ที่ใช้ระบบปฏิบัติการวินโดวส์ตารางในแนวต้ัง เรียกว่า สดมภ์ (Column) จะมีช่ือ

ก ากับเป็นภาษาอังกฤษเร่ิมจาก A,B,C,… เร่ือยไปจนสุดขอบตารางทางขวา รวมทั้งสิ้น 256  

สดมภ์ ตารางในแนวนอน เรียกว่า แถว (Row) จะมีตัวเลขก ากับแถวเป็นบรรทัดที่ 1, 2, 3,….  

เร่ือยไปจนถึงบรรทัดสุดท้ายจ านวนบรรทัดจะแตกต่างกันตามโปรแกรมที่ใช้งาน ส าหรับ

โปรแกรมไมโครซอฟต์เอ็กเซลจะมีทั้งสิ้น 65,536 บรรทัด ช่องแต่ละช่องที่แนวต้ังและ

แนวนอนตัดกันเรียกว่า เซลล์ (Cell) ใช้ส าหรับใส่ข้อมูลหรือสูตรค านวณ เมื่อใส่ข้อมูลหรือ

https://th.wikipedia.org/wiki/%E0%B8%90%E0%B8%B2%E0%B8%99%E0%B8%82%E0%B9%89%E0%B8%AD%E0%B8%A1%E0%B8%B9%E0%B8%A5
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สูตรลงไปแลว้โปรแกรมสามารถค านวณค่าโดยอาศัยข้อมูลที่เกี่ยวข้องให้โดยอัตโนมัติ และ

ถ้ามีการเปลี่ยนค่าใด ๆ ที่มีการอ้างอิงกับสูตร โปรแกรมจะมีการค านวณใหม่ให้โดย

อัตโนมัติเช่นกันและนอกจากนี้ไมโครซอฟท์ เอ็กซ์เซล ยังมีความสามารถอีกมากมาย

ดังต่อไปนี ้

- สร้างและแสดงรายงานของข้อมูล ตัวอักษร และตัวเลข โดยมีความสามารถใน

การ จัดรูปแบบให้สวยงามน่าอ่าน เช่น การก าหนดสีพืน้ การใส่แรเงา การก าหนดลักษณะ

และสีของ เส้นตาราง การจัดวางต าแหน่งของตัวอักษร การก าหนดรูปแบบและสตัีวอักษร 

เป็นต้น 

- อ านวยความสะดวกในด้านการค านวณต่าง ๆ เช่น การบวก ลบ คูณ หารตัวเลข 

และยังมีฟังก์ชันที่ใช้ในการค านวณอีกมากมาย เข่น การหาผลรวมของตัวเลขจ านวนมาก 

การหา ค่าทางสถติิและการเงิน การหาผลลัพธ์ของโจทย์ทางคณิตศาสตร์ เป็นต้น 

- สร้างแผนภูมิ (Chart) ในรูปแบบต่าง ๆ เพ่ือใช้ในการแสดงและการเปรียบเทียบ 

ข้อมูลไดห้ลายรูปแบบ เช่น แผนภูมิคอลัมน์ แผนภูมิเสน้ แผนภูมิวงกลม ฯลฯ 

- มีระบบขอความช่วยเหลือ (Help) ที่จะคอยช่วยให้ค าแนะน า ช่วยให้ผู้ใช้สามารถ 

ท างานได้อย่างสะดวกและรวดเร็ว เช่น หากเกิดปัญหาเกี่ยวกับการใช้งานโปรแกรม หรือ

สงสัย เกี่ยวกับวิธีการใช้งาน แทนที่จะต้องเปิดหาในหนังสือคู่มือการใช้งานของโปรแกรม ก็

สามารถขอ ความชว่ยเหลอืจากโปรแกรมได้ทันที 

- มีความสามารถในการค้นหาและแทนที่ ข้อมูล โดยโปรแกรมจะต้องมี  

ความสามารถในการค้นหาและแทนที่ข้อมูล เพ่ือท าการแก้ไขหรือท าการแทนที่ข้อมูลได้

สะดวก และรวดเร็ว 

- มีความสามารถในการจัดเรียงล าดับข้อมูล โดยเรียงแบบตามล าดับ จาก A ไป Z 

หรือจาก 1 ไป 100 และเรียงย้อนกลับจาก Z ไปหา A หรือจาก 100 ไปหา 1 

- มีความสามารถในการจัดการข้อมูลและฐานข้อมูล ซึ่งเป็นกลุ่มของข้อมูลขา่วสาร 

ที่ถูกรวบรวมเข้าไว้ด้วยกันในตารางที่อยู่ในแผ่นงาน (Worksheet) ลักษณะของการเก็บ

ข้อมูลเพ่ือใช้เป็น ฐานข้อมูลมนโปรแกรมตารางงานจะเก็บข้อมูลในรูปแบบของตาราง โดย
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แต่ละแถวของรายการจะเป็น ระเบียน หรือเรคอร์ด (Record) และคอลัมน์จะเป็นฟิลด์ 

(Field) 

- ความสามารถด้านการค านวณไมโครซอฟท์ เอ็กซ์เซล สามารถป้อนสูตรการ

ค านวณทางคณิตศาสตร์ เช่น บวก ลบ คูณ หาร เป็นต้น 

- ความสามารถด้านใช้ฟังก์ชัน เช่น ฟังก์ชันเกี่ยวกับตัวอักษร ตัวเลข วันที่ ฟังก์ชัน

เกี่ยวกับการเงิน หรือเกี่ยวกับการตัดสินใจ 

- ความสามารถในการสร้างกราฟไมโครซอฟท์ เอ็กซเ์ซล สามารถน าข้อมูลที่ป้อน

ลงในตารางมาสร้างเป็นกราฟได้ทันที 

- ความสามารถในการตกแต่งตารางข้อมูลไมโครซอฟท์ เอ็กซ์เซล สามารถตกแต่ง

ตารางข้อมูลหรือกราฟ ข้อมูลด้วยภาพสี และรูปแบบตัวอักษรต่าง ๆ เพ่ือให้เกิดความ

สวยงามและท าให้แยกแยะขอ้มูลไดง้่ายขึน้ 

- ความสามารถในการเรียงล าดับข้อมูลไมโครซอฟท์ เอ็กซ์เซล สามารถคัดเลือก

เฉพาะข้อมูลที่ต้องการมาวิเคราะห์ได้ 

- ความสามารถในการพิมพ์งานออกทางเคร่ืองพิมพ์ไมโครซอฟท์ เอ็กซ์เซล 

สามารถพิมพ์งานทั้งข้อมูลรูปภาพภาพ หรือกราฟออกทางเครื่องพิมพ์ได้ทันที ซึ่งท าให้งา่ย

ต่อการสร้างรายงาน 

- ความสามารถในการแปลงข้อมูลในตารางให้เป็นเว็บเพจ เพ่ือน าไปแสดงใน

โฮมเพจ 

2.3.3 การใช้งานโปรแกรมไมโครซอฟท์ เอกซ์เซล เบื้องต้น 

ไมโครซอฟท์ เอกซ์เซลคือ โปรแกรมที่เหมาะกับงานด้านการค านวณการตีตาราง

การหาค่าสูตรต่าง ๆ การสร้างกราฟโดยที่เมื่อเปลี่ยนแปลงตัวเลขใด ๆ โปรแกรมจะท าการ

ค านวณสูตรที่เช่ือมโยงกับตัวเลขน้ัน ๆ ให้อัตโนมัติในการท างานของโปรแกรมจะใช้ตาราง

ตามแนวตัง้  (columns) และแนวนอน (rows) เป็นหลัก 

- การเรยีกใช้งานโปรแกรมไมโครซอฟท์ เอกซ์เซล 2010 

 การเปิดโปรแกรมไมโครซอฟท์ เอกซ์เซล 2010 เพ่ือการใช้งานเร่ิมต้น  ให้ไปที่ 

เร่ิมต้น (Start) > All Programs > Microsoft Office > Microsoft Excel 2010 



18 
  

 

ภาพที่ 2-9 ภาพแสดงการเปิดใช้งานโปรแกรมไมโครซอฟท์ เอกซ์เซล 2010 

- ส่วนประกอบของการใช้งานโปรแกรมไมโครซอฟท์ เอกซ์เซล 2010 

 

ภาพที่ 2-10 ภาพแสดงสว่นประกอบของการใช้งานโปรแกรมไมโครซอฟท์ เอกซ์เซล 2010 

1.) เครื่องมือเข้าถงึด่วน (Quick Access) เป็นส่วนที่รวบรวมเมนูหรือเครื่องมือ

ส าคัญ และนิยมใช้เป็นประจ า โดยผู้ใช้สามารถเพิ่มหรือลบเครื่องมือตา่ง ๆ ได้ตาม

ความตอ้งการ 
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2.) ริบบอน (Ribbon) เป็นส่วนที่รวบรวมชุดค าสั่ง และเคร่ืองมือต่าง ๆ เข้า

ดว้ยกัน โดยมีการจัดแบ่งออกเป็นกลุ่ม ๆ เพ่ือสามารถเรียกใช้งานได้สะดวก 

3.) แถบเครื่องมือสูตร (Formula Bar) เป็นส่วนที่ใช้ส าหรับพิมพ์ข้อความ ตัวเลข 

และสูตรทางคณิตศาสตร์ 

4.) กล่องช่ือ (Name box) เป็นสว่นที่ใช้บอกต าแหน่งของเซลล ์หรือช่ือของเซลล์

ที่ถูกเลอืกท างาน 

5.) พ้ืนที่ท างาน (Work Space) เป็นส่วนของพื้นที่ที่ใช้ในการพิมพ์ข้อความ หรือ

ตัวเลขลงไปในชีทงาน 

6.) คอลัมน์ (Column) เป็นส่วนของแถวที่อยู่ในแนวต้ังของชีทงาน โดยมีช่ือของ

หัวแถวเป็นอักษร A, B, …,XFD 

7.) แถว (Row) เป็นส่วนของแถวที่อยู่ในแนวนอนของชีทงาน โดยมีช่ือของหัว

แถวเป็นตัวเลข 1, 2, 3,…,1,048 

8.) ป้ายช่ือ (Sheet tab) เป็นส่วนที่แสดงช่ือของชีทงานที่เลือกใช้อยู่ โดยปกติ

โปรแกรมจะท าให้ 3 ชีทงาน เมื่อท าการสร้างไฟลใ์หม่ 

- ส่วนประกอบหลักของโปรแกรมไมโครซอฟท์ เอกซ์เซล 2010 

1.) สมุดงาน (Workbook) คือ ไฟล์งานหลักของโปรแกรมไมโครซอฟท์ เอกซ์เซล 

2010 ที่ประกอบด้วยชีทงานตามที่ผู้ใช้สร้างขึ้น และจัดเก็บบันทึกเป็นไฟล์งาน เพ่ือ

น ามาเพ่ิมเตมิแก้ไขในครัง้ต่อไป 

2.) ชีทงาน (Worksheet) คือ หน้ากระดาษแต่ละหน้าที่อยู่ในสมุดงาน โดยใช้เป็น

พ้ืนที่ส าหรับท างานทุก ๆ อย่าง ซึ่งปกติเมื่อสร้างสมุดงานใหม่  จะมีชีทงานมาให้ด้วย 

3 ชีทงานเสมอ 

3.) เซลล ์(Cell) คือ ช่องส่ีเหลี่ยมที่เกิดจากจุดตัดของแถวและคอลัมน์ ใช้ส าหรับ

กรอกตัวเลขหรือข้อความลงไป เพ่ือน าไปบันทึกผล หรือค านวณค่าต่าง ๆ ในการ

เรียกเซลล์จะดูจากตัวอักษรที่อยู่บนคอลัมน์ และจากตัวเลขที่อยู่หัวแถว 
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ภาพที่ 2-11 ภาพแสดงตัวอย่างส่วนประกอบหลักของโปรแกรมไมโครซอฟท์ เอกซ์เซล 2010 

- แถบเคร่ืองมือมาตรฐาน(Standard) ของโปรแกรมไมโครซอฟท์ เอกซ์เซล  

 

ภาพที่ 2-12 ภาพแสดงแถบเครื่องมือมาตรฐานของโปรแกรมไมโครซอฟท์ เอกซ์เซล 

ตารางที่ 2-1 แสดงค าอธิบายแถบเครื่องมอืมาตรฐานของโปรแกรมไมโครซอฟท์ เอกซ์เซล 

ปุ่ม ชื่อปุ่ม หน้าที ่

 
New (สร้าง) - เปิดเอกสารชุดใหม่ 

 
Open (เปิด) - เรียกเอกสารชุดเก่าที่เก็บบันทึกไว้มาใช้ 

 
Save (บันทึก) - สั่งเก็บบันทึกเอกสาร 

 
Permission (สทิธิ) - การจัดการสิทธิ์ในการใช้ขอ้มูล 

 

E-mail 

(อีเมล์ตามใบแนบ) 

- เปิดโปแกรมสร้างอีเมล์พร้อมแนบไฟลข์อง  Word  

ไปด้วย 

 
Print (พิมพ์) - สั่งพิมพ์เอกสารลงบนกระดาษ 
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ปุ่ม ชื่อปุ่ม หน้าที ่

 

Print Preview 

(ตัวอย่างกอ่นพิมพ์) 
- แสดงผลการพิมพ์บนหน้าจอเพ่ือดูกอ่นพิมพ์จริง 

 

Spelling 

(การสะกด) 
- ตรวจสอบการสะกดค าตามพจนานุกรม 

 

Research 

(การวิจัย) 
- ให้ข้อมูลอ้างอิงส าหรับงานวิจัย 

 
Cut (ตัด) 

- ลบขอ้ความ หรือออบเจ็คทีเ่ลอืกไว้ไปไว้ในคลิป

บอร์ด 

 
Copy (คัดลอก) 

- คัดลอกขอ้ความ หรือออบเจ็คทีเ่ลอืกไว้ไปไวใ้น

คลิปบอร์ด 

 
Past (วาง) 

- น าข้อความ หรือออบเจ็คมาวางในเอกสารตรงที่

ต้องการ 

 

Format Painter 

(ตัวคัดวางรูปแบบ) 

- คัดลอกรูปแบบข้อความหน่ึงไปใส่ให้กับอีก

ข้อความ 

 
Undo (เลกิท า) - ยกเลิกค าสั่งหรือการท างานที่ท าลา่สุด 

 
Redo (ท าอีกคร้ัง) - เรียกท าค าสั่งหรือการท างานที่ถูกยกเลิกไป 

 

Hyperlink 

(การเช่ือมโยง 

หลายมิติ) 

- สร้างการเช่ือมโยงจากต าแหน่งที่ก าหนดไว้ไปยัง

เอกสารหรอืไปยังส่วนอื่นในเอกสารเดยีวกันหรือ

URL  

 

Table & Border 

(ตารางและเส้น

ขอบ) 

- แสดง/ไมแ่สดงแถบเครื่องมือตารางและเสน้ขอบ 

 

Insert Table 

(แทรกตาราง) 

 

- ใส่ตารางในเอกสาร 
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ปุ่ม ชื่อปุ่ม หน้าที ่

 

Insert Microsoft 

Excel 

- แทรกสเปรดชีทของโปรแกรมไมโครซอฟท์ เอกซ์

เซล 

 
Columns (คอลัมน์) - จัดข้อความเป็นหลายคอลัมน์เหมือนหนังสือพิมพ์ 

 
Drawing (รูปวาด) - เปิด/ปิดแถบเครื่องมือรูปวาด 

 

Document Map 

(แมปเอกสาร) 
- เปิด/ปิดแผนที่เอกสาร 

 

Show/Hide 

(ซ่อน/แสดง) 

- ซ่อนหรือแสดงสัญลักษณ์พิเศษซึ่งจะไมถู่กพิมพ์

ออกมา 

 
Zoom (ย่อย/ขยาย) 

- ย่อหรือขยายเอกสารที่แสดงบนหน้าจอตาม

เปอร์เซ็นต์ที่เลอืก 

 
Office Assistant 

- แสดง Office Assistant ซึ่งเป็นตัวการตู์นที่ให้

ค าแนะน าในการใช้งาน 

 

Read 

(มุมมองเค้า 

โครงการอ่าน) 

- เปลี่ยนเค้าโครงของหน้ากระดาษและปรับปรุงการ

แสดงผลของตัวอักษรเพ่ือท าให้ผ่านข้อมูลไดส้ะดวก

ขึน้เหมาะกับหน้ากระดาษที่มขี้อความยาว ๆ แต่จะ

ไมเ่หมาะกับพวกกราฟิกหรือตาราง 

- แถบเคร่ืองมือจัดรูปแบบ (Formatting)ของโปรแกรม  Microsoft Excel 

 

ภาพที่ 2-13 ภาพแสดงแถบเครื่องมือจัดรูปแบบของโปรแกรมไมโครซอฟท์ เอกซ์เซล 
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ตารางที่ 2-2 แสดงค าอธิบายแถบเครื่องมือจดัรูปแบบของโปรแกรมไมโครซอฟท์ เอกซ์เซล 

ปุ่ม ชื่อปุ่ม หน้าที ่

 

Styles and Format 

(ลักษณะและรูปแบบ) 
- เปิดทาสกเ์พน (Styles and Formatting)  

 Style (ลักษณะ) 
- แสดงหรือใช้เลอืก Style (รูปแบบ) ของ

ข้อความตรงที่เคอร์เซอร์อยู ่

 Font (แบบอักษร) 
- แสดงหรือเลอืกแบบของตัวอักษรตรงที่

เคอร์เซอร์อยู ่

 

Font Size 

(ขนาดแบบอักษร) 

- แสดงหรือใช้เลอืกขนาดของตัวอักษรที่

เคอร์เซอร์อยู ่

 
Bold (ตัวหนา) - ท าเป็นตัวหนาหรือยกเลกิ 

 
Italic (ตัวเอียง) - ท าเป็นตัวเอียงหรือยกเลกิ 

 

Underline 

(ขีดเสน้ใต้) 
- ขีดเสน้ใต้หรือยกเลกิ 

 

Align Left 

(จัดชิดซ้าย) 
- จัดข้อความให้ชิดซ้าย 

 
Center (กึ่งกลาง) - จัดข้อความใหอ้ยู่กลางบรรทัด 

 

Align Right 

(จัดชิดขวา) 
- จัดข้อความให้ชิดขวา 

 
Justify (ชิดขอบ) - จัดข้อความให้เสมอกันทั้งซ้ายและขวา 

 
Distributed (กระจาย) 

- เหมอืนชิดขอบแต่จะเพิ่มช่องไฟ ระหว่าง

อักษรและประโยคในภาษไทยเพ่ือความ

สวยงาม 

 
Line Spacing - ปรับระยะห่างระหว่างบรรทัด 
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ปุ่ม ชื่อปุ่ม หน้าที ่

 

Numbering 

(ล าดับเลข) 
- เติมหรือยกเลกิเลขล าดับหน้าขอ้ความ 

 

Bullets (สัญลักษณ์

แสดงหัวข้อย่อย) 

- เติม หรือยกเลกิจุดสดี า (bullets) หรือ

สัญลักษณ์อื่น ๆ หน้าขอ้ความ 

 

Decrease Indent 

(ลดการเยือ้ง) 
- ร่นทั้งย่อหน้าไปทางซ้าย 1 ขั้น 

 

Increase Indent 

(เพ่ิมการเยือ้ง) 
- ร่นทั้งย่อหน้าไปทางขวา 1 ขั้น 

 

Outside Bolder 

(เสน้ขอบนอก) 
- ตีเสน้หรือลงเสน้ที่ขอบดา้นต่าง ๆ 

 Highlight (เน้น) 
- เลอืกแถบสีเพ่ือเน้นข้อความ (เหมือน

ปากกสีสะท้อนแสง)  

 

Font Color 

(สแีบบอักษร) 
- เลอืกสีของตัวอักษร 

 

2.4 เส้นโค้งเบซเิยร์ อันดับ n 

2.4.1 ประวัติและความเป็นมาของเส้นโค้งเบซิเยร์ 

เส้นโค้งเบซิเยร์  ในคณิตศาสตร์ถือว่าเป็นเส้นโค้งหน่ึงที่มีความส าคัญอย่างมากใน

เร่ืองของ  คอมพิวเตอร์กราฟิก  เพราะวิธีการที่เสถียรที่สุด ในการสร้างจุดต่างๆบนเส้น

โค้งเบซิเยร์สามารถท าได้โดยใช้  ขั้นตอนวิธีของเดอคาสเซิลโจ  (de Casteljau's algorithm)  

เส้นโค้งเบซิเยร์ถูกเผยแพร่สู่สาธารณชนเป็นคร้ังแรกเมื่อปี  พ.ศ. 2505  โดยนัก

วิศวกรชาว  ฝรั่งเศส  ที่ช่ือ ปิแอร์ เบซิเยร์ (Pierre Bézier)  ซึ่งขณะนัน้เป็นนักวิชาการอยูใ่น

แผนกออกแบบที่บริษัทรถยนต์ย่ีห้อเรโนลด์  แตใ่นความเป็นจริงแลว้  เสน้โค้งน้ีได้ถูกคิดค้น

เป็นคร้ังแรก  เมื่อปี  พ.ศ. 2502  โดยนายพอล เดอ คาสเซิลโจ  (Paul de Casteljau) 
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2.4.2 ทฤษฎีบททวินาม 

ก่อนที่จะมาศึกษาเร่ืองพหุนามเบิร์นสไตน์ เราต้องมารู้จักกับสามเหลี่ยมปาสคาล ซึ่ง

หาได้จากการกระจายทวินาม    เมือ่  n  เป็นจ านวนเต็มบวกหรือศูนย์ ดังนี้ 

เมื่อ 

 

 

 

 

 

 

 

0

1

2 2 2

3 3 2 2 3

4 4 3 2 2 3 4

5 5 4 3 2 2 3 4 5

( 1) ( 2) 2 ( )

0 ; 1

1 ;

2 ; 2

3 ; 3 3

4 ; 4 6 4

5 ; 5 10 10 5

;
1 2

k k k k k k k

n a b

n a b a b

n a b a ab b

n a b a a b ab b

n a b a a b a b ab b

n a b a a b a b a b ab b

k k k
n k a b a a b a b a b

k

  

  

   

    

     

      

       

     
           

     

 

สามารถเขียนแผนภาพเฉพาะสัมประสทิธิ์ของการกระจายทวินาม เมื่อ n เป็นจ านวน

เต็มบวกหรือศูนย์ ได้ดังน้ี 
0 ; 1

1 ; 1 1

2 ; 1 2 1

3 ; 1 3 3 1

4 ; 1 4 6 4 1

5 ; 1 5 10 10 5 1

; 1 1
1 2 2 1

n

n

n

n

n

n

k k k k
n k

k k













       
        

        

 

จากการพิจารณาสามเหลี่ยมของปาสคาลตามแผนภาพ เราจะสามารถเขียนสูตร 

( )na b  ที่เกี่ยวข้องกับสัมประสทิธิ์ทวินาม !

!( )!

n n

k k n k

 
 

 
 เมื่อ ,n k  เป็นจ านวน

เต็มบวกใดๆ ซึ่ง 0 k n   เป็นสูตรได้ดังนี้ 

 
0

( )
n

n n k k

k

n
a b a b

k





 
   

 
  
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ต่อไปเราจะกลา่วถึงคลาสของพหุนามเบิร์นสไตน์ อันดับที่ n ซึ่งนิยามโดย  

 , ( ) (1 ) , 0,1, 2, ,n k k

n k

n
b t t t k n

k

 
   

 
   

จากสูตร 

 
0

( )
n

n n k k

k

n
a b a b

k





 
   

 
   (1) 

เมื่อก าหนด 1a t   และ b t  ในเทอมดา้นขวาของสมการ (1) ดังนี้  

 
0

( ) (1 )
n

n n k k

k

n
a b t t

k





 
   

 
   (2) 

เราจะเห็นว่าการกระจายทวินาม ( )na b  คือ ผลรวมของคลาสของพหุนามเบิร์น 

สไตน์ อันดับที่ n และเมื่อพิจารณาเทอมดา้นซ้ายของสมการ (2) โดยการแทน 1a t   

และ b t  ซึ่งท าให ้

0

,

0

1 ((1 ) )

(1 )

( )

n

n
n k k

k

n

n k

k

t t

n
t t

k

b t







  

 
  

 







 

             เราพบว่า ผลรวมของพหุนามเบิร์นสไตน์ อันดับที่ n มีค่าเท่ากับ 1 ซึ่งสอดคล้องกับ

คุณสมบัติพิเศษของพหุนามเบิร์นสไตน์ และเรียก  ,n kb t  ว่า คลาสของพหุนามเบิร์นสไตน์ 

อันดับที่ n 

2.4.3 เส้นโค้งเบซิเยร์ อันดับ n  

เสน้โค้งของเบซิเยร์ เกิดจากผลรวมเชิงเสน้ระหว่างคลาสของพหุนามเบิร์นสไตน์ 

อันดับที่ n กับจุดควบคุม 0 1 2, , , , nP P P P  ซึ่งมรูีปแบบของสมการดังนี้  

 0 1 2 ,

0

( , , , , , ) ( )
n

n n n k k

k

B t P P P P b t P


    (3) 

โดยที ่  , ( ) 1
n k k

n k

n
b t t t

k

 
  

 
 และ  , ,k k k kP x y z  เมื่อ 0,1,2, ,k n  
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2.4.4 การแปลงฐานของพหุนามเบิร์นสไตน์ อันดับ n 

เราก าลังจะกล่าวถึงพจน์ที่ k  ของเบิร์นสไตน์ อันดับที่ n  ที่นิยามโดย  

  , 1
n kk

n k

n
b t t

k

 
  

 
  (4) 

เราสามารถเขียนให้อยู่ในรูปของฐานของพหุนามยกก าลัง อันดับที่ n (Power Basis 

Order n ) ได้ โดยใช้ทฤษฎีบททวินามเข้ามาช่วยในการแปลงฐานของพหุนามเบิร์นสไตน์ 

เป็นฐานของพหุนามยกก าลัง ครัง้นี ้
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จากที่แสดงมาข้างต้นพบว่า  1
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จากสมการที ่(6) เราจะท าการเปลี่ยนดรรชนี โดยการมอง i i k    จะได้ 
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พิจารณาสมการเสน้โค้งเบซิเยร์ อันดับที่ n ซึ่งสร้างจากจุดควบคุม 0 1, , , nP P P   ที่นิยาม
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ในรูปของผลคูณของเมทรกิซ์ จะพบว่า 
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พิจารณาเมทรกิซ์ของพหุนามเบิร์นสไตน์ อันดับที่ n พบว่าแตล่ะพจน์ของพหุนาม 

เบิร์นสไตน์ อันดับที่ n สามารถเขียนให้อยู่ในรูปของผลรวมเชิงเส้นของพหุนามยกก าลัง 

อันดับที่ n นิยามโดย   
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ดังน้ันจากสมการที่ (8) และ (9) - (12) จะได้ว่า
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ดังน้ันจากสมการ (8) จะได้ 
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2.4.5 อนุพันธ์อันดับ r ของเส้นโค้งเบซิเยร์ 
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
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2.4.6 ความต่อเนื่องของเส้นโค้งเบซิเยร์ 

บทนยิาม 1 ก าหนดให้ 
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ต่อเน่ือง 

2.4.7 ความราบเรยีบของเส้นโค้งเบซิเยร์ 
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2.5 เส้นโค้งเบซิเยร์ อันดับ 1 

2.5.1 เส้นโค้งเบซิเยร์ อันดับ 1 

จากสมการ (3) เราสามารถสร้างสมการเสน้โค้งเบซิเยร์ อันดับ 1  ได้โดยการแทน 

ค่า 1n  ในสมการที่ (3) จะได้ว่า    
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ดังน้ันสมการเส้นโค้งเบซิเยร์ อันดับ 1  เกิดจากผลรวมเชิงเสน้ระหว่างคลาสของ       

พหุนามเบิร์นสไตน์ อันดับที่ 1 กับจุดควบคุม 0 1,P P    

 
 

ภาพที่ 2-14 ภาพแสดงเสน้โค้งเบซิเยร์ อันดับ 1 

2.5.2 การแปลงฐานของพหุนามเบิร์นสไตน์ อันดับ 1 

จากสมการ (16) เราสามารถการแปลงฐานของพหุนามเบิร์นสไตน์ อันดับ 1  
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2.5.3 อนุพันธ์อันดับ 1 ของเส้นโค้งเบซิเยร์ 

จากสมการ (16) เราสามารถหาอนุพันธ์อันดับ 1 ของเสน้โค้งเบซิเยร์ อันดับ 1 ได้จาก

การแทน 1r   และ 1n   ในสมการ (15) จะได้ว่า                                              
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( , , ) ( )

(1 1)!

( )

0
1

0

i i

i

B t P P Pb t

P b t

P t t

P







  


 

 
   

 

 



                             (18) 

2.5.4 อนุพันธ์อันดับ 2 ของเส้นโค้งเบซิเยร์ 

จากสมการ (16) เราสามารถหาอนุพันธ์อันดับ 2 ของเสน้โค้งเบซิเยร์ อันดับ 1 ได้

จากการแทน 2r   และ 1n  ในสมการ (15) จะได้ว่า 

  1 0 1, , 0B t P P    (19) 

2.6 เส้นโค้งเบซิเยร์ อันดับ 2 

2.6.1 เส้นโค้งเบซิเยร์ อันดับ 2 

จากสมการ (3) เราสามารถสร้างสมการเสน้โค้งเบซิเยร์ อันดับ 2  ได้โดยการแทน

ค่า 2n  ในสมการที่ (3) จะได้ว่า 

 
2

2 0 1 2 2,

0

( , , , ) ( )k k

k

B t P P P b t P


    (20) 

โดยที ่  
2

2,

2
( ) 1

k k

kb t t t
k

 
  

 
 และ  , ,k k k kP x y z  เมื่อ  0,1, 2k   

ดังน้ันสมการเส้นโค้งเบซิเยร์ อันดับ 2  เกิดจากผลรวมเชิงเสน้ระหว่างคลาสของ       

พหุนามเบิร์นสไตน์ อันดับที่ 2 กับจุดควบคุม 0 1 2, ,P P P    
 



37 
  

 

 

ภาพที่ 2-15 ภาพแสดงเสน้โค้งเบซิเยร์ อันดับ 2 
 

2.6.2 การแปลงฐานของพหุนามเบิร์นสไตน์ อันดับ 2 

จากสมการ (20) เราสามารถการแปลงฐานของพหุนามเบิร์นสไตน์ อันดับ 2  

เป็นฐานของพหุนามยกก าลังได้โดย แทนค่า 2n   ในสมการ (14) จะได้ว่า                          

 
0

2 0 1 2 2,0 2,1 2,2 1

2

0

0 1 2 1 0

2 1 0

, , , ( ) ( ) ( )

2 0
( 1) 0 0

0 0

2 1 2 1
( 1) ( 1) 0

1 0 1 1

2 2 2 2 2 2
( 1) ( 1) ( 1)

2 0 2 1 2 2

P

B t P P P b t b t b t P

P

t t t

 
      
  

   
   

  
      
         

     

        
          

        

 

 

0

1

2

0

0 1 2

1

2

2 2

0 1 2

2 2 2

0 1 2

2

2 1 0 1 0 0

2 2

0 0 0 0 1 0

1 0 0

2 2 0

1 2 1

1 2 (1 )

1 2 (2 2 )

( 2 ) 2( )

2 ;

P

P

P

P

t t t P

P

t P t t P t P

t t P t t P t P

P P P t P P t P

P t P t P P P P




 
 
  
   

 
 



   
          
      

    

     

     

       

  (21) 
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2.6.3 อนุพันธ์อันดับ 1 ของเส้นโค้งเบซิเยร์ 

จากสมการ (20) เราสามารถหาอนุพันธ์อันดับ 1 ของเสน้โค้งเบซิเยร์ อันดับ 2 ได้

จากการแทน 1r   และ 2n  ในสมการ (15) จะได้ว่า 

            

2 1

2 0 1 2 2 1,

0

1

1,

0

2!
( , , , ) ( )

(2 1)!

2 ( )

i i

i

i i

i

B t P P P Pb t

Pb t









  


 




  (22) 

โดยที่ 1
1,

1
( ) (1 ) i i

ib t t t
i

 
  

 
  ซึ่ง  

 

1 1!

! 1 !i i i

 
 

 
   และ 1 , 0,1,2i i iP P P i      

และจากสมการ (22) เราสามารถแปลงฐานของพหุนามเบิร์นสไตน์ เป็นฐานของพหุนามยก

ก าลังได้ จะได้ว่า 

         

0

2 0 1 2 1,0 1,1

1

0

00 1

11 0

0 1

( , , , ) 2 ( )   ( )

1 0
( 1)                    0     

0 0
2   

1 1 1 1
( 1)        ( 1)

1 0 1 1

1 0
2   

1 1

P
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P

P
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P
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 
       

   
   

                  
       
       

    

 

    

 

0

1

0 1

1 0 2 1

2 1 0 1

2

0 0

2

0 0

2 1

2 1

2 2

2

2 2

P

P

t P Pt

t P P P P t

P P P t P P

P t P

P t P

  
  
   

      

      

      

     

   

  (23) 

2.6.4 อนุพันธ์อันดับ 2 ของเส้นโค้งเบซิเยร์ 

จากสมการ (20) เราสามารถหาอนุพันธ์อันดับ 2 ของเสน้โค้งเบซิเยร์ อันดับ 2 ได้

จากการแทน 2r   และ 2n  ในสมการ (15) จะได้ว่า 
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 
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2 0 1 2 2-2,

0

0
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0,

0

2

0 0,0

02 0

0

2

0

2!
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(2 - 2)!
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0
2 1

0

2
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i

i i

i

B t P P P Pb t

Pb t

P b t

P t t

P





  

 

 

 
   

 

 




  (24) 

2.6.5 ความต่อเนื่องของเส้นโค้งเบซิเยร์ 

จากบทนิยามที่ 1 ท าให้ได้ทราบว่าเมื่อ ก าหนดให้ 

 
0 1

0 1 0 1 0 1

( ) ( , , , , )

( , , , , ), ( , , , , ), ( , , , , )

n n

n n n

r t B t P P P

x t P P P y t P P P z t P P P

 

   
 

เป็นฟังก์ชันที่ส่งจากช่วง  0,1  ไปยัง 3  เราจะกลา่วว่า   2 0 1( , , , , )nr t B t P P P 

ต่อเน่ืองบนช่วง  0,1  ก็ต่อเมื่อ 

1. 0 1( , , , , )nr t P P P หาค่าได ้ส าหรับทุกค่า t  ที่อยู่ในช่วง  0,1  

2.  
*

*

0 1lim , , , , n
t t

r t P P P


,  
*

*

0 1lim , , , , n
t t

r t P P P


 หาคา่ได้ ส าหรับทุกค่า 

t  ที่อยู่ในช่วง  0,1  และ 

   
* *0 1 0 1lim , , , , lim , , , ,n n

t t t t
r t P P P r t P P P

  
  

3.  
*

*

0 1 0 1( , , , , ) lim , , , ,n n
t t

r t P P P r t P P P


  

หมายเหต ุ  * 0,1t  และถ้าหากขาดคุณสมบัติขอ้ใดข้อหน่ึง ก็ไม่เป็นฟังก์ชัน

ต่อเน่ือง 

2.6.6 ความราบเรยีบของเส้นโค้งเบซิเยร์ 

จากบทนิยามที่ 2 ท าให้ได้ทราบว่าเมื่อ ก าหนดให้ 

 
0 1

0 1 0 1 0 1

( ) ( , , , , )

( , , , , ), ( , , , , ), ( , , , , )

n n

n n n

r t B t P P P

x t P P P y t P P P z t P P P

 

   
 

เป็นฟังก์ชันที่ส่งจากช่วง  0,1  ไปยัง 3 เราจะกลา่วว่า   2 0 1( , , , , )nr t B t P P P   

เป็นเสน้โค้งราบเรียบบนช่วง  0,1  ก็ต่อเมื่อ 

1. 0 1( , , , , )nr t P P P    หาคา่ได้ ส าหรับทุกค่า t  ที่อยู่ในช่วง [0,1]  

2.  
*

*

0 1lim , , ,. n
t t

r t P P P


  ,  
*

*

0 1lim , , , , n
t t

r t P P P


  หาค่าได ้ส าหรับทุกค่า 

t  ที่อยู่ในช่วง  0,1  และ  

   
* *0 1 0 1lim , , , , lim , , , ,n n

t t t t
r t P P P r t P P P

  
  
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3.  
*

*

0 1 0 1( , , , , ) lim , , , ,n n
t t

r t P P P r t P P P


  

4. 
0 1( , , , , )nr t P P P  0  เมื่อ   0,0,0, ,0

n

0    

หมายเหต ุ  * 0,1t  และถ้าหากขาดคุณสมบัติขอ้ใดข้อหน่ึง ก็จะไมเ่ป็นเสน้โค้ง

ราบเรียบ 

2.6.7 การคอมโพสิตเส้นโค้งเบซิเยร์ อันดับ 2  

เสน้โค้งเบซิเยร์แต่ละเส้นน้ันมีลักษณะที่ขึ้นอยู่กับจุดควบคุม ดังน้ันเสน้โค้งเบซิเยร์ใด 

ๆ จึงมีความเป็นอิสระต่อกัน  หากเราต้องการให้เบซิเยร์สองเส้นเข้าร่วมหรือต่อกันให้เกิด

ความต่อเน่ือง เราจะต้องวางต าแหน่งจุดควบคุมของเส้นโค้งที่สองอย่างชัดเจนเพ่ือให้จุด

ควบคุมในเส้นโค้งแรกมีความสัมพันธ์ที่เหมาะสมกับจุดควบคุมในอีกเสน้โค้งหน่ึง เราเรียก

การกระท าดังกล่าวว่า การคอมโพสิตเส้นโค้งเบซิเยร์ ซึ่งในการคอมโพสิตเสน้โค้งเบซิเยร์

แบ่งเป็นการคอมโพสติแบบ C และแบบ G เราจึงไดศึ้กษาหัวข้อที่เกี่ยวข้องต่อไปนี้ 

2.6.7.1 เงื่อนไขการคอมโพสติเสน้โค้งเบซิเยร์แบบ 0C  และ 0G  

ก าหนดให้ 

   1 0 1, , , ,n nC t B t P P P   

และ 

   2 0 1, , , ,m mC t B t Q Q Q   

การคอมโพสติของเสน้โค้งเบซิเยร์แบบ 0C และ 0G  มีเงือนไขการต่อเน่ืองกัน

แบบ 0C และ 0G   ( 0C and 0G  Continuity) คือ จุดปลายของเส้นแรกต้องเป็นจุด

เดยีวกันกับจุดแรกของเสน้ที่สอง ดังนี้ 

   

   
1 2

0 1 0 1

0

0 1

0, , , , 1, , , ,n n m m

n

C C

B P P P B Q Q Q

P Q



  



 

 

ตัวอย่าง เงื่อนไขการคอมโพสติเสน้โค้งเบซิเยร์อันดับสองแบบ 0C และ 0G  สองเสน้  

จาก  
2 2

2 0 1 2 0 0( , , , ) 2B t P P P P t P t P      
และ  

2 2

2 0 1 2 0 0( , , , ) 2B t Q Q Q Q t Q t Q      
จะได้ว่า 
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2 0 1 2 2 0 1 2
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0 0 0 0
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P Q



   

     



 

 

 

 

 

 

 

 

 

ภาพที่ 2-16 ภาพแสดงความตอ่เน่ืองแบบ 0 0,C G     

2.6.7.2 เงื่อนไขการคอมโพสติเสน้โค้งเบซิเยร์แบบ 1C  และ 1G  

             ก าหนดให้  

   1 0 1, , , ,n nC t B t P P P   

             และ 

   2 0 1, , , ,m mC t B t Q Q Q   

ในท านองเดยีวกันการคอมโพสิตของเสน้โค้งเบซิเยร์แบบ 1C หรือ 1G ต้องมี

การต่อแบบ 0C หรือ 0G  และเงือนไขการต่อเน่ืองกันแบบ 1C และ 1G  ( 1C  and 1G  

Continuity) คือ  
 

   

   
1 2

0 1 0 1

1 1 0

0 1

0, , , , 1, , , ,n n m m

n n

C C

B P P P B Q Q Q

P P Q Q

 

   

  
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กรณีที่ 1 ถ้า  1 1C  มีขนาดและทิศทางเดียวกันกับ  2 0C เราเรียกว่าการคอมโพ

สติแบบ 1C  หรืออาจเขียนได้ว่า    1 21 0C C   แสดงให้เห็นดังภาพที่ 2-17 

 
ภาพที่ 2-17 ภาพแสดงการต่อเน่ืองแบบ 1C  ( 1C -Continuity) 

   

กรณีที่ 2 ถ้า  1 1C  มีทิศทางเดียวกันแต่มีขนาดไม่เท่ากับ  2 0C เราเรียกว่าการ

คอมโพสติแบบ 1G  แสดงให้เห็นดังภาพที่ 2-18 

 
ภาพที่ 2-18 ภาพแสดงการต่อเน่ืองแบบ 1G  ( 1G -Continuity) 

 

ตัวอย่าง เงื่อนไขการคอมโพสติเสน้โค้งเบซิเยร์อันดับสองแบบ 1C  สองเสน้  

  จาก 2

2 0 1 2 0 0( , , , ) 2 2B t P P P P t P      

  และ 2

2 0 1 2 0 0( , , , ) 2 2B t Q Q Q Q t Q      

  จะได้ว่า 

   
   2 0 1 2 2 0 1 2

2

0 0 0

2 1 1 0

1, , , 0, , ,

2 2 2

B P P P B Q Q Q

P P Q

P P Q Q

 

    

  

  

 

น่ันคือเวกเตอร์ 2 1P P  มีทิศทางเดียวกับ 2 1Q Q และ 2 1 1 0P P Q Q    ดัง

แสดงในภาพที่ 2-19 ความตอ่เน่ืองแบบและราบเรียบแบบ 1C  
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ภาพที่ 2-19 ภาพแสดงความตอ่เน่ืองแบบและราบเรียบแบบ 1C  

 
ภาพที่ 2-20 ภาพแสดงความตอ่เน่ืองแบบและราบเรียบแบบ 1G  

 

2.7 สูตรที่เกี่ยวข้องกับการวิเคราะห์เส้นโคง้ในการปิดล้อมวัตถุ และทฤษฎีของกรีน  

     2.7.1 เส้นโค้งในการปิดล้อมวัตถุ 

คือเส้นโค้งปิดที่ใช้เตรียมการตัดเสื้อผ้าโดยใช้เนือ้ผ้าน้อยที่สุด ในการสร้างเส้นโค้งใน

การปิดล้อมวัตถุ สามารถพิจารณาจาก จุดเอกพจน์ (Singular point), จุดปลายแหลม 

(Cusp Point), จุดมุม (Corner Point), จุดเปลี่ยนเว้า (Inflection Point), จุดเปลี่ยน (Turning 

Point) และเสน้โค้งออฟเซ็ต (Offset Curves) โดยก าหนดให้  

1 2( ) ( ) ( )C t C t C t   เมื่อ  0,1t  

โดยที่  

 1 0 1 22
( ) , , ,C t B t P P P  

และ   

 2 0 1 22
( ) , , ,C t B t Q Q Q  
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จุดเอกพจน์ คือ จุดที่อนุพันธ์หาค่าได้และเท่ากับ 0 น่ันคือเวกเตอร์สัมผัสหน่ึงหน่วยมี

ขนาดเท่ากับ 0 แตไ่มม่ีทิศทาง (จุดที่ไม่สามารถหาเวกเตอร์สัมผัสหน่ึงหน่วยได้) 

 

ภาพที่ 2-21 ภาพแสดงจุดเอกพจน์ 

จุดปลายแหลม คือ เมื่อน าเส้นเช่ือมมาต่อกัน ( 1 2( ) ( )C t C t ) แล้วอนุพันธ์ของ 

1( )C t ณ จุด 2P  และอนุพันธ์ของ 2 ( )C t  ณ จุด 0Q  หาค่าไม่ได้ และสามารถหาเวกเตอร์

สัมผัสหน่ึงหน่วยได้ ซึ่งทิศทางของเวกเตอร์สัมผัสหน่ึงหน่วยตรงข้ามกัน หรือมุมระหว่าง

เวกเตอร์สัมผัสหน่ึงหน่วยเท่ากับ    

 

ภาพที ่2-22 ภาพแสดงจุดปลายแหลม 

จุดมุม คือ เมื่อน าเส้นเช่ือมมาต่อกัน ( 1 2( ) ( )C t C t ) แล้วอนุพันธ์ของ 1( )C t ณ จุด 

2P  และอนุพันธ์ของ 2 ( )C t  ณ จุด 0Q  หาค่าไม่ได้ และสามารถหาเวกเตอร์สัมผัสหน่ึง

หน่วยได้ ซึ่งมุมระหว่างเวกเตอร์สัมผัสหน่ึงหน่วยอยู่ในช่วง  0,  

 
ภาพที่ 2-23 ภาพแสดงจุดมุม 
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จุดเปลี่ยนเว้า คือ เมื่อน าเสน้เช่ือมมาต่อกัน ( 1 2( ) ( )C t C t ) แล้วอนุพันธ์ของ 1( )C t

ณ จุด 2P  และอนุพันธ์ของ 2 ( )C t  ณ จุด 0Q  หาค่าได้และไม่เท่ากับ 0 และสามารถหา

เวกเตอร์สัมผัสหน่ึงหน่วยได้ ซึ่งมุมระหว่างเวกเตอร์สัมผัสหน่ึงหน่วยเท่ากับ 0 และขนาน

แกน x และแกน y  

 
 ภาพที่ 2-24 ภาพแสดงจุดเปลี่ยนเว้า 

จุดเปลี่ยน คือ เมื่อน าเส้นเช่ือมมาต่อกัน ( 1 2( ) ( )C t C t ) แลว้อนุพันธ์ของ 1( )C t ณ 

จุด 2P  และอนุพันธ์ของ 2 ( )C t  ณ จุด 0Q  หาค่าไดแ้ละเท่ากับ 0 และสามารถหาเวกเตอร์

สัมผัสหน่ึงหน่วยไดซ้ึ่งมุมระหว่างเวกเตอร์สัมผัสหน่ึงหน่วยเท่ากับ 0 และขนานแกน x และ

แกน y  

 
ภาพที่ 2-25 ภาพแสดงจุดเปลี่ยน 

  



46 
  

มุมระหว่างเวกเตอร์สัมผัสหนึ่งหน่วย 

ทฤษฎีบท 1 

 ให้ u  และ v  เป็นเวกเตอรท์ี่ไมใ่ช่เวกเตอรศู์นย์ใน 2 มิติ และ 3 มิติ และถ้า  คือมุม

ระหว่างเวกเตอร์ทั้งสองที่เล็กที่สุด แล้ว 
                                                        

 cos( )
u v

u v



         เมื่อ 0     (25)      

 

ภาพที่ 2-26 ภาพแสดงมุมระหว่างเวกเตอร์ 

กรณทีี่ 1  

ให้  

1 1 0,1 1,1

0,1 0,1

( ) ( , , )C t B t P P

P t P



  
 

และ 

2 1 0,2 1,2

0,2 0,2

( ) ( , , )C t B t P P

P t P



  
 

โดยที ่  0,1 0,1 0,1,P x y และ  0,2 0,2 0,2,P x y  

จะได้  

 
1 0,1

0,1 0,1

0,1 0,

2

1

2

1

( )

,

( ) ( ) ( )

C t P

x y

C yxt

  

  

    

 

และ   

 
2 0,2

0,2 0,2

0,2 0,

2

2

2

2

( )

,

( ) ( ) ( )

C t P

x y

C yxt

  

  

    
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จากสมการ (25) จะได้มุมระหว่างเวกเตอร์สัมผัสหน่ึงหน่วยดังนี ้ 

     
   

     

1 2

1 2

0,1 0,1 0,2 0,2

2 2 2 2

0,1 0,2 0,1 0

0,1 0,1 0,2 0,2

0,1 0,1 0,2 0

,2

2 2 2

2

2

,

( ) ( )
cos( )

( ) ( )

, ,

( ) ( ) ( ) ( )

( ) ( ) ( ) ( )

C t C t

C t C t

x y x y

y y

x x y y

y y

x x

x x


 


 

    


     

    


     

  (26) 

กรณทีี่ 2  

ให้  

1 2 0,1 1,1 2,1

2 2

0,1 0,1 0,1

( ) ( , , , )

2

C t B t P P P

P t P t P



    
 

และ 

2 2 0,2 1,2 2,2

2 2

0,2 0,2 0,2

( ) ( , , , )

2

C t B t P P P

P t P t P



    
 

     โดยที ่  0,1 0,1 0,1,P x y และ  0,2 0,2 0,2,P x y  

     จะได้  

 

   

2

1 0,1 0,1

2 2

0,1 0,1 0,1 0,1

2 2
2 2

1 0,1 0,1 0,1 0,1

( ) 2 2

2 2 ,2 2

( ) 2 2 2 2

C t P t P

x t x y t y

C t x t x y t y

    

      

        

 

     และ   

 

   

2

2 0,2 0,2

2 2

0,2 0,2 0,2 0,2

2 2
2 2

2 0,2 0,2 0,2 0,2

( ) 2 2

2 2 ,2 2

( ) 2 2 2 2

C t P t P

x t x y t y

C t x t x y t y

    

      

        

 

      

     จากสมการ (25) จะได้มุมระหว่างเวกเตอร์สัมผัสหน่ึงหน่วยดังนี้ 
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   

       

  

1 2

1 2

2 2 2 2

0,1 0,1 0,1 0,1 0,2 0,2 0,2 0,2

2 2 2 2
2 2 2 2

0,1 0,1 0,1 0,1 0,2 0,2 0,2 0,2

2 2 2

0,1 0,1 0,2 0,2 0,

( ) ( )
cos( )

( ) ( )

2 2 ,2 2 2 2 ,2 2

2 2 2 2 2 2 2 2

2 2 2 2 2

C t C t

C t C t

x t x y t y x t x y t y

x t x y t y x t x y t y

x t x x t x y


 


 

            


             

       


  

       

2

1 0,1 0,2 0,2

2 2 2 2
2 2 2 2

0,1 0,1 0,1 0,1 0,2 0,2 0,2 0,2

2 2 2

2 2 2 2 2 2 2 2

t y y t y

x t x y t y x t x y t y

    

             

    (27) 

 

     กรณทีี่ 3  

     ให้  

1 2 0,1 1,1 2,1

2 2

0,1 0,1 0,1

( ) ( , , , )

2

C t B t P P P

P t P t P



    
 

     และ 

2 1 0,2 1,2

0,2 0,2

( ) ( , , )C t B t P P

P t P



  
 

     โดยที ่  0,1 0,1 0,1,P x y และ  0,2 0,2 0,2,P x y  

     จะได้  

 

   

2

1 0,1 0,1

2 2

0,1 0,1 0,1 0,1

2 2
2 2

1 0,1 0,1 0,1 0,1

( ) 2 2

2 2 ,2 2

( ) 2 2 2 2

C t P t P

x t x y t y

C t x t x y t y

    

      

        

 

     และ   

 
2 0,2

0,2 0,2

0,2 0,

2

2

2

2

( )

,

( ) ( ) ( )

C t P

x y

C yxt

  

  

    
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     จากสมการ (25) จะได้มุมระหว่างเวกเตอร์สัมผัสหน่ึงหน่วยดังนี้ 

      
   

   

     

   

1 2

1 2

2 2

0,1 0,1 0,1 0,1 0,2 0,2

2 2
2 2 2 2

0,1 0,1 0,1 0,1

2 2

0,1 0,1 0,2 0,1 0,1 0,2

2
2 2

0,1 0,1 0,1 0

0,2 0,2

,1

( ) ( )
cos( )

( ) ( )

2 2 ,2 2 ,

2 2 2 2 ( ) ( )

2 2 2 2

2 2 2 2

C t C t

C t C t

x t x y t y x y

x t x y t y y

x t x x y

x

t y y

x t x y t y


 


 

        


         

        


      
2

2 2

0,2 0,2( ) ( )x y  

  (28) 

 

ในการสร้างเส้นโค้งในการปิดล้อมวัตถุ ที่พิจารณาจากจุดเอกพจน์, จุดปลายแหลม, 

จุดมุม, จุดเปลี่ยนเว้า และจุดเปลี่ยน สามารถสร้างได้จากการลากเสน้ตรงเช่ือมระหว่างมุม 

ที่เกิดจากการน าเสน้โค้ง 2 เสน้มาตอ่กันทุกมุม 

 

 

 

 

 

 

ภาพที่ 2-27 ภาพแสดงเสน้โค้งในการปิดล้อมวัตถุที่พิจารณาจาก จุดเอกพจน์,  

จุดปลายแหลม, จุดมุม, จุดเปลี่ยนเว้า และจุดเปลี่ยน 
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บทนยิาม 3 เสน้โค้งออฟเซ็ตของเสน้โค้งเบซิเยร์  (Offset curve of  Bezier Curve) 

 0 1 0 1 0 1( , , , , ) ( , , , , ) ( , , , , )n n n nO t P P P B t P P P n t P P P d      (29) 

เมื่อ  0 1( , , , , )nO t P P P คือ Offset curve of  Bezier Curve 

     0 1( , , , , )nn t P P P  คือ เวกเตอร์หน่ึงหน่วย  

  d    คือ ระยะห่างที่น้อยที่สุดของ Offset curve  

 

ภาพที่ 2-28 ภาพแสดงเสน้โค้งออฟเซ็ตของเสน้โค้งเบซิเยร์  อันดับ 2 

เมทรกิซ์การหมุนในปริภูมิสองมิติ (Rotation matrix) 

ให้  old 0 0,P x y แทนพิกัดเร่ิมต้นที่ท ามุมกับแกน X เป็นมุม  และ  new 1 1,P x y

เป็นพิกัดใหม่ที่เกิดจากการหมุนพิกัด  old 0 0,P x y เป็นมุม  โดยมีทิศการหมุนทวนเข็ม

นาฬิกา ซึ่งจะพิจารณาหาเมทรกิซ์การหมุนในสองมิติรอบจุดก าเนดิ  

 

ภาพที่ 2-29 ภาพแสดงการหมุนของพิกัดจุด 2 มิติรอบจุดก าเนดิ 

θ + Ø 
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เราจะได้ว่า  

 

 
1

1

cos cos( )cos( ) sin( )sin( )

sin cos( )sin( ) sin( )cos( )

x r r r

y r r r

     

     

   

   
 

แตเ่ราทราบว่า  0 0cos , sin( )x r y r       

ท าให้ได้ว่า 

1 0 0

1 0 0

cos( ) sin( )

sin( ) cos( )

x x y

y x y

 

 

 

 
 

จะได้ว่าพิกัดใหม่  1 1,newP x y  เราสามารถเขียนใหม่ได้ว่า 

 01

01

cos( ) sin( )

sin( ) cos( )
new

xx
P

yy

 

 

     
      

    
  (30) 

เรียกเมทรกิซ์   
cos( ) sin( )

sin( ) cos( )

 

 

 
 
 

  ว่าเมทรกิซ์การหมุนในสองมิติรอบจุดก าเนดิ 

เวกเตอร์หนึ่งหน่วย (Unit vector)  

( )n t คือ เวกเตอร์หน่ึงหน่วยที่เกิดจากการหมุนเวกเตอร์สัมผัสหน่ึงหน่วย ( )T t  ใน

ทิศทางทวนเข็มนาฬิกาด้วยมุม 
2


 

จากสมการ (30) แทน 
2


  จะได้เวกเตอร์หน่ึงหน่วยดังนี ้

0

0

0

0

0

0

cos sin
2 2

( )

sin cos
2 2

0 1

1 0

x
n t

y

x

y

y

x

 

 

    
    

       
      
    

    

   
   

   

 
  

 

             

โดยที่ 0

0

x

y

 
 
 

คือพิกัดของเวกเตอร์สัมผัสหน่ึงหน่วย ( ( )T t ) 
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ดังน้ันเวกเตอร์หน่ึงหน่วยที่เกิดจากการหมุนเวกเตอร์สัมผัสหน่ึงหน่วยคือ 

    0 0,n t y x    (31) 

จากสมการ (29) แทน ( )n t ดว้ยสมการ (31) จะได้เสน้โค้งออฟเซ็ตของเสน้โค้งเบซิเยร์  

ดังน้ี 

  0 1 0 1 0 0( , , , ) ( , , , ) ,n n nO t P P P B t P P P d y x       (32) 

2.7.2 ทฤษฎีของกรีน (Green’s Theorem) 

บทนยิาม 4  

1. เสน้โค้งปิด (Closed curve) 

 สมการอิงตัวแปรเสริมที่แสดงโดยเวกเตอร์ ( )r t ส าหรับ a t b  จะเรียกว่า

เสน้โค้งปิด ถ้าจุดเร่ิมต้น ( )r a  และจุดปลาย ( )r b  เหมือนกัน น่ันคือ ( ) ( )r a r b    

 
ภาพที่ 2-30 ภาพแสดงเสน้โค้งปิด 

2. เสน้โค้งอยา่งง่าย (Simple curve) 

 คือเสน้โค้งที่ไม่ตัดกัน 

 

 

 

ภาพที่ 2-31 ภาพแสดงเสน้โค้งอยา่งง่าย 
 

              

 

 

ภาพที่ 2-32 ภาพแสดงที่ไมใ่ช่เสน้โค้งอยา่งง่าย 
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3. เสน้โค้งราบเรียบเป็นส่วน ๆ (Piecewise smooth curve) 

  คือเสน้โค้งที่เกิดจากเสน้โค้งราบเรียบหลายเสน้ 1 2( , ,..., )nC C C เช่ือมกันต้ังแต่

เสน้แรกจนเสน้สุดท้าย 

 

 

 

 

ภาพที่ 2-33 ภาพแสดงเสน้โค้งราบเรียบเป็นส่วน ๆ 

                  4. โดเมนที่ต่อเน่ือง (Connected domain) 

   คือจุด 2 จุดใด ๆ ใน D  สามารถเช่ือมโดยเส้นโค้งราบเรียบเป็นส่วน ๆ ที่

ทั้งหมดอยู่ใน D  หรือ D  เป็นโดเมนที่ต่อต่อเน่ือง ถ้าไม่ประกอบดว้ย 2 สว่น หรือ

มากกว่า 2 สว่น 

 

 

 

ภาพที่ 2-34 ภาพแสดงโดเมนที่ต่อเน่ือง 

 
 

 

 

ภาพที่ 2-35 ภาพแสดงโดเมนที่ไมต่่อเน่ือง 
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5. โดเมนที่ต่อเน่ืองอย่างง่าย (Simply Connected domain) 

   จะเรียก เซต D  ที่ต่อเน่ืองใน 2 มิติ ว่าโดเมนที่ต่อเน่ืองอย่างง่าย ถ้าเส้นโค้ง

ปิดอย่างง่าย ใน D  แล้วจุดล้อมรอบไม่อยู่ใน D  หรือจะเรียกว่า โดเมนที่ต่อเน่ือง

อย่างง่ายถ้าไม่มหีลุม  

 

 

 

 

ภาพที่ 2-36 ภาพแสดงโดเมนที่ต่อเน่ืองอย่างง่าย                 

หรือเรียกว่า โดเมนที่ต่อเน่ืองทวีคูณ (Multiply Connected domain) ถ้าเส้น

โค้งปิดอย่างง่าย ใน D  แล้วจุดล้อมรอบอยู่ใน D  หรือจะเรียกว่า โดเมนที่ต่อเน่ือง

ทวีคูณ ถ้าไม่มหีลุม ถ้ามีมากกว่า 1 หลุม 

 

 
 

 

 

ภาพที่ 2-37 ภาพแสดงโดเมนที่ต่อเน่ืองทวีคูณ 

สนามเวกเตอร์ (Vector Fields) 

ถ้าให้ F  เป็นฟังก์ชันค่าเวกเตอร์ที่นิยามใน 3  ซึ่ง 

  ˆˆ ˆ( , , ) ( , , ) ( , , ) , ,F x y z f x y z i g x y z j h x y z k    

แล้วเรียกฟังก์ชัน F  ว่าสนามเวกเตอร์ (Vector Fields)  เราสามาหาสนามเวกเตอร์

ได้ จากการหาเกรเดยีนต์ของสนามสเกลาร์  

ให้   เป็นสนามสเกลาร์ และ F เป็นสนามเวกเตอร์ ที่ F   แล้วเรียก F  

ว่าเป็นสนามเวกเตอร์เกรเดยีนต์ (gradirnt vector field) โดยที ่

ˆˆ ˆgrad i j k
x y z

  
 

  
    

  
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จะเรียกฟังก์ชัน   ว่า ฟังก์ชันศักย์ (potential function) สัญลักษณ์    อ่านว่า เดล 

เป็นตัวด าเนินการ ที่ 

ˆˆ ˆi j k
x y z

  
   

  
 

ทฤษฎีบท สนามเวกเตอร์อนุรักษ์ (Conservative Vector Fields) 

ถ้า (x, y)f  และ ( , )g x y ต่อเน่ือง และอนุพันธ์ย่อยอันดับ 1 ต่อเน่ืองบนพืน้ที่เปิด D 

และ ˆ ˆ( , ) ( , ) ( , )F x y f x y i g x y j   คือ สนามเวกเตอร์อนุรักษ์ แล้ว 

 f g

y x

 


 
  

บทนยิาม 5 การหางานจากการอินทิกรัลตามเสน้ (work as a line integral) 

ถ้า F คือสนามเวกเตอร์แบบต่อเน่ือง และC เป็นเส้นโค้งราบเรียบใน 2 มิติ และมี 

Unit tangent vector ( )T  แล้วงานที่ด าเนินการโดยสนามเวกเตอร์บนวัตถุที่เคลื่อนที่ไปตาม

เสน้โค้ง C  ในทิศทางเพ่ิมขึ้น คือ 

;
C

C

dr
W F T ds T

ds

F dr

  






 

 

เน่ืองจาก 2 2ˆ ˆ( , ) ( , ) ( , ) ; :F x y f x y i g x y j F    

และ ˆ ˆdr dxi dyj   ดังน้ัน 

 ( , ) ( , )
C

W f x y dx g x y dy    (33) 

ถ้า ˆ ˆ( , ) ( , ) ( , )F x y f x y i g x y j   เป็นสนามเวกเตอร์อนุรักษ์ใน และ  (x, y)f  และ 

( , )g x y ต่อเน่ือง ถ้า  

   , ,F x y x y   

และถ้า C  เป็นเสน้โค้งราบเรียบเป็นส่วน ๆ เร่ิมจาก  0 0,x y  ถึง  1 1,x y  แล้ว 

      1 1 0 0, , ,
C

W F x y dr x y x y      
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น่ันคือถ้า F  เป็นสนามอนุรักษ์ การอินทีเกรตจะเป็นอิสระตอ่วิถี คือจะไม่ขึน้กับทางเดนิ 

(Path) แตจ่ะขึน้อยู่กับจุดเร่ิมต้น และจุดส้ินสุดเท่านัน้  

จากสมการ (33) สามารถน าไปประยุกต์เป็นทฤษฎีบทของกรีน (Green’s Theorem) ได้ โดย

มีเงื่อนไขหลักคือเสน้โค้งต้องเป็นเสน้โค้งปิด 

 

ทฤษฎีบท 2 ทฤษฎีของกรีน 

ให้ R  เป็นบริเวณที่โดเมนต่อเน่ืองอย่างง่าย ที่มีขอบเขต (เส้นโค้งอย่างง่าย, เสน้โค้ง

ปิด, เสน้โค้ง C  ราบเรียบเป็นส่วน ๆ) และทิศทางของเสน้โค้งทวนเข็มนาฬิกา ถ้า (x, y)f

และ ( , )g x y ต่อเน่ือง และอนุพันธ์ย่อยอันดับ 1 ต่อเน่ืองบน R  แล้ว 

 ( , ) ( , )
C R

g f
f x y dx g x y dy dA

x y

  
   

  
    (34) 

จากทฤษฎีบทของกรีน  (34) 

ก าหนดให้  

ˆ ˆ( , ) ( , ) ( , )F x y f x y i g x y j   

กรณทีี่ 1 ให้  

1 1ˆ ˆ( , )
2 2

F x y yi xj    

       
 

 

 

 

 

 

 

ภาพที่ 2-38 ภาพแสดงสนามเวกเตอร์ 1 1ˆ ˆ( , )
2 2

F x y yi xj     

          จะได้ 1

2

g

x





และ 1

2

g

y


 


 

          ดังน้ัน 
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 

( , ) ( , )

1 1

2 2

1 1

2 2

1

C R

R

R

R

g f
f x y dx g x y dy dA

x y

dA

dA

dA

A

  
   

  

  
    

  

 
  

 





 







 

กรณทีี่ 2 ให้  

1 3ˆ ˆ( , )
2 2

F x y yi xj    

 

 

 

 

 

 

ภาพที่ 2-39 ภาพแสดงสนามเวกเตอร์ 1 3ˆ ˆ( , )
2 2

F x y yi xj    

จะได้ 3

2

g

x





และ 1

2

g

y


 


 

          ดังน้ัน   

 

( , ) ( , )

3 1

2 2

3 1

2 2

2

2

C R

R

R

R

g f
f x y dx g x y dy dA

x y

dA

dA

dA

A

  
   

  

  
    

  

 
  

 





 






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 กรณทีี่ 3 ให้  

ˆ ˆ( , )F x y yi xj   

 

 

 

 

 

 

ภาพที่ 2-40 ภาพแสดงสนามเวกเตอร์ ˆ ˆ( , )F x y yi xj   

             จะได้ 1
g

x





และ 1

g

y





 

              ดังน้ัน   

 

 

( , ) ( , )

1 1

0

0

C R

R

R

g f
f x y dx g x y dy dA

x y

dA

dA

  
   

  

 





 





 

การประยุกต์ใช้ทฤษฎีบทของกรีนในการหาพื้นที่ 

 
ภาพที่ 2-41 ภาพแสดงบรเิวณ R 
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เน่ืองจาก พ้ืนที่ของ 1
R

R dxdy   

ถ้าสามารถหาสนามเวกเตอร์  

ˆ ˆ( , ) ( , ) ( , )F x y f x y i g x y j   

ซึ่ง  

1
g f

x y

 
 

 
 

จะสามารถใช้ทฤษฎีของกรนีได ้จากสมการ (34) จะได้ 

                                    

( , ) ( , )

1

Area

C R

R

g f
f x y dx g x y dy dA

x y

dA

R

  
   

  





 

  

ดังน้ัน 

 rea( , ) ( , ) A
C

f x y dx g x y dy R    (35) 

ในการเลือก ( , )f x y และ ( , )g x y ที่เหมาะสมเพ่ือน าไปใช้ในทฤษฎีของกรีน อันดับแรกต้อง

หา ( , )f x y และ ( , )g x y  ที่มีคุณสมบัตต่ิอไปนี ้

                                                          1
g f

x y

 
 

 
 

ซึ่งพิจารณา 3 กรณี ประกอบดว้ย 

กรณทีี่ 1  

 

ภาพที่ 2-42 ภาพแสดงสนามเวกเตอร์ ( , ) ˆx yF xj  
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ให้ ( , ) 0f x y   และ ( , )g x y x  

     ดังน้ัน  

( , ) ˆx yF xj  
     จากสมการ (35) จะได้ 

                                        
( , ) ( , eaAr)

C

c

f x y dx g x y dy

x dy

R

A

 






 

     เน่ืองจาก  

( ) ( ) ( )r t dy r t y t dt    

 แทน 

1 0 1

0 0

( ) ( , , ) ; [0,1]r t B t P P t

P t P

 

  
 

          โดนที่ 0 1 0P P P    และ  0 0 0 1 0 0 1( ( , , , ), ( , , , ))n nP x t P P P y t P P P    

 จะได้  

0 1 0 0( , , , )nx t P P P x t x     

 และ  

0 1 0 0

0 1 0

( , , , )

( , , , )

n

n

y t P P P y t y

y t P P P y

   

   
 

ดังน้ัน   

0

0 0

( , , , )
0 1

1
( , , , ) ( , , , )

0 1 0 1
0

1
( ) ( )

0 0 0
0

1
( ) ( )

0 0 0
0

1
2

( )
0 0 02

0

( )
2

x dy x t P P P dy
n

c c

x t P P P y t P P P dt
n n

x t x y dt

y x t x dt

t
y x x t

x
y x

  

   

    

   

 
    
  

 
   

 

                                               (36) 
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 แทน 

2 0 1 2

2 2

0 0 0

( ) ( , , , ) ; [0,1]

2

r t B t P P P t

P t P t P

 

    
 

          โดนที่ 0 1 0P P P    และ  0 0 0 1 0 0 1( ( , , , ), ( , , , ))n nP x t P P P y t P P P    

 จะได้  
2 2

0 1 0 0 0( , , , ) 2nx t P P P x t x t x       

 และ  
2 2

0 1 0 0 0

2

0 1 0 0

( , , , ) 2

( , , , ) 2 2

n

n

y t P P P y t y t y

y t P P P y t y

     

     
 

ดังน้ัน         

         

0 1

1

0 1 0 1

0

1
2 2 2

0 0 0 0 0

0

2 2 3 2 2 2 21
0 0 0 0 0 0 0 0

2
0 0 0 0 0

2 2 4 2 3 2

0 0 0 0 0

( , , , )

( , , , ) ( , , , )

( 2 )( 2 2 )

2 2 4 4

2 2

2 2 4

4 3

n

c c

n n

x dy x t P P P dy

x t P P P y t P P P dt

x t x t x y t y dt

x y t x y t x y t x y t
dt

x y t x y

x y t x y t x

 

   

       

           
       

     
 



 







1
3 2

0 0 0

2 2

0 0

0 0
0

1
2 2 4 2 3 2 3

20 0 0 0 0 0

0 0

2 2

0 0 0 0 0

2 2 2 2

20 0 0 0 0 0

0 0 0 0

0 0

4

3 2

2
2

2

2 4
2

2 3 3

2

2 4
2

2 3 3

2

y t x y t

x y t
x y t

x y t x y t x y t
x y t

x y t x y t

x y x y x y
x y x y

x y

  
 

 
 
   
 

      
     


 
     

     
      



 

     (37) 
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กรณทีี่ 2  

 

ภาพที่ 2-43 ภาพแสดงสนามเวกเตอร์ ( , ) ˆx yF yi   

ให้ ( , )f x y y  และ ( , ) 0g x y   

     ดังน้ัน  

( , ) ˆx yF yi   
     จากสมการ (35) จะได้ 

                                        
( , ) ea( r, ) A

C

c

f x y d Rx g x y dy

y dx A

 

 




 

     เน่ืองจาก  

( ) ( ) ( )r t dx r t x t dt    

 แทน 

1 0 1

0 0

( ) ( , , ) ; [0,1]r t B t P P t

P t P

 

  
 

          โดนที่ 0 1 0P P P    และ  0 0 0 1 0 0 1( ( , , , ), ( , , , ))n nP x t P P P y t P P P    

 จะได้  

0 1 0 0

0 1 0

( , , , )

( , , , )

n

n

x t P P P x t x

x t P P P x

   

   
 

 และ  

                           0 1 0 0( , , , )ny t P P P y t y     

 ดังน้ัน    
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0 1

1

0 1 0 1

0

1

0 0 0

0

1

0 0 0

0

1
2

0 0 0

0

0

0 0

( , , , )

( , , , ) ( , , , )

( ) ( )

( ) ( )

( )
2

( )
2

n

c c

n n

y dx y t P P P dx

y t P P P x t P P P dt

y t y x dt

x y t y dt

t
x y y t

y
x y

   

    

     

    

 
     

 

 
    

 

 






                                            (38) 

 แทน 

2 0 1 2

2 2

0 0 0

( ) ( , , , ) ; [0,1]

2

r t B t P P P t

P t P t P

 

    
 

          โดนที่ 0 1 0P P P    และ  0 0 0 1 0 0 1( ( , , , ), ( , , , ))n nP x t P P P y t P P P    

 จะได้  
2 2

0 1 0 0 0

2

0 1 0 0

( , , , ) 2

( , , , ) 2 2

n

n

x t P P P x t x t x

x t P P P x t x

     

     
 

 และ  
2 2

0 1 0 0 0( , , , ) 2ny t P P P y t y t y       

ดังน้ัน               
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0 1

1

0 1 0 1

0

1
2 2 2

0 0 0 0 0

0

2 2 3 2 2 2 21
0 0 0 0 0 0 0 0

2
0 0 0 0 0

2 2 4 2 3

0 0 0 0

( , , , )

( , , , ) ( , , , )

( 2 )( 2 2 )

2 2 4 4

2 2

2 2

4 3

n

c c

n n

y dx y t P P P dx

y t P P P x t P P P dt

y t y t y x t x dt

x y t x y t x y t x y t
dt

y x t y x

x y t x y t

   

    

        

           
        

   
 

 

 







1
2 3 2

0 0 0 0

2 2

0 0

0 0
0

1
2 2 4 2 3 2 3

20 0 0 0 0 0

0 0

2 2

0 0 0 0 0

2 2 2 2

0 0 0 0 0 0

0 0

2

0 0 0 0

4 4

3 2

2
2

2

2 4
2

2 3 3

2

2 4
2

2 3 3

2

x y t x y t

y x t
y x t

x y t x y t x y t
x y t

y x t y x t

x y x y x y
x y

y x y x

    
 

 
 
   
 

      
      

 
     

      
      

 
     

  (39) 

 

กรณทีี่ 3  

 

ภาพที่ 2-44 ภาพแสดงสนามเวกเตอร์ 
1 1 ˆ( , )
2

ˆ
2

F ix y y xj   
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ให้ 1
( , )

2
f x y y  และ 1

( , )
2

g x y x  

ดังน้ัน  

1 1 ˆ( , )
2

ˆ
2

F ix y y xj   

จากสมการ (35) จะได้ 

                                        
( , ) ( , ) Area

1 1

2 2

C

c

f x y dx g x y dy

y

R

dx x dy A

 

 





 

เน่ืองจาก  

( ) ( ) ( )r t dx r t x t dt    

และ  

( ) ( ) ( )r t dy r t y t dt    

 แทน 

1 0 1

0 0

( ) ( , , ) ; [0,1]r t B t P P t

P t P

 

  
 

          โดนที่ 0 1 0P P P    และ  0 0 0 1 0 0 1( ( , , , ), ( , , , ))n nP x t P P P y t P P P    

 จะได้  

0 1 0 0

0 1 0

( , , , )

( , , , )

n

n

x t P P P x t x

x t P P P x

   

   
 

 และ  

                           0 1 0 0

0 1 0

( , , , )

( , , , )

n

n

y t P P P y t y

y t P P P y

   

   
 

 ดังน้ัน    
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0 1 0 1

1
0 1 0 1

0 1 0 10

1

0 0 0 0 0 0

0

1

0 0 0 0 0 0

0

1 1 1 1
( , , , ) ( , , , )

2 2 2 2

( , , , ) ( , , , )1

( , , , ) ( , , , )2

1
( )( ) ( )( )

2

1
( ) (

2

n n

c c

n n

n n

y dx x dy y t P P P dx x t P P P dy

y t P P P x t P P P dt

x t P P P y t P P P dt

y t y x dt x t x y dt

x y t y x dt x y t

     

   


   

        

     



 

 







 

 

0 0

1

0 0 0 0 0 0 0 0

0

1

0 0 0 0

0

1

0 0 0 0 0

0 0 0 0

)

1
( )

2

1
( )

2

1

2

1

2

x y dt

x y t y x x y t x y dt

x y y x dt

x y t y x t

x y y x

 

        

   

   

   





  (40) 

 

 แทน 

2 0 1 2

2 2

0 0 0

( ) ( , , , ) ; [0,1]

2

r t B t P P P t

P t P t P

 

    
 

          โดนที่ 0 1 0P P P    และ  0 0 0 1 0 0 1( ( , , , ), ( , , , ))n nP x t P P P y t P P P    

 จะได้  
2 2

0 1 0 0 0

2

0 1 0 0

( , , , ) 2

( , , , ) 2 2

n

n

x t P P P x t x t x

x t P P P x t x

     

    
 

 และ  
2 2

0 1 0 0 0

2

0 1 0 0

( , , , ) 2

( , , , ) 2 2

n

n

y t P P P y t y t y

y t P P P y t y

     

     
 

ดังน้ัน         
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0 1 0 1

1
0 1 0 1
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1
2 2 2
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1 1 1 1
( , , , ) ( , , , )

2 2 2 2
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( 2 )(2 2 )

2

( 2 )(2 2 )
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n n

n n

y dx x dy y t P P P dx x t P P P dy

y t P P P x t P P P dt

x t P P P y t P P P dt

y t y t y x t x dt

x t x t x y t y dt

     

   


   

       


      







 





2 2 3 2 2 2 21
0 0 0 0 0 0 0 0

2
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2
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0 0 0 0 0 0 0 0
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x y t x y t x y t x y t
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y x t y x

x y t x y t x y t x y t
dt

x y t x y

x y t x y t y x t y x

x y t x

            
      

           
       

        


  





1
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1
2 3 2 3 2 2

0 0 0 0 0 0
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2 2
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0 0
0

1
2 3 2 3

2 20 0 0 0

0 0 0 0

2 2

0 0 0 0 0
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0 0 0

2 2 2
2

1 3 3 2

2 2
2

2

2 2
21

3 3
2

2

2 2
21

3 3
2

dt
y

x y t x y t y x t
y x t

x y t
x y t

x y t x y t
y x t y x t

x y t x y t

x y x y
y x y

 
   

     
    

 
 
   
 

    
     


 
     

   
   





2

0 0 0

0 0

2 2 2 2

0 0 0 0 0 0 0 0

0 0

0 0

2

3 3 2 2

x x y

x y

x y x y y x x y
y x

x y

 
   

 
   

     
    



 

  (41) 
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ภาพที่ 2-45 ภาพแสดงพืน้ที่แบบรูปหลายเหลี่ยม 

การหาพื้นที่ของรูปหลายเหลี่ยม (Polygon)  

                   

2 3 11 2

2 3 11 2

1 1

1

1

2

1
( )

2

n

n

n

i i i i

i

x x x xx x
A

y y y yy y

x y x y 



 
    

 



                                (42) 

โดยที่ ( , )i ix y  คือ จุดควบคุมของเสน้โค้งเบซิเยร์ และ n คือจ านวนเสน้โค้ง 

 

 

 

 

 

ภาพที่ 2-46 ภาพแสดงพืน้ที่แบบรูปหลายเหลี่ยมและเสน้โค้ง 
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การหาพื้นที่โดยใช้ทฤษฎีบทของกรีน 

การหาพืน้ที่ของเสน้โค้งเบซิเยร์ อันดับ 1 

จากสมการ  จะได้ 

 
1

( )
2

n
i

i i

i

x
A y x



 
   

 
   (43) 

การหาพืน้ที่ของเสน้โค้งเบซิเยร์ อันดับ 2 

จากสมการ  จะได้ 

 
2 2 2 2

2

1

2 4
2 2

2 3 3

n
i i i i i i

i i i i i i

i

x y x y x y
A x y x y x y



     
            (44) 

โดยที่ 1 1,i i i i i ix x x y y y        และ n คือจ านวนเสน้โค้ง 

และ ( , )i ix y  คือ จุดควบคุมของเสน้โค้งเบซิเยร์   

การหาพื้นที่ของรูปหลายเหลี่ยมและใช้ทฤษฎีบทของกรีน 

การหาพืน้ที่ของเสน้โค้งเบซิเยร์ อันดับ 1 

จากสมการ (42)  จะได้ 

 1 1

1

1
( )

2

n

i i i i

i

A x y x y 



    

การหาพืน้ที่ของเสน้โค้งเบซิเยร์ อันดับ 2 

จากสมการ (44)  จะได้ 

2 2 2 2

2

1

2 4
2 2

2 3 3

n
i i i i i i

i i i i i i

i

x y x y x y
A x y x y x y



     
           

โดยที่ 1 1,i i i i i ix x x y y y        และ n คือจ านวนเสน้โค้ง 

และ ( , )i ix y  คือ จุดควบคุมของเสน้โค้งเบซิเยร์



 
 

บทท่ี 3 

 

วิธีการด าเนินการวิจัย 

 

 ในบทน้ีจะกล่าวถึงวิธกีารด าเนนิงานการศึกษาวิจัย เร่ือง การประยุกต์ใช้เสน้โค้ง                    

เบซิเยร์ในการออกแบบชุด ซึ่งไดน้ าความรู้จากทฤษฎีบท โปรแกรมจีโอจีบา (Geogebra) และ 

เบลนเดอร์ (Blender) มาใช้ในการด าเนนิงานวิจัย โดยมีขัน้ตอนดังต่อไปนี้ 

3.1 ขั้นตอนการออกแบบชุดในกระดาษ 

3.2 ขั้นตอนการออกแบบชุดในโปรแกรมเบลนเดอร ์(Blender) 

3.3 ขั้นตอนการตัดชุดในโปรแกรมเบลนเดอร ์(Blender) 

3.4 ขั้นตอนการลงลายบนชุดที่ตัดเย็บในโปรแกรมเบลนเดอร ์(Blender) 

3.5 ขั้นตอนการเก็บจุดเพื่อการใช้งานอื่น ๆ 

3.1 ขั้นตอนการออกแบบชุดในกระดาษ 

3.1.1 ชุดเดรสกระโปรงทรงสอบ  

ภาพที ่3-1 แบบชุดเดรสกระโปรงทรงสอบ
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     3.1.2 ชุดเดรสกระโปรงทรงบาน 

ภาพที ่3-2 แบบชุดเดรสกระโปรงทรงบาน 

3.2 ขั้นตอนการออกแบบชุดในโปรแกรมเบลนเดอร์ (Blender) 

ในขั้นตอนน้ี จะท าการออกแบบชุดรูปตา่ง ๆ ในโปรแกรมเบลนเดอร ์ 

3.2.1 ชุดเดรสกระโปรงทรงสอบ 

 ชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

                    1. เปิดโปรแกรมเบลนเดอร ์ 

 

 

ภาพที ่3-3 โปรแกรมเบลนเดอร ์ 
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            2. ลบวัตถุทั้งหมด 

   กด X เลอืก Delete และเปลี่ยนมุมมองเป็นระนาบ XY 

 

 

ภาพที ่3-4 การลบวัตถุ 
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                   3. น าแบบชุดที่ท าการออกแบบในกระดาษลงในโปรแกรมเบลนเดอร ์ 

    กด Shift+A เลอืก Image > Background > เลอืกรูป 

 

 

ภาพที่ 3-5 น าแบบชุดที่ออกแบบในกระดาษลงในโปรแกรมเบลนเดอร ์ 
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                      4. เพ่ิมเส้น Path ขึน้มา จากน้ันลบจุด 2 จุด เพ่ือให้ไดเ้สน้โค้งเบซิเยร์ อับดับ 2 

หรือลบจุด 3 จุด เพ่ือให้ได้เส้นโค้งเบซิเยร์อับดับ 1 และในการสร้างเส้นโค้งเบซิเยร์ 

จากเส้น Path จะพบว่าหัวลูกศรจะแสดงทิศทางของเส้นโค้งว่าเกิดจากจุดใดไปยังจุดใด 

    กด Shift+A เลอืก Add > Curve > Path จากน้ันเปลี่ยนจาก Object Mode 

เป็น Edit Mode ลบจุด 2 จุดหรือลบจุด 3 จุด และลากเสน้โค้งเบซิเยร์ตามแบบชุด 

 

 

 

ภาพที ่3-6 ลากเสน้โค้งเบซิเยร์ตามแบบชุด 
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                    5. ลากเสน้โค้งเบซิเยร์ตามแบบชุดโดยท าแค่คร่ึงชุด เน่ืองจากชุดมคีวาม

สมมาตร จากน้ันเปลี่ยนจาก Edit Mode เป็น Object Mode 

 

 

ภาพที่ 3-7 ลากเสน้โค้งเบซิเยร์ตามแบบชุดคร่ึงชุด 
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                    6. ท าการสร้างพ้ืนผิว 

   กด Object > Convert to > Mesh from Curve/Meta/Surf/Text จากน้ันเปลี่ยน

จาก Object Mode เป็น Edit Mode เลอืกหน้าและกด F 

 

 

 

ภาพที่ 3-8 สร้างพ้ืนผิว 
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                    7. ท าการสะท้อนเนื่องจากชุดทัง้สองฝั่งสมมาตรกัน 

  เลอืกหน้า > Material ท าการใส่สี > เลอืกทั้งหมดโดยกด A >  Modifiers > 

Add Modifiers > Mirror 

 

 

 

ภาพที ่3-9 การใส่สีและสะท้อนชุดเดรสกระโปรงทรงสอบดา้นหนา้ 
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                    8. ชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ภาพที่ 3-10 แบบชุดเดรสกระโปรงทรงสอบดา้นหน้าท าการออกแบบจากโปรแกรมเบลนเดอร์  

 ชุดเดรสกระโปรงทรงสอบดา้นหลัง 

ในท านองเดยีวกันกับชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ภาพที่ 3-11 แบบชุดเดรสกระโปรงทรงสอบดา้นหลังท าการออกแบบจากโปรแกรมเบลนเดอร์  
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3.2.2 ชุดเดรสกระโปรงทรงบาน 

 เสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

                    1. เปิดโปรแกรมเบลนเดอร ์ 

 

 

ภาพที ่3-12 โปรแกรมเบลนเดอร ์ 
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                    2. ลบวัตถุทั้งหมด 

   กด X เลอืก Delete และเปลี่ยนมุมมองเป็นระนาบ XY 

 

 

ภาพที ่3-13 การลบวัตถุ 
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                   3. น าแบบชุดที่ออกแบบในกระดาษใส่ในโปรแกรมเบลนเดอร ์ 

    กด Shift+A เลอืก Image > Background > เลอืกรูป 

 

 

ภาพที่ 3-14 น าแบบชุดที่ออกแบบในกระดาษลงในโปรแกรมเบลนเดอร ์ 
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                    4. เพ่ิมเส้น Path ขึน้มา จากน้ันลบจุด 2 จุด เพ่ือให้ไดเ้สน้โค้งเบซิเยร์อับดับ 2 

หรือลบจุด 3 จุด เพ่ือให้ไดเ้สน้โค้งเบซิเยร์อับดับ 1 และในการสร้างเส้นโค้งเบซิเยร์ 

จากเสน้ Path จะพบว่าหัวลูกศรจะแสดงทิศทางของเสน้โค้งว่าเกิดจากจุดใดไปยังจุดใด 

    กด Shift+A เลอืก Add > Curve > Path จากน้ันเปลี่ยนจาก Object Mode 

เป็น Edit Mode ลบจุด 2 จุดหรือลบจุด 3 จุด และลากเสน้โค้งเบซิเยร์ตามแบบชุด 

 

 

 ภาพที ่3-15 ลากเสน้โค้งเบซิเยร์ตามแบบชุด 
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                    5. ลากเสน้โค้งเบซิเยร์ตามแบบชุดโดยท าแค่คร่ึงชุดเนื่องจากชุดมคีวาม

สมมาตร จากน้ันเปลี่ยนจาก Edit Mode เป็น Object Mode 

 

 

ภาพที่  3-16 ลากเสน้โค้งเบซิเยร์ตามแบบชุดครึ่งชุด 
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                   6. ท าการสร้างพ้ืนผิว 

  กด Object > Convert to > Mesh from Curve/Meta/Surf/Text จากน้ันเปลี่ยน

จาก Object Mode เป็น Edit Mode เลอืกหน้าและกด F 

 

 

 

ภาพที่ 3-17 สร้างพ้ืนผิว 
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                    7. ท าการสะท้อนเนื่องจากชุดทัง้สองฝั่งสมมาตรกัน 

  เลอืกหน้า > Material ท าการใส่สี > เลอืกทั้งหมดโดยกด A >  Modifiers > 

Add Modifiers > Mirror 

 

 

 

ภาพที ่3-18 การใส่สีและสะท้อนเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 
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                    8. เสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่3-19 แบบเสื้อดา้นหน้าของชุดเดรสกระโปรงทรงบานท าการออกแบบจากโปรแกรมเบลนเดอร์  

 เสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

ในท านองเดยีวกันกับเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่3-20 แบบเสื้อดา้นหลังของชุดเดรสกระโปรงทรงบานท าการออกแบบจากโปรแกรมเบลนเดอร์  
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 กระโปรงของชุดเดรสกระโปรงทรงบาน 

                    1. เปิดโปรแกรมเบลนเดอร ์ 

 

 

ภาพที ่3-21 โปรแกรมเบลนเดอร์  
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                   2. ลบวัตถุทั้งหมด 

   กด X เลอืก Delete และเปลี่ยนมุมมองเป็นระนาบ XY 

 

 

ภาพที่ 3-22 การลบวัตถุ 

 

 

 

 

 

 

 

 

 



89 
 

                   3. น าแบบกระโปรงที่ออกแบบในกระดาษใส่ในโปรแกรมเบลนเดอร ์ 

   กด Shift+A เลอืก Image > Background > เลอืกรูป 

 

 

ภาพที่ 3-23 น าแบบกระโปรงที่ออกแบบในกระดาษใส่ในโปรแกรมเบลนเดอร์  
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                   4. สร้างวงกลมเพ่ือท าขอบกระโปรง 

   กด Shift+A เลอืก Add > Curve > Circle จากน้ันเปลี่ยนจาก Object Mode 

เป็น Edit Mode กด S เพ่ือปรับขนาด Circle ใหม้ีขนาดตามแบบชุด 

 

 

 

ภาพที ่3-24 ลากเสน้โค้งเบซิเยร์ตามแบบชุด 
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                   5. ท าการสร้างพ้ืนผิว 

  กด Object > Convert to > Mesh from Curve/Meta/Surf/Text จากน้ันเปลี่ยน

จาก Object Mode เป็น Edit Mode  

 

 

ภาพที่ 3-25 สร้างพ้ืนผิว 
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                   6. ท าการเพ่ิมหน้าและปรับขนาดตามแบบชุดโดยกด E และ S 

 

 

ภาพที ่3-26 เพ่ิมหน้าและปรับขนาดตามแบบชุด 

                   7. ท าการใส่สี เลอืกหน้า > Material  

 

ภาพที ่3-27 การใส่สี 
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                  8. กระโปรงของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 3-28 แบบกระโปรงของชุดเดรสกระโปรงทรงบานท าการออกแบบจากโปรแกรมเบลนเดอร์  

3.3 ขั้นตอนการตัดชุดในโปรแกรมเบลนเดอร์  

3.3.1 ชุดเดรสกระโปรงทรงสอบ  

                    1. เปิดโปรแกรมเบลนเดอร ์ 

 

 

ภาพที ่3-29 โปรแกรมเบลนเดอร ์ 
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                    2. น าหุ่นเข้ามาโดย 

     File > Open > เลอืกไปที่หุ่น > Open Blender File 

 

ภาพที่ 3-30 หุ่น 

                    3. น าแบบชุดเดรสกระโปรงทรงสอบดา้นหนา้ที่ออกแบบไว้ ลงในโปรแกรม 

          เบลนเดอร ์(Blender)เพ่ือท าการตัดโดย 

      กด Shift+A เลอืก Add > Image > Background > เลอืกรูปชุดเดรส

กระโปรงทรงสอบดา้นหนา้ จากน้ันกด Load Background Image 

 
ภาพที ่3-31 การน าแบบชุดลงในโปรแกรมเบลนเดอร ์ 
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      จากน้ันซ่อนวัตถุทุกวัตถุ ยกเว้นรูปชุดเดรสกระโปรงทรงสอบดา้นหนา้โดย

การกด H แล้วเพ่ิมระนาบขึน้ โดย  

      กด Shift+A เลอืก Add > Mesh > Plane และจัดวัตถุ (Plane) ให้ตรงกับ

แบบชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

 

 

ภาพที่ 3-32 จัดวัตถุ (Plane) ให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบดา้นหนา้ 
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4. เลอืกวัตถุ (Plane) เปลี่ยน Object Mode เป็น Edit Mode สร้าง Loop Cut 

โดยกด Ctrl+R ในแนวแกน Z จากน้ันเลอืกหน้าหน่ึงหน้าของวัตถุ (Plane) แล้วลบทิง้

โดยกด X > Faces ต่อจากน้ันไปที่ Modifiers > Add Modifier > Mirror เพ่ือท าการ

สะท้อนเนื่องจากรูปภาพมคีวามสมมาตร 

 

 

 

ภาพที่ 3-33 การสะท้อนชุด 
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5. สร้าง Loop Cut โดยการกด Ctrl+R จ านวน 6 เสน้ ในแนวแกน Z 3 เสน้ 

และแนวแกน X 3 เสน้ เพ่ือสร้างจุดตัดของคริบชุด 

 

ภาพที่ 3-34 สร้าง Loop Cut 

     จากน้ันลบหน้าทั้งหมดทิง้โดย เลอืกวัตถุทั้งหมด > X > Only Faces และลบ

จุดที่ไม่เกี่ยวข้องโดยเลอืกจุดที่ไมเ่กี่ยวข้อง > X > Vertices 

 

 

 

ภาพที ่3-35 ลบหน้าและลบจุด 
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6. สร้างหน้าขึ้นใหม่โดยการเลอืกจุด 4 จุดแล้วกด F 

 
ภาพที่ 3-36 สร้างหน้าขึ้นใหม่ 

7. เพ่ิมจุดใหม่ขึน้ 4 จุด 

 
ภาพที่ 3-37 เพ่ิมจุด 

      จากน้ันลบหน้าโดยเลอืกหน้า > X > Only Faces และสร้างหน้าขึ้นมาใหม่

โดยเลอืกจุด 4 จุดและกด F พร้อมทั้งจัดจุดให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบ

ดา้นหนา้ 

 
ภาพที ่3-38 ลบหน้าและสร้างหน้าขึ้นมาใหม่ 

 



99 
 

8. เลอืกจุดบน 4 จุด แล้วเพ่ิมหน้าขึ้น 2 ครัง้โดยการกด E และจัดจุดให้ตรงกับ

แบบชุดเดรสกระโปรงทรงสอบดา้นหน้า 

 

 

 

ภาพที่ 3-39 จัดจุดให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

9. สร้าง Loop Cut โดยการกด Ctrl+R เพ่ิมอีก 2 เสน้ เพ่ือให้แต่ละช่องมีขนาด

ใกลเ้คียงกัน 

 

ภาพที่ 3-40 สร้าง Loop Cut เพ่ิม 
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10. ใช้ Subdivide โดยการคลิกเม้าท์ขวา > Subdivide แล้วสร้าง Loop Cut 

โดยการกด Ctrl+R เพ่ือให้เป็นช่องหลักส าหรับการเย็บ 

 

ภาพที่ 3-41 สร้างช่องหลักส าหรับการเย็บ 

11. เปลี่ยนจาก Edit Mode เป็น Object Mode เลอืกรูปแบบชุดเดรสกระโปรง

ทรงสอบดา้นหนา้ ท าการย้ายไปตามแนวแกน X โดยกด G+X+100 

12. น าแบบชุดเดรสกระโปรงทรงสอบดา้นหลังที่ออกแบบไว ้ลงในโปรแกรม 

เบลนเดอร ์(Blender)เพ่ือท าการตัดโดย 

      กด Shift+A เลอืก Add > Image > Background > เลอืกรูปชุดเดรส

กระโปรงทรงสอบดา้นหลัง จากน้ันกด Load Background Image 

 

ภาพที ่3-42  การตัดชุดเดรสกระโปรงทรงสอบ 
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    จากน้ันท าการเพ่ิมระนาบโดยกด Shift+A เลอืก Add > Mesh > Plane และ

จัดวัตถุ (Plane) ให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ภาพที ่3-43 จัดวัตถุ (Plane) ให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบดา้นหนา้ 
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13. เลอืกวัตถุ (Plane) เปลี่ยน Object Mode เปน็ Edit Mode สร้าง Loop Cut  

          โดยกด Ctrl+R ในแนวแกน Z จากน้ันเลอืกหน้าหน่ึงหน้าของวัตถุ (Plane) แล้วลบทิง้

โดยกด X > Faces ต่อจากน้ันไปที่ Modifiers > Add Modifier > Mirror เพ่ือท าการ

สะท้อนเนื่องจารูปภาพมีความสมมาตร 

 
 

 

ภาพที่ 3-44 การสะท้อนชุดเดรสกระโปรงทรงสอบดา้นหนา้ 
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14. สร้าง Loop Cut โดยการกด Ctrl+R จ านวน 6 เสน้ ในแนวแกน Z 3 เสน้  

           และแนวแกน X 3 เสน้ เพ่ือสร้างจุดตัดของขริบชุด 

 

ภาพที ่3-45 สร้างจุดตัดของขริบชุด 

    จากน้ันลบหน้าทั้งหมดทิง้โดย เลอืกวัตถุทั้งหมด > X > Only Faces และลบ

จุดที่ไม่เกี่ยวข้องโดยเลอืกจุดที่ไมเ่กี่ยวข้อง > X > Vertices 

15. สร้างหน้าขึ้นใหม่โดยการเลอืกจุด 4 จุดแล้วกด F 

 

ภาพที ่3-46 การสร้างหน้าขึ้นใหม่ 
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16. เลอืกจุดบน 3 จุด แลว้เพ่ิมหน้าขึ้น 2 ครัง้โดยการกด E และจัดจุดให้ตรง 

          กับแบบชุดเดรสกระโปรงทรงสอบดา้นหลัง 

 

ภาพที ่3-47 จัดจุดให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบดา้นหลัง 

  17. เพ่ิมจุดใหม่ขึน้ 3 จุด 

 

ภาพที่ 3-48 การเพ่ิมจุด 

     จากน้ันลบหน้าโดยเลอืกหน้า > X > Only Faces และสร้างหน้าขึ้นมาใหม่

โดยเลอืกจุด 4 จุดและกด F พร้อมทั้งจัดจุดให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบ

ดา้นหลัง 
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  18. เลอืกจุดบน 3 จุด แลว้เพ่ิมหน้าขึ้น 2 ครัง้โดยการกด E และจัดจุดให้ตรง

กับแบบชุดเดรสกระโปรงทรงสอบดา้นหลัง 

 

ภาพที ่3-49 จัดจุดให้ตรงกับแบบชุดเดรสกระโปรงทรงสอบดา้นหลัง 

19. สร้าง Loop Cut โดยการกด Ctrl+R เพ่ิมอีก 2 เสน้ เพ่ือให้แต่ละช่องมีขนาด 

          ใกลเ้คียงกัน 

 

ภาพที่ 3-50 สร้าง Loop Cut 
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  20. ใช้ Subdivide โดยการคลิกเม้าท์ขวา > Subdivide แล้วสร้าง Loop Cut 

โดยการกด Ctrl+R เพ่ือให้เป็นช่องหลักส าหรับการเย็บ 

 

ภาพที ่3-51 สร้างช่องหลักส าหรับการเย็บ 

21. เปลี่ยนจาก Edit Mode เป็น Object Mode เลอืกรูปแบบชุดเดรสกระโปรง 

          ทรงสอบดา้นหนา้ ท าการย้ายไปตามแนวแกน X โดยกด G+X+(-100) เพ่ือยา้ยรูปแบบ

ชุดเดรสกระโปรงทรงสอบดา้นหนา้กลับมาที่เดิม 

 

ภาพที ่3-52 ย้ายรูปแบบชุดเดรสกระโปรงทรงสอบดา้นหนา้กลับมาที่เดมิ 
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22. เลอืกวัตถุทั้ง 2 วัตถุ นั่นคือชุดเดรสกระโปรงทรงสอบดา้นหนา้และชุด 

          เดรสกระโปรงทรงสอบดา้นหลัง จากน้ันท าการรวมให้เป็นวัตถุช้ินเดยีวกันโดยกด 

Ctrl+J 

23. เลอืกวัตถุ (ชุดเดรสกระโปรงทรงสอบ) เปลี่ยน Object Mode เป็น Edit  

          Mode เลอืกจุดทั้งหมดของวัตถุ > คลกิเม้าท์ขวา > Remove Double Vertices เพ่ือท า

การรวมจุดที่อยู่ใกล้กันให้เป็นจุดเดยีวกันและท าการเย็บชุดโดยการเลอืกจุด 2 จุด 

แล้วกด F เพ่ือท าการเชื่อมเป็นเสน้ดา้ย 

 

ภาพที่ 3-53 การเช่ือมเป็นเสน้ดา้ย 
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24. เปลี่ยน Edit Mode เป็น Object Mode น าหุ่นออกมาโดยการกด Alt+H  

         เลือกที่หุ่นแล้วกด Physics > Collision จากน้ันเลือกชุดเดรสกระโปรงทรงสอบ แล้วกด                  

Physics > Cloth >  New Preset  

>  Mass  

>  Shape จากน้ันท าเครื่องหมายถูกที่ Sewing และ Max Swing Force  

>  Field weights Grarity  

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 3-54 การต้ังค่าชุด 

 

 

 

 

 

 

Cotton 

3 Kg 
10 
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New Preset 
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  25. กด  เพ่ือท าการเลน่ เมื่อได้ชุดที่ต้องการแลว้

กด  เพ่ือท าการหยุดเลน่ 

 

ภาพที ่3-55 การปรับแตง่ชุด 

          จากน้ันกด Modifiers > Apply ของ Mirror และ Cloth 

 

ภาพที่ 3-56 การ Apply 
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  26. เลอืกชุดแล้วกด Physics > Cloth > Mass เพ่ือท าให้ชุดมคีวามสวยงามขึน้ 

 

 

 

ภาพที่ 3-57 การปรับชุดมคีวามสวยงามขึน้ 

 

 



111 
 

  27. เลอืกวัตถุชุดเดรสกระโปรงทรงสอบเปลี่ยน Object Mode เป็น Edit Mode 

ท าการเพ่ิมหน้าของวัตถุที่ขาดหายไปโดยการเลอืกจุด Alt+กดจุด > F 

 

ภาพที ่3-58 การเพ่ิมหน้าของวัตถุที่ขาดหายไป 

  28. ท าการจัดจุดเพ่ือท าให้จุดเกิดความสวยงาม 

ภาพที่ 3-59 การจัดจุดเพ่ือท าให้จุดเกิดความสวยงาม 
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3.3.2 ชุดเดรสกระโปรงทรงบาน 

                    1. เปิดโปรแกรมเบลนเดอร ์ 

 

 

ภาพที ่3-60 โปรแกรมเบลนเดอร ์ 

                    2. น าหุ่นเข้ามาโดย 

     File > Open > เลอืกไปที่หุ่น > Open Blender File 

 

ภาพที่ 3-61 หุ่น 
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                    3. น าแบบเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบานที่ออกแบบไว้ ลงใน

โปรแกรมเบลนเดอร์เพ่ือท าการตัดโดย 

     กด Shift+A เลอืก Add > Image > Background > เลอืกเสื้อด้านหน้าของชุด

เดรสกระโปรงทรงบาน จากน้ันกด Load Background Image 

 

ภาพที่ 3-62 การน าแบบชุดลงในโปรแกรมเบลนเดอร ์ 

จากน้ันซ่อนวัตถุทุกวัตถุ ยกเว้นรูปเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

           โดยการกด H แล้วเพ่ิมระนาบขึน้ โดย  

  กด Shift+A เลอืก Add > Mesh > Plane และจัดวัตถุ (Plane) ให้ตรงกับแบบ

เสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่3-63 จัดวัตถุ (Plane) ให้ตรงกับแบบเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 
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4. เลอืกวัตถุ (Plane) เปลี่ยน Object Mode เป็น Edit Mode สร้าง Loop Cut 

โดยกด Ctrl+R ในแนวแกน Z จากน้ันเลอืกหน้าหน่ึงหน้าของวัตถุ (Plane) แล้วลบทิง้

โดยกด  X > Faces ต่อจากน้ันไปที่ Modifiers > Add Modifier > Mirror เพ่ือท าการ

สะท้อนเนื่องจากรูปภาพมคีวามสมมาตร 

 

 

 

ภาพที ่3-64 การสะท้อนเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 
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5. สร้าง Loop Cut โดยการกด Ctrl+R จ านวน 4 เสน้ ในแนวแกน Z 3 เสน้ 

และแนวแกน X 1 เสน้ เพ่ือสร้างจุดตัดของครบิชุด 

 

ภาพที่ 3-65 สร้าง Loop Cut 

     จากน้ันลบหน้าทั้งหมดทิง้โดย เลอืกวัตถุทั้งหมด > X > Only Faces และลบ

จุดที่ไม่เกี่ยวข้องโดยเลอืกจุดที่ไมเ่กี่ยวข้อง > X > Vertices 

 

 

 

ภาพที ่3-66 การลบหน้าและลบจุด 
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6. สร้างหน้าขึ้นใหม่โดยการเลอืกจุด 4 จุดแล้วกด F 

 
ภาพที่ 3-67 สร้างหน้าขึ้นใหม่ 

7. สร้าง Loop Cut โดยการกด Ctrl+Rจ านวน 1 เสน้และเพ่ิมจุดใหม่ขึน้ 1 จุด 

 
ภาพที่ 3-68 การเพ่ิมจุด 

      จากน้ันลบหน้าโดยเลอืกหน้า > X > Only Faces และสร้างหน้าขึ้นมาใหม่

โดยเลอืกจุด 4 จุดและกด F พร้อมทั้งจัดจุดให้ตรงกับแบบเสื้อด้านหน้าของชุดเดรส

กระโปรงทรงบาน 

 
ภาพที ่3-69 ลบหน้าและสร้างหน้าขึ้นมาใหม่ 
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8. เลอืกจุดบน 3 จุด แล้วเพ่ิมหน้าขึ้น โดยการกด E และสร้าง Loop Cut โดย

การกด Ctrl+R ในแนวแกน X แล้วท าการจัดจุดให้ตรงกับแบบเสื้อด้านหน้าของชุดเดรส

กระโปรงทรงบาน 

 

ภาพที ่3-70 จัดจุดให้ตรงกับแบบเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

9. ใช้ Subdivide โดยการคลิกเม้าท์ขวา > Subdivide แล้วสร้าง Loop Cut โดย

การกด Ctrl+R เพ่ือให้เป็นช่องหลักส าหรับการเย็บ 

 

ภาพที่ 3-71 สร้างช่องหลักส าหรับการเย็บ 

10. เปลี่ยนจาก Edit Mode เป็น Object Mode เลอืกรูปแบบเสื้อด้านหน้าของ

ชุดเดรสกระโปรงทรงบาน ท าการย้ายไปตามแนวแกน X โดยกด G+X+100 
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11. น าแบบเสื้อด้านหลังของชุดเดรสกระโปรงทรงบานที่ออกแบบไว้ ลงใน

โปรแกรมเบลนเดอร์เพ่ือท าการตัดโดย 

      กด Shift+A เลอืก Add > Image > Background > เลอืกรูปเสื้อด้านหลัง

ของชุดเดรสกระโปรงทรงบานจากน้ันกด Load Background Image 

 

ภาพที่ 3-72 การตัดเสื้อของชุดเดรสกระโปรงทรงบาน 

      จากน้ันท าการเพ่ิมระนาบโดยกด Shift+A เลอืก Add > Mesh > Plane และ

จัดวัตถุ (Plane) ให้ตรงกับแบบเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่3-73 จัดวัตถุ (Plane) ให้ตรงกับแบบเสือ้ดา้นหลังของชุดเดรสกระโปรงทรงบาน 
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12. เลอืกวัตถุ (Plane) เปลี่ยน Object Mode เป็น Edit Mode สร้าง Loop Cut  

          โดยกด Ctrl+R ในแนวแกน Z จากน้ันเลอืกหน้าหน่ึงหน้าของวัตถุ (Plane) แล้วลบทิง้

โดยกด X > Faces ต่อจากน้ันไปที่ Modifiers > Add Modifier > Mirror เพ่ือท าการ

สะท้อนเนื่องจารูปภาพมีความสมมาตร 

 

 

 

ภาพที ่3-74 การสะท้อนเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 
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13. สร้าง Loop Cut โดยการกด Ctrl+R จ านวน 4 เสน้ ในแนวแกน Z 3 เสน้  

          และแนวแกน X 1 เสน้ เพ่ือสร้างจุดตัดของขริบชุด 

 

ภาพที ่3-75 การสร้างจุดตัดของขริบชุด 

      จากน้ันลบหน้าทั้งหมดทิง้โดย เลอืกวัตถุทั้งหมด > X > Only Faces และลบ

จุดที่ไม่เกี่ยวข้องโดยเลอืกจุดที่ไมเ่กี่ยวข้อง > X > Vertices 

 

 

 

ภาพที ่3-76 การลบหน้าและลบจุด 
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14. สร้างหน้าขึ้นใหม่โดยการเลอืกจุด 4 จุดแล้วกด F 

 

ภาพที่ 3-77 การสร้างหน้าขึ้นใหม่ 

15. เลอืกจุดบน 3 จุด แลว้เพ่ิมหน้าขึ้น 2 ครัง้โดยการกด E 2 ครัง้และจัดจุด 

          ให้ตรงกับแบบเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

 
 

 

 

ภาพที ่3-78 การจัดจุดให้ตรงกับแบบเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 
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16. สร้าง Loop Cut โดยการกด Ctrl+R ในแนวแกน X และจัดจุด 

          ให้ตรงกับแบบเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่3-79 จัดจุดให้ตรงกับแบบเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

17. ใช้ Subdivide โดยการคลิกเม้าท์ขวา > Subdivide แล้วสร้าง Loop Cut โดย 

          การกด Ctrl+R เพ่ือให้เป็นช่องหลักส าหรับการเย็บ 

 

ภาพที ่3-80 การสร้างช่องหลักส าหรับการเย็บ 
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18. เปลี่ยนจาก Edit Mode เป็น Object Mode เลอืกรูปแบบเสื้อด้านหน้าของ 

          ชุดเดรสกระโปรงทรงบาน ท าการย้ายไปตามแนวแกน X โดยกด G+X+(-100) เพ่ือยา้ย

รูปแบบเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบานกลับมาที่เดมิ 

 

ภาพที ่3-81 การย้ายรูปแบบเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบานกลับมาที่เดมิ 

19. เลอืกวัตถุทั้ง 2 วัตถุ นั่นคือเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

          และเสื้อด้านหลังของชุดเดรสกระโปรงทรงบานจากน้ันท าการรวมให้เป็นวัตถุช้ิน

เดยีวกันโดยกด Ctrl+J 

 

ภาพที ่3-82 การรวมวัตถุทั้ง 2 วัตถุ 
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20. เลอืกวัตถุ (เสื้อของชุดเดรสกระโปรงทรงบาน) เปลี่ยน Object Mode เป็น  

          Edit Mode เลอืกจุดทั้งหมดของวัตถุ > คลิกเม้าท์ขวา > Remove Double Vertices เพ่ือ

ท าการรวมจุดที่อยู่ใกล้กันให้เป็นจุดเดยีวกันและท าการเย็บชุดโดยการเลอืกจุด 2 จุด 

แล้วกด F เพ่ือท าการเชื่อมเป็นเสน้ดา้ย 

 

ภาพที ่3-83 การเช่ือมเป็นเสน้ดา้ย 

21. เปลี่ยน Edit Mode เป็น Object Mode น าหุ่นออกมาโดยการกด Alt+H  

           เลอืกที่หุ่นแล้วกด Physics > Collision  

 

ภาพที ่3-84 การต้ังค่าแบบชุด 
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จากน้ันเลอืกชุดเดรสกระโปรงทรงบาน แล้วกด                   

Physics > Cloth >  New Preset  

>  Mass  

>  Shape จากน้ันท าเครื่องหมายถูกที่ Sewing และ Max Swing Force  

>  Field weights Grarity  

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 3-85 การต้ังค่าชุด 
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10 
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  22. กด  เพ่ือท าการเลน่ เมื่อได้ชุดที่ต้องการแลว้

กด  เพ่ือท าการหยุดเลน่ 

 

ภาพที่ 3-86 การปรับแตง่เสื้อ 

       จากน้ันกด Modifiers > Apply ของ Mirror และ Cloth 

 

ภาพที่ 3-87 การ Apply 
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  23. เลอืกเสื้อของชุดเดรสกระโปรงทรงบานแล้วกด Physics > Cloth > Mass 

เพ่ือท าให้ชุดมคีวามสวยงามขึน้ 

 

 

 

ภาพที ่3-88 การชุดมคีวามสวยงามขึน้ 
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  24. เลอืกวัตถุเสื้อของชุดเดรสกระโปรงทรงบานเปลี่ยน Object Mode เป็น Edit 

Mode ท าการเพ่ิมหน้าของวัตถุที่ขาดหายไปโดยการเลอืกจุด Alt+กดจุด > F 

 

ภาพที ่3-89 การเพ่ิมหน้าของวัตถุที่ขาดหายไป 

  25. ท าการจัดจุดเพ่ือท าให้จุดเกิดความสวยงาม 

  26. เลอืกหน้าของวัตถุโดยเว้นแถวสุดท้ายไว้ จากน้ันกด Object Pata > 

Vertex Group >         >                > Assign      

 

 

 

 

+ Group (ช่ือที่ต้ังขึ้น) 
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ภาพที ่3-90 การต้ังค่ากอ่นการเช่ือมกระโปรง 
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  27. ท ากระโปรง โดยเลอืกขอบลา่สุดของตัวเสื้อ จากน้ันกด E+S 

 

ภาพที ่3-91 การเช่ือมกระโปรง 

         ต่อจากน้ันเลอืกขอบกระโปรง กด  G+Z เพ่ือท าการดงึกระโปรงลง 

 

ภาพที่ 3-92 การดงึกระโปรงลง 

28. สร้าง Loop Cut โดยการกด Ctrl+R จ านวน 11 เสน้ 

 

ภาพที่ 3-93 สร้าง Loop Cut กระโปรง 
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29. เปลี่ยน Edit Mode เป็น Object Mode เลอืกวัตถุชุดเดรสกระโปรงทรงบาน

กด Physics > Cloth > Shape > PinGroup               

 

ภาพที่ 3-94 การต้ังค่ากระโปรง 

  30. กด  เพ่ือท าการเลน่ เมื่อได้ชุดที่ต้องการแลว้

กด  เพ่ือท าการหยุดเลน่ 

 

ภาพที่ 3-95 การปรับแตง่ชุด 

       จากน้ันกด Modifiers > Apply ของ Mirror และ Cloth 

 

Group (ช่ือที่ต้ังขึ้น) 
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  31. ท าการจัดจุดเพ่ือท าให้จุดเกิดความสวยงาม 

 

 

 

ภาพที่ 3-96 การจัดจุดเพ่ือท าให้จุดเกิดความสวยงาม 
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3.4 ขั้นตอนการลงลายบนชุดที่ตัดเย็บในโปรแกรมเบลนเดอร์ (Blender) 

      3.4.1 ชุดเดรสกระโปรงทรงสอบ 

 

 

 

ภาพที่ 3-97 ลายของชุดเดรสกระโปรงทรงสอบ 
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  1. เลอืกวัตถุชุดเดรสกระโปรงทรงสอบแล้วเปลี่ยน Object Mode เป็น                     

Edit Mode 

 

 

 

ภาพที่ 3-98 Edit Mode ของชุดเดรสกระโปรงทรงสอบ 
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2. เลอืกเส้นของของชุดเพ่ือท าการ Mark seam แบ่งส่วน โดยเลอืกเส้นที่

ต้องการ > คลิกเม้าท์ขวา > Mark seam 

          หมายเหตุ เมือ่ Mark seam แล้วเสน้จะเปลี่ยนเป็นสีแดง   

                    

 

 

ภาพที่ 3-99 การ Mark seam 
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3. ท าการ Mark seam 7 เสน้ ดังนี ้รอบคอ, รอบวงแขน 2 ข้าง, รอบกระโปรง 

2 เสน้ และแถบข้างทั้ง 2 ดา้น 

   

 

ภาพที่ 3-100 บรเิวณ Mark seam 
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4. ลงสขีองชุดโดยเลอืกหน้าทั้งหมดของชุด > Material >         > New > 

Base Color                 > Assign 

 

 

ภาพที่ 3-101 การลงสขีองชุด 

 

 

+ 

เลือกสี 
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5. เลอืกหน้าของวัตถุจากน้ันเพ่ิม Materaial แลว้กด Assign  

 

 

ภาพที่ 3-102 การเลอืกหน้า 
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6. เลอืก UV Editing เพ่ือกาง UV 

  

ภาพที่ 3-103 การกาง UV 

ไปที่หน้าต่างด้านขวาแลว้กด U > Unwrap 

 

ภาพที่ 3-104 Unwrap 
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7. เลอืกชุดเดรสกระโปรงทรงสอบดา้นหนา้และเคลื่อนย้ายไปทับกับชุดเดรส

กระโปรงทรงสอบดา้นหลัง โดยท างานในหน้าต่างทางซ้าย 

 

 

 

ภาพที่ 3-105 เคลื่อนย้ายชุดเดรสกระโปรงทรงสอบดา้นหนา้ทับดา้นหลัง 
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เลอืกวัตถุทั้งหมดแล้วท าการหมุนโดยกด R+Z+90 และท าการขยายวัตถ ุ

 

 

ภาพที่ 3-106 การหมุน 

8. เลอืก  > เลอืกลายผ้า > Open Image 

 

ภาพที่ 3-107 เลอืกลายผ้า 
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9. เลอืก Shading 

 

ภาพที่ 3-108 Shading 

จากน้ันกด Shift+A > Texture > Image Texture เพ่ือน ารูปลายผ้าที่ท าการ

กาง UV ลง แล้วเลอืก Open > เลอืกลายผ้าใหเ้ป็นลายเดยีวกันกับขั้นตอนที่ 8 > Open 

Image และเช่ือมเสน้จาก Color ไปยัง Base Color 

 

ภาพที่ 3-109 การปรับลายผ้า 
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10. จัดชุดให้ตรงตามลายที่ต้องการ โดยอยู่ในหน้าต่างของการกาง UV  

 

ภาพที่ 3-110 จัดชุดให้ตรงตามลายที่ต้องการ 

11. เลอืกหน้าของวัตถุด้านหน้าในสว่นของท้ายชุดเดรส 

 

ภาพที่ 3-111 เลอืกหน้าของวัตถุด้านหน้า 
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จากน้ันเพ่ิม Material แล้วกด Assign  

  

ภาพที่ 3-112 การเพ่ิม Material 

12. เลอืก UV Editing เพ่ือกาง UV จากน้ันกด U > Unwrap โดยท างานใน

หน้าต่างด้านขวา 

 

ภาพที่ 3-113 กาง UV สว่นท้ายของชุดเดรส 
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13. เลอืกวัตถุทั้งหมดและท าการหมุนโดยกด Q+Z+90  

 

ภาพที่ 3-114 เลอืกวัตถุทั้งหมดและท าการหมนุ 

                        จากน้ันท าการจัดจุดของวัตถุให้เป็นเสน้ตรง โดยการเลอืกวัตถุ > O > G 

 

ภาพที่ 3-115 การจัดจุดของวัตถุให้เป็นเสน้ตรง 

14. เลอืก  > เลอืกลายผ้า > Open Image 

 

ภาพที่ 3-116 ใส่ลายผ้าสว่นท้ายของชุดเดรสด้านหนา้ 
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จากน้ันท าการจัดจุดให้ตรงกับลายผ้า 

 

ภาพที่ 3-117 จัดจุดให้ตรงกับลายผ้าสว่นท้ายของชุดเดรสด้านหน้า 

15. เลอืก Shading 

 

ภาพที่ 3-118 Shading ลายผ้าสว่นท้ายของชุดเดรสด้านหน้า 
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จากน้ันกด Shift+A > Texture > Image Texture เพ่ือน ารูปลายผ้าที่ท าการ

กาง UV ลง แล้วเลอืก Open > เลอืกลายผ้าใหเ้ป็นลายเดยีวกันกับขั้นตอนที่ 24 > 

Open Image และเช่ือมเสน้จาก Color ไปยัง Base Color 

 

ภาพที่ 3-119 การปรับลายผ้าสว่นท้ายของชุดเดรสด้านหน้า 

16. ในท านองเดยีวกันกับสว่นท้ายของชุดเดรสดา้นหลัง จะท าเหมือนกับ

สว่นท้ายของชุดเดรสดา้นหนา้ 

 

 

 

 

 

 

 

 



148 
 

 

 

 

ภาพที่ 3-120 ลายผ้าสว่นท้ายของชุดเดรสดา้นหน้า 

17. เลอืก Layout > เลอืกชุดเดรสกระโปรงทรงสอบ > Modifiers > Add 

Modifier > Subdivision > Apply 

 



149 
 

 

 

 

ภาพที่ 3-121 ลายชุดเดรสกระโปรงทรงสอบ 
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      3.4.2 ชุดเดรสกระโปรงทรงบาน 

 

 

 

ภาพที่ 3-122 ลายชุดเดรสกระโปรงทรงบาน 
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  1. เลอืกวัตถุชุดเดรสกระโปรงทรงบานแล้วเปลี่ยน Object Mode เป็น                     

Edit Mode 

 

 

 

ภาพที่ 3-123 Edit Mode ของชุดเดรสกระโปรงทรงบาน 
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2. เลอืกเส้นของของชุดเพ่ือท าการ Mark seam แบ่งส่วน โดยเลอืกเส้นที่

ต้องการ > คลิกเม้าท์ขวา > Mark seam  

          หมายเหตุ เมือ่ Mark seam แล้วเสน้จะเปลี่ยนเป็นสีแดง   

 

 

 

ภาพที่ 3-124 Mark seam ชุดเดรสกระโปรงทรงบาน 
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3. ท าการ Mark seam 7 เสน้ ดังนี ้รอบคอ, รอบวงแขน 2 ข้าง, รอบกระโปรง 

2 เสน้ และแถบข้างทั้ง 2 ดา้น 

 

ภาพที่ 3-125 บรเิวณที่ Mark seam ชุดเดรสกระโปรงทรงบาน 
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4. ลงสขีองชุดโดยเลอืกหน้าทั้งหมดของชุด > Material >         > New > 

Base Color                 > Assign 

 

 

ภาพที่ 3-126 การลงสขีองชุดชุดเดรสกระโปรงทรงสอบ 

 

 

+ 

เลือกสี 
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5. เลอืกหน้าของวัตถุจากน้ันเพ่ิม Materaial แลว้กด Assign  

 

 

ภาพที่ 3-127 การเลอืกหน้า 
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6. เลอืก UV Editing เพ่ือกาง UV 

 

ภาพที่ 3-128 การกาง UV 

ไปที่หน้าต่างด้านขวาแลว้กด U > Unwrap 

 

ภาพที่ 3-129 Unwrap 
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7. เลอืกชุดเดรสกระโปรงทรงบานดา้นหนา้และเคลื่อนย้ายไปทับกับชุดเดรส

กระโปรงทรงบานดา้นหลัง โดยท างานในหน้าต่างทางซ้าย 

 

 

 

ภาพที่ 3-130 เคลื่อนย้ายชุดเดรสกระโปรงทรงบานดา้นหนา้ทับดา้นหลัง 
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เลอืกวัตถุทั้งหมดแล้วท าการหมุนโดยกด R+Z+90 และท าการขยายวัตถ ุ

 

ภาพที่ 3-131 การหมุน 

8. เลอืก  > เลอืกลายผ้า > Open Image 

 

ภาพที่ 3-132 เลอืกลายผ้า 

9. เลอืก Shading 

 

ภาพที่ 3-133 Shading 
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จากน้ันกด Shift+A > Texture > Image Texture เพ่ือน ารูปลายผ้าที่ท าการ

กาง UV ลง แล้วเลอืก Open > เลอืกลายผ้าใหเ้ป็นลายเดยีวกันกับขั้นตอนที่ 8 > Open 

Image และเช่ือมเสน้จาก Color ไปยัง Base Color 

 

ภาพที่ 3-134 การปรับลายผ้า 

10. จัดชุดให้ตรงตามลายที่ต้องการ โดยอยู่ในหน้าต่างของการกาง UV  

 

ภาพที่ 3-135 จัดชุดให้ตรงตามลายที่ต้องการ 
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11. เลอืกหน้าของวัตถุด้านหน้าในสว่นของท้ายชุดเดรส 

 

ภาพที่ 3-136 เลอืกหน้าของวัตถุด้านหน้า 

จากน้ันเพ่ิม Material แล้วกด Assign  

 

ภาพที่ 3-137 การเพ่ิม Material 
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12. เลอืก Layout > เลอืกชุดเดรสกระโปรงทรงบาน > Modifiers > Add 

Modifier > Subdivision > Apply 

 

 

ภาพที่ 3-138 ลายชุดเดรสกระโปรงทรงบาน 
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3.5 ขั้นตอนการเก็บจุดเพื่อการใช้งานอ่ืน ๆ 

ในการออกแบบชุด ผู้ว ิจัยได้สนใจและได้เก็บข้อมูลของจุดที ่เกิดขึ้นบนเส้นโค้ง                  

เบซิเยร์และท าการน าข้อมูลจากโปรแกรมเบรนเดอร์ มาเก็บไว้ที่โปรแกรมเอ็กซ์เซล ซึ่งม ี

ขั้นตอนวิธีการเก็บข้อมูลดังน้ีดังต่อไปนี้    

3.5.1  เปิดโปรแกรม Blender > File > open > เปิดไฟลก์ารเดนิที่มีกราฟขึ้นมา 

 
ภาพที ่3-139 โปรแกรมเบรนเดอร์ 

3.5.2 เปิดไฟลท์ี่ต้องการเก็บจุด > เลอืกจุดควบคุมที่เราจะศึกษาเพ่ือเก็บจุด 

 

 

ภาพที ่3-140 การเก็บจุดในโปรแกรมเบรนเดอร์ 
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3.5.3 เปิดโปรแกรมเอ็กซ์เซล 
 

 

 

 

 

 

 

ภาพที่ 3-141 หน้าต่างโปรแกรมเอ็กซ์เซล 

3.5.4 การเก็บจุดจากโปรแกรมเบรนเดอร์ คือการคลิกที่จุด แลว้ดูขอ้มูลแถบ

ดา้นขวา Transform  

 

ภาพที ่3-142 การบันทึกจุดจากโปรแกรมเบรนเดอร์ ไปยัง โปรแกรมเอ็กซ์เซล 

3.5.6 คัดลอกจุดควบคุมจากโปรแกรมเบรนเดอร์ ไปยัง โปรแกรมเอ็กซ์เซล 

 

ภาพที ่3-143 โปรแกรมเอ็กซ์เซล ( บันทึกข้อมูล ) 



 
 

บทท่ี 4 

 

ผลการวิจัย 

 

ในบทน้ีจะกลา่วถึงผลของการด าเนินงานการศึกษาอิสระ (IS) จากวิธีการด าเนินงานที่

กล่าวไว้ในบทที่ 3 คณะผู้จัดท า ได้ท าการออกแบบชุดโดยใช้เส้นโค้งเบซิเยร์ อันดับ 1 และ

อันดบั 2 จากโปรแกรมเบลนเดอร์ จากน้ันทางคณะผู้จัดท าจึงอาศัยความรู้และประสบการณ์ที่

ได้เรยีนรู้ในรายวิชา Special Topics  โดยการน าค่าจุดควบคุมของแตล่ะเสน้โค้งเบซิเยร์ อันดับ 1 

และอันดับ 2 มาวิเคราะห์หาค่าพ้ืนที่โดยใช้ทฤษฎีของกรนีและเสน้โค้งปิดลอ้มวัตถุของแบบชุด 

4.1 ผลการเช่ือมเสน้โค้งเบซิเยร์ ให้ราบเรียบโดยการใช้นิยามของการเช่ือมกันของเสน้

โค้งเบซิเยร์ แบบ 
0 0

C และ G    

 

ภาพที่ 4-1 การเช่ือมเสน้โค้งเบซิเยร์ 

จากภาพที่ 4-1 เป็นการเช่ือมเส้นโค้งเบซิเยร์ หรือการคอมโพสติเส้นโค้งเบซิเยร์ แบบ 

0 0
C G, โดยใช้จุดปลายของเสน้โค้งเบซิเยร์ เสน้หน่ึงต่อกับจุดเร่ิมต้นของเสน้โค้งเบซิเยร์ อีกเส้น

หน่ึง ตามแบบชุดที่ได้ท าการออกแบบไว้ 

 



165 
 

4.2 ผลการวิเคราะห์หาเสน้โค้งปิดลอ้มวัตถุ 

4.2.1 พิจารณาจากจุดปลายแหลม, จุดมุม, จุดเปลี่ยนเว้า, จุดเปลี่ยน และเสน้โค้ง 

ออฟเซ็ต 

   

 

ภาพที่ 4-2 พิจารณามุมระหว่างเวกเตอร์สัมผสัหนึ่งหน่วย 

จากภาพที่ 4-2 จะได้ว่าแบบชุดที่ได้ท าการออกแบบไว้เป็นจุดเปลี่ยนดัง 

หมายเลย 1 และเป็นจุดมุมดังหมายเลย 2 ทั้งหมดโดยการพิจารณาจากมุมระหว่าง 

เวกเตอร์สัมผัสหน่ึงหน่วยของแบบชุด   

 

 

 

 

 

 
1 

2 
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  ดังน้ันจากการวิเคราะห์จงึได้เสน้โค้งปิดลอ้มวัตถุ ทั้งหมด 3 แบบดังน้ี 

 เสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน  

โดยเสน้โค้งปิดลอ้มวัตถุพิจารณาจากจุดมุม และจุดเปลี่ยน จะมี 

ลักษณะเป็นเสน้โค้งเบซิเยร์อันดับที่ 1 สร้างจากการลากเสน้ตรงเช่ือมระหว่างจุด 

  

ภาพที ่4-3 เสน้โค้งปิดลอ้มวัตถุโดยพิจารณาจากจุดมุม และจุดเปลี่ยน 

 เสน้โค้งปิดลอ้มวัตถุ พิจารณาจาก เสน้โค้งออฟเซ็ต แบบรูปหลายเหลี่ยม 

โดยเสน้โค้งปิดลอ้มวัตถุพิจารณาจากเสน้โค้งออฟเซ็ต แบบรูป                       

หลายเหลี่ยม จะมีลักษณะเป็นเสน้โค้งเบซิเยร์อันดับที่ 1 สร้างจากการลากเสน้ตรงเช่ือม 

ระหว่างจุดแรกและจุดสุดท้ายของเสน้โค้งออฟเซ็ต 

  

ภาพที ่4-4 เสน้โค้งปิดลอ้มวัตถุโดยพิจารณาจากเสน้โค้งออฟเซ็ต แบบรูปหลายเหลี่ยม 
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 เสน้โค้งปิดลอ้มวัตถุ พิจารณาจากเส้นโค้งออฟเซ็ตแบบรูปหลาย

เหลี่ยมและเสน้โค้ง 

โดยเสน้โค้งปิดลอ้มวัตถุพิจารณาจากเสน้โค้งออฟเซ็ต แบบรูป                 

หลายเหลี่ยมและเสน้โค้ง จะมีลักษณะเป็นเสน้โค้งเบซิเยร์อันดับที่ 1 และเสน้โค้งเบซเิยร์ 

อันดับที่ 2  สร้างจากการลากเสน้ตรงเช่ือมระหว่างจุดที่ไม่ต่อเน่ืองกัน 

  

ภาพที ่4-5 เสน้โค้งปิดลอ้มวัตถุโดยพิจารณาจากเสน้โค้งออฟเซ็ต                                                 

แบบรูปหลายเหลี่ยมและเสน้โค้ง 

 

4.3 ผลการเก็บข้อมูลจุดควบคุมของแบบชุด 

               เน่ืองจากแบบชุดมสีัดสว่นที่สมมาตร ดังน้ันในการเก็บข้อมูลจุดควบคุมของแบบชุด 

จึงเก็บข้อมูลเพียงครึ่งชุด โดยตารางที่เป็นสเีขียว      จะเป็นเสน้โค้งเบซิเยร์อันดับที่ 1  

และตารางที่เป็นสเีหลอืง      จะเป็นเสน้โค้งเบซิเยร์อันดับที่ 2 ดังนี ้
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4.3.1 ชุดเดรสกระโปรงทรงสอบ 

 ชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ภาพที่ 4-6 จุดควบคุมของชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ตารางที่ 4-1 แสดงจุดควบคุมของชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

เส้นโค้งเส้นที ่ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

1 0.0000 7.6022 25.8715 7.5900 - - 

2 25.8715 7.5900 25.7114 56.1846 - - 

3 25.7114 56.1846 25.1275 63.9686 24.2737 72.5073 

4 24.2737 72.5073 25.7099 85.6863 26.4383 98.0302 

5 26.4383 98.0302 20.1000 99.6562 - - 

6 20.1000 99.6562 12.8743 104.3590 20.7174 118.9070 

7 20.7174 118.9070 18.9379 120.1240 - - 

8 18.9379 120.1240 9.6688 94.9473 - - 

9 9.6688 94.9473 12.2462 121.9020 - - 

10 12.2462 121.9020 10.9807 122.311 - - 

11 10.9807 122.3110 9.7780 110.7250 8.0207 103.9070 

12 8.0207 103.9070 6.4753 101.2790 - - 

13 6.4753 101.2790 2.5545 99.6564 - - 

14 2.5545 99.6564 0.9584 98.3103 0.0000 96.0998 

15 0.0000 96.0998 0.0000 7.6022 - - 
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 ชุดเดรสกระโปรงทรงสอบดา้นหลัง 

 

ภาพที่ 4-7 จุดควบคุมของชุดเดรสกระโปรงทรงสอบดา้นหลัง 

ตารางที่ 4-2 แสดงจุดควบคุมของชุดเดรสกระโปรงทรงสอบดา้นหลัง 

เส้นโค้งเส้นที ่ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

1 0.0000 2.2411 27.3090 2.2830 - - 

2 27.3096 2.2830 27.8258 53.5488 - - 

3 27.8258 53.5488 27.7235 58.3441 26.7323 70.7254 

4 26.7323 70.7254 27.7668 85.6800 27.8581 96.1891 

5 27.8581 96.1891 21.2005 97.3226 17.9356 99.5943 

6 17.9356 99.5943 11.7385 104.7370 17.9952 119.1860 

7 17.9952 119.1860 15.8869 119.9110 - - 

8 15.8869 119.9110 13.1266 111.1690 - - 

9 13.1266 111.1690 14.1253 120.5740 - - 

 

เส้นโค้งเส้นที ่ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

16 9.5271 56.2832 13.5472 72.5139 - - 

17 13.5472 72.5139 9.5272 93.1344 - - 

18 9.5272 93.1344 8.0776 72.5146 - - 

19 8.0776 72.5146 9.5271 56.2832 - - 
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4.3.2 ชุดเดรสกระโปรงทรงบาน 

 เสือ้ด้านหน้าชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-8 จุดควบคุมของเสื้อด้านหน้าชุดเดรสกระโปรงทรงบาน 

 

 

 

 

 

 

 

 

เส้นโค้งเส้นที ่ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

10 14.1253 120.5740 12.5390 121.1120 - - 

11 12.5390 121.1120 11.7797 118.8500 10.4602 116.0230 

12 10.4602 116.0230 7.2808 111.6350 0.0000 111.1030 

13 0.0000 111.1030 0.0000 2.2411 - - 

14 13.9141 55.0865 16.7488 71.0203 - - 

15 16.7488 71.0203 13.9143 91.8953 - - 

16 13.9143 91.8953 11.7670 71.0203 - - 

17 11.7670 71.0203 13.9141 55.0865 - - 
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ตารางที่ 4-3 แสดงจุดควบคุมของเสื้อด้านหน้าชุดเดรสกระโปรงทรงบาน 

เส้นโค้งเส้นที ่ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

1 0.0000 0.8386 4.2470 0.8386 - - 

2 4.2470 0.8386 9.6577 25.0512 - - 

3 9.6577 25.0512 15.0533 0.8386 - - 

4 15.0533 0.8386 22.9651 0.8386 - - 

5 22.9651 0.8386 26.7897 21.4238 - - 

6 26.7897 21.4238 13.6844 26.6178 - - 

7 13.6844 26.6178 27.3255 24.7479 - - 

8 27.3255 24.7479 27.7585 28.7037 - - 

9 27.7585 28.7037 20.1187 30.6971 15.6001 38.4594 

10 15.6001 38.4594 13.5319 42.1585 12.6767 49.3444 

11 12.6767 49.3444 8.6102 50.3621 - - 

12 8.6102 50.3621 8.3659 38.9000 - - 

13 8.3659 38.9000 7.8603 34.2522 6.0144 32.9305 

14 6.0144 32.9305 4.2942 31.5567 0.6351 30.3159 

15 0.6351 30.3159 0.0000 28.7041 - - 

16 0.0000 28.7041 0.0000 0.8386 - - 

 เสือ้ด้านหลงัชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-9 จุดควบคุมของเสือ้ดา้นหลังชุดเดรสกระโปรงทรงบาน 
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ตารางที่ 4-4 แสดงจุดควบคุมของเสือ้ดา้นหลังชุดเดรสกระโปรงทรงบาน 

เส้นโค้งเส้นที ่ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

1 0.0000 0.5356 8.0069 0.5356 - - 

2 8.0069 0.5356 12.3934 25.7437 - - 

3 12.3934 25.7437 19.0077 0.5356 - - 

4 19.0077 0.5356 26.8280 0.5357 - - 

5 26.8280 0.5357 29.1033 25.7438 - - 

6 29.1033 25.7438 21.8639 28.3463 18.9999 34.0646 

7 18.9999 34.0646 16.4546 38.6772 15.2601 48.4818 

8 15.2601 48.4818 11.1127 49.1958 - - 

9 11.1127 49.1958 6.0495 46.1521 0.0000 45.9614 

10 0.0000 45.9614 0.0000 0.5356 - - 

 

 กระโปรงชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-10 จุดควบคุมของกระโปรงชุดเดรสกระโปรงทรงบาน 
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ตารางที่ 4-5 แสดงจุดควบคุมของกระโปรงชุดเดรสกระโปรงทรงบาน 

เส้นโค้งเส้นที ่ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

1 0.0000 3.5021 34.7599 3.00977 58.2093 36.7196 

2 58.2093 36.7196 72.6006 69.9787 57.4494 96.9073 

3 57.4494 96.9073 36.7908 129.9760 0.0000 130.102 

4 0.0000 130.1020 0.0000 3.5021 - - 

5 0.0000 50.9905 11.4785 51.8844 13.8226 61.8679 

6 13.8226 61.8679 12.9737 72.6491 0.0000 72.3745 

7 0.0000 72.3745 0.0000 50.9905 - - 

 

4.4 ผลการวิเคราะห์หาพืน้ที่โดยใช้ทฤษฎีของกรีน 

        จากสูตรการหาพืน้ที่ใช้ทฤษฎีของกรนี โดยให้ (x, y) 0f  และ ( , )g x y x  

0
0 0

( )

( )
2

c

A x t dy

x
y x



 
   

 


   

4.4.1 พ้ืนที่ชุดเดรสกระโปรงทรงสอบ 

 พืน้ที่ชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ภาพที่ 4-11 ตารางแสดงพืน้ที่ชุดเดรสกระโปรงทรงสอบดา้นหนา้ 
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 พืน้ที่ชุดเดรสกระโปรงทรงสอบดา้นหลัง 

 

ภาพที่ 4-12 ตารางแสดงพืน้ที่ชุดเดรสกระโปรงทรงสอบดา้นหลัง 

จากภาพที่ 4-11 และ 4-12 เป็นภาพตารางแสดงพืน้ที่ชุดเดรสกระโปรงทรง 

สอบดา้นหนา้และชุดเดรสกระโปรงทรงสอบดา้นหลัง จะเห็นว่าพืน้ที่ชุดเดรสกระโปรง 

ทรงสอบดา้นหนา้ คือพ้ืนที่ทั้งหมดของเสน้โค้งนอกลบดว้ยพ้ืนที่ทั้งหมดของเสน้โค้งใน  

เท่ากับ 4698.3731 ตารางเซนติเมตร และพืน้ที่ชุดเดรสกระโปรงทรงสอบดา้นหลัง คือ 

พ้ืนที่ทั้งหมดของเสน้โค้งนอกลบดว้ยพ้ืนที่ทั้งหมดของเสน้โค้งใน เท่ากับ 5603.6485  

ตารางเซนติเมตร ดังน้ันชุดเดรสกระโปรงทรงสอบมีพืน้ที่ทั้งหมด 10302.0216 ตาราง 

เซนติเมตร 

4.4.2 ชุดเดรสกระโปรงทรงบาน 

 เสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-13 ตารางแสดงพืน้ที่เสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 
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 เสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-14 ตารางแสดงพืน้ที่เสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

 กระโปรงของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-15 ตารางแสดงพืน้ที่กระโปรงชุดเดรสกระโปรงทรงบาน 

จากภาพที่ 4-13, 4-14 และ 4-15 เป็นภาพตารางแสดงพืน้ที่เสื้อด้านหน้า 

ของชุดเดรสกระโปรงทรงบาน เสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน และ 

กระโปรงของชุดเดรสกระโปรงทรงบานจะเห็นว่าพืน้ที่เสื้อด้านหน้าของชุดเดรส 

กระโปรงทรงบาน เท่ากับ 1519.0856 ตารางเซนติเมตร พืน้ที่เสื้อด้านหลังของชุดเดรส 

กระโปรงทรงบาน เท่ากับ 1962.4675 ตารางเซนติเมตร ฉะน้ันเสื้อของชุดเดรส 

กระโปรงทรงบานมพ้ืีนที่ทั้งหมด 3481.5531 ตารางเซนติเมตร และพืน้ที่กระโปรงของ 

ชุดเดรสกระโปรงทรงบาน คือพืน้ที่ทั้งหมดของเสน้โค้งนอกลบดว้ยพ้ืนที่ทั้งหมดของ 

เสน้โค้งใน เท่ากับ 12530.3407 ตารางเซนติเมตร ดังน้ันชุดเดรสกระโปรงทรงบานมี 

พ้ืนที่ทั้งหมด 16011.8938 ตารางเซนติเมตร 
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4.5 ผลการเก็บข้อมูลจุดควบคุมของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจาก                        

จุดมุม และจุดเปลี่ยน 

                เน่ืองจากแบบชุดมสีัดสว่นที่สมมาตร ดังน้ันในการเก็บข้อมูลจุดเสน้โค้งปิดลอ้ม 

วัตถุ พจิารณาจาก จุดมุม และ จุดเปลี่ยนของแบบชุดจึงเก็บข้อมูลเพียงครึ่งชุด โดย 

ตารางที่เป็นสเีขียว      จะเป็นเสน้โค้งเบซิเยร์อันดับที่ 1 และตารางที่เป็นสเีหลอืง       

จะเป็นเสน้โค้งเบซิเยร์อันดับที่ 2 ดังนี ้

                 4.5.1 ชุดเดรสกระโปรงทรงสอบ 

 ชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ภาพที ่4-16 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุพิจารณาจากจุดมุม และจุดเปลี่ยน                                     

ของชุดเดรสกระโปรงทรงสอบดา้นหนา้ 
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ตารางที่ 4-6 แสดงจุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากจุดมุม และจุดเปลี่ยน

ของชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

เส้นโค้งเส้นที ่
P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 

เส้นโค้งนอก 
 

   
 

1 0.0000 7.6023 25.8715 7.5901 -98.3412 

2 25.8715 7.5901 25.7114 56.1846 629.2140 

3 25.7114 56.1846 26.4383 98.0302 517.5342 

4 26.4383 98.0302 20.1000 99.6562 332.1667 

5 20.1000 99.6562 20.7174 118.9070 162.7067 

6 20.7174 118.9070 18.9379 120.1240 118.4040 

7 18.9379 120.1240 9.6804 95.0490 318.5918 

8 9.6804 95.0490 12.2462 121.9020 8.0337 

8 12.2462 121.9020 10.9807 122.3110 79.6378 

9 10.9807 122.3110 8.0207 103.9070 79.9747 

10 8.0207 103.9070 6.4753 101.2790 69.7497 

11 6.4753 101.2790 2.5546 99.6564 193.2909 

12 2.5546 99.6564 0.0000 96.0998 122.7473 

13 0.0000 96.0998 0.0000 7.6023 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของเส้นโค้งนอก 2533.7104 

พื้นที่ Bounding Box ทั้งหมดของเส้นโค้งนอก 5067.4208 

เส้นโค้งใน 
 

    

14 9.6172 56.4840 13.5900 72.5516 -34.9361 

15 13.5900 72.5516 9.5289 92.8569 285.2927 

16 9.5289 92.8569 8.1637 72.1455 -35.2910 

17 8.1637 72.1455 9.6172 56.4840 -116.3618 

พื้นที่ Bounding Box ครึ่งหนึ่งของเส้นโค้งใน 98.7038 

พื้นที่ Bounding Box ทั้งหมดของเส้นโค้งใน 197.4076 

พื้นที่ Bounding Box  ทั้งหมดของชุดเดรสด้านหน้า 4870.0133 
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 ชุดเดรสกระโปรงทรงสอบดา้นหลัง 

 

ภาพที ่4-17 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากจุดมุม และจุดเปลี่ยน              

ของชุดเดรสกระโปรงทรงสอบดา้นหลัง 

ตารางที่ 4-7 แสดงจุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากจุดมุม และจุดเปลี่ยน              

ของชุดเดรสกระโปรงทรงสอบดา้นหลัง 

เส้นโค้งเส้นที ่
P_i P_i+1 

ผลการค านวณ 
X_i Y_i X_i+1 Y_i+1 

เส้นโค้งนอก           

1 0.0000 2.2412 27.3096 2.2830 -30.6026 

2 27.3096 2.2830 27.8258 53.5488 699.4347 

3 27.8258 53.5488 27.8581 96.1891 592.3854 

4 27.8581 96.1891 21.2005 97.3226 335.9829 

5 21.2005 97.3226 17.9356 99.5943 182.9549 

6 17.9356 99.5943 17.9952 119.1860 172.7265 

7 17.9952 119.1860 16.0083 119.9180 124.9916 

8 16.0083 119.9180 13.0790 111.2440 106.2099 

9 13.0790 111.2440 14.1143 120.5300 3.1403 

10 14.1143 120.5300 12.5390 121.0330 98.4852 

11 12.5390 121.1120 10.4602 116.0230 93.9783 
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เส้นโค้งเส้นที ่
P_i P_i+1 

ผลการค านวณ 
X_i Y_i X_i Y_i 

12 10.4602 116.0230 0.0000 111.1030 581.0798 

13 0.0000 111.1030 0.0000 2.2412 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของเส้นโค้งนอก 2960.7670 

พื้นที่ Bounding Box ทั้งหมดของเส้นโค้งนอก 5921.5339 

เส้นโค้งใน      

14 13.8881 55.3056 16.8361 71.043 27.7608 

15 16.8361 71.043 13.8698 91.3392 276.2219 

16 13.8698 91.3392 11.9963 70.8869 -56.2727 

17 11.9963 70.8869 13.8881 55.3056 -160.5109 

พื้นที่ Bounding Box ครึ่งหนึ่งของเส้นโค้งใน 87.1991 

พื้นที่ Bounding Box ทั้งหมดของเส้นโค้งใน 174.3983 

พื้นที่ Bounding Box  ทั้งหมดของชุดเดรสด้านหลัง 5747.1356 

 

4.5.2 ชุดเดรสกระโปรงทรงบาน 

 เสือ้ด้านหน้าชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่4-18 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน 

ของเสื้อด้านหน้าชุดเดรสกระโปรงทรงบาน 
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ตารางที่ 4-8 แสดงจุดควบคุมเสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน 

ของเสื้อด้านหน้าชุดเดรสกระโปรงทรงบาน 

เส้นโค้งเส้นที ่
P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 

1 0.0000 0.8386 15.0533 0.8386 -6.3119 

2 15.0533 0.8386 22.9651 0.8386 -3.3174 

3 22.9651 0.8386 26.9245 21.2890 233.1623 

4 26.9245 21.2890 13.7896 26.5588 210.7578 

5 13.7896 26.5588 27.3747 24.7388 -192.9505 

6 27.3747 24.7388 27.7585 28.7037 49.5216 

7 27.7585 28.7037 15.6001 38.4594 309.8973 

8 15.6001 38.4594 12.6767 49.3444 141.1196 

9 12.6767 49.3444 8.6103 50.3621 106.7788 

10 8.6103 50.3621 8.3660 38.9000 -43.1948 

11 8.3660 38.9000 6.0144 32.9305 20.7671 

12 6.0144 32.9305 0.6351 30.3159 80.7089 

13 0.6351 30.3159 0.0000 28.7041 9.1155 

14 0.0000 28.7041 0.0000 0.8386 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของเสื้อด้านหน้า 916.0544 

พื้นที่ Bounding Box ทั้งหมดของเสื้อด้านหน้า 1832.1088 
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 เสือ้ด้านหลงัชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่4-19 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน 

ของเสื้อด้านหลังชุดเดรสกระโปรงทรงบาน 

ตารางที่ 4-9 แสดงจุดควบคุมเสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน               

ของเสื้อด้านหลังชุดเดรสกระโปรงทรงบาน 

เส้นโค้งเส้นที ่
P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 

1 0.0000 0.5357 8.0565 0.5357 -2.1579 

2 8.0565 0.5357 12.3621 25.5269 99.5177 

3 12.3621 25.5269 18.9141 0.5357 -238.0980 

4 18.9141 0.5357 26.8280 0.5357 -2.1196 

5 26.8280 0.5357 29.1033 25.7438 337.5319 

6 29.1033 25.7438 18.9999 34.0646 251.1313 

7 18.9999 34.0646 15.2601 48.4818 200.6601 

8 15.2601 48.4818 11.1127 49.1958 105.9846 

9 11.1127 49.1958 0.0000 45.9614 255.3776 

10 0.0000 45.9614 0.0000 0.5357 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของเสื้อด้านหลัง 1007.8276 

พื้นที่ Bounding Box ทั้งหมดของเสื้อด้านหลัง 2015.6553 
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 กระโปรงชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่4-20 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน 

ของกระโปรงชุดเดรสกระโปรงทรงบาน 

ตารางที่ 4-10 แสดงจุดควบคุมเสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน              

ของกระโปรงชุดเดรสกระโปรงทรงบาน 

เส้นโค้งเส้นที ่
P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 

เส้นโค้งนอก           

1 0.0000 3.5021 65.3986 3.0098 -114.5162 

2 65.3986 3.0098 65.3986 69.9787 2189.8371 

3 65.3986 69.9787 65.3986 129.9760 1961.8697 

4 65.3986 129.9760 0.0000 130.1020 4254.2443 

5 0.0000 130.1020 0.0000 3.5021 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของเส้นโค้งนอก 8291.4350 

พื้นที่ Bounding Box ทั้งหมดของเส้นโค้งนอก 16582.8699 
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เส้นโค้งเส้นที ่
P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i Y_i 

เส้นโค้งใน      

6 0.0000 51.0914 13.9526 51.2479 -356.4289 

7 13.9526 51.2479 13.9526 72.1516 145.8305 

8 13.9526 72.1516 0.0000 72.2290 503.8912 

9 0.0000 72.2290 0.0000 51.0914 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของเส้นโค้งใน 293.2927 

พื้นที่ Bounding Box ทั้งหมดของเส้นโค้งใน 586.5854 

พื้นที่ทั้งหมดของกระโปรง 15996.2845 

 

4.6 ผลการวิเคราะห์หาพืน้ที่เสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน 

4.6.1 พ้ืนที่ชุดเดรสกระโปรงทรงสอบ 

 พืน้ที่ชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ภาพที่ 4-21 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน        

ของชุดเดรสกระโปรงทรงสอบดา้นหนา้ 
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 พืน้ที่ชุดเดรสกระโปรงทรงสอบดา้นหลัง 

 

ภาพที่ 4-22 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน     

ของชุดเดรสกระโปรงทรงสอบดา้นหลัง 

จากภาพที่ 4-21 และ 4-22 เป็นภาพตารางแสดงพืน้ที่ชุดเดรสกระโปรงทรง 

สอบดา้นหนา้และชุดเดรสกระโปรงทรงสอบดา้นหลัง จะเห็นว่าพืน้ที่ชุดเดรสกระโปรง 

ทรงสอบดา้นหนา้ เท่ากับ 4870.0133 ตารางเซนติเมตร และพืน้ที่ชุดเดรสกระโปรง 

ทรงสอบดา้นหลัง เท่ากับ 5747.1356 ตารางเซนติเมตร ดังน้ันชุดเดรสกระโปรงทรง 

สอบมีพ้ืนที่ทั้งหมด 10617.1489 ตารางเซนติเมตร เมื่อคิดเปอร์เซ็นการสูญเสยีผ้าที่ 

เกิดจากการสร้างเส้นโค้งปิดลอ้มวัตถุ ส าหรับชุดเดรสกระโปรงทรงสอบ จะได้เท่ากับ  

3.0588 % 
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4.6.2 ชุดเดรสกระโปรงทรงบาน 

 เสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-23 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน  

ของเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

 เสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-24 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน 

ของเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 
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 กระโปรงของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-25 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ พิจารณาจากจุดมุม และจุดเปลี่ยน 

ของกระโปรงของชุดเดรสกระโปรงทรงบาน 

จากภาพที่ 4-23, 4-24 และ 4-25 เป็นภาพตารางแสดงพืน้ที่เสื้อด้านหน้า 

ของชุดเดรสกระโปรงทรงบาน เสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน และ 

กระโปรงของชุดเดรสกระโปรงทรงบาน จะเห็นว่าพืน้ที่เสื้อด้านหน้าของชุดเดรส 

กระโปรงทรงบาน เท่ากับ 1832.1088 ตารางเซนติเมตร พืน้ที่เสื้อด้านหลังของชุดเดรส 

กระโปรงทรงบาน เท่ากับ 2015.6553 ตารางเซนติเมตร และพืน้ที่กระโปรงของชุด               

เดรสกระโปรงทรง เท่ากับ 15996.2845 ตารางเซนติเมตร ดังน้ันชุดเดรสกระโปรงทรง 

บานมีพ้ืนที่ทั้งหมด 19844.0486 ตารางเซนติเมตร เมื่อคิดเปอร์เซ็นการสูญเสยีผ้าที่ 

เกิดจากการสร้างเส้นโค้งปิดลอ้มวัตถุ ส าหรับชุดเดรสกระโปรงทรงสอบ จะได้เท่ากับ  

22.8608 % ซึ่งเปอร์เซ็นการสูญเสยีผ้าที่เกิดจากการสร้างเส้นโค้งปิดลอ้มวัตถุ จะ 

เพ่ิมขึ้นหรือลดลงขึน้อยู่กับค่า d หรือระยะห่างที่น้อยที่สุดของเสน้โค้งออฟเซ็ต 
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4.7 ผลการเก็บข้อมูลจุดควบคุมของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจาก                        

เสน้โค้งออฟเซ็ต แบบรูปหลายเหลี่ยม  

เน่ืองจากแบบชุดมสีัดสว่นที่สมมาตร ดังน้ันในการเก็บข้อมูลจุดควบคุมเสน้โค้งปิด 

ลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต แบบรูปหลายเหลี่ยมของแบบชุดจึง 

เก็บข้อมูลเพียงครึ่งชุด โดยตารางที่เป็นสเีขียว      จะเป็นเสน้โค้งเบซิเยร์อันดับที่ 1  

และตารางที่เป็นสเีหลอืง      จะเป็นเสน้โค้งเบซิเยร์อันดับที่ 2 ดังนี้ 

4.7.1 ชุดเดรสกระโปรงทรงสอบ 

 ชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ภาพที ่4-26 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจาก เสน้โค้งออฟเซ็ต                      

แบบรูปหลายเหลี่ยมของชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

ตารางที่ 4-11 แสดงจุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมของชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

เส้นโค้ง

เส้นที ่

P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 

1 0.0000 5.4919 26.2448 5.2723 -72.0674 

2 26.2448 5.2723 28.0022 7.2494 21.3116 

3 28.0022 7.2494 28.0022 56.0177 682.8104 

4 28.0022 56.0177 26.5810 72.7132 273.5615 

5 26.5810 72.7132 29.2171 98.6352 248.6767 

6 29.2171 98.6352 23.0661 118.6260 595.3892 

7 23.0661 118.6260 22.2491 121.2620 78.8598 
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 ชุดเดรสกระโปรงทรงสอบดา้นหลัง 

 

ภาพที ่4-27 จุดควบคุม เสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต                     

แบบรูปหลายเหลี่ยมของชุดเดรสกระโปรงทรงสอบดา้นหลัง 

ตารางที่ 4-12 แสดงจุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมของชุดเดรสกระโปรงทรงสอบดา้นหลัง 

เส้นโค้งเส้นที ่
P_i P_i+1 

ผลการค านวณ 
X_i Y_i X_i+1 Y_i+1 

1 0.0000 0.1181 27.6394 0.0577 -1.6321 

2 27.6394 0.0577 30.1194 2.6558 35.8341 

เส้นโค้งเส้นที ่
P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 

8 22.2491 121.2620 19.4723 123.0190 187.9060 

8 19.4723 123.0190 11.0118 124.4910 534.7327 

9 11.0118 124.4910 8.8783 122.7990 123.4873 

10 8.8783 122.7990 6.0826 104.9210 92.2881 

11 6.0826 104.9210 0.0000 99.4142 302.3494 

12 0.0000 99.4142 0.0000 5.4919 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของชุดเดรสด้านหน้า 3069.3053 

พื้นที่ Bounding Box ทั้งหมดของชุดเดรสดา้นหน้า 6138.6107 
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4.7.2 ชุดเดรสกระโปรงทรงบาน 

 เสือ้ด้านหน้าชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่4-28 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต                        

แบบรูปหลายเหลี่ยมของเสื้อด้านหน้าชุดเดรสกระโปรงทรงบาน 

 

เส้นโค้งเส้นที ่
P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i Y_i 

3 30.1194 2.6558 30.6296 53.3339 762.5192 

4 30.6296 53.3339 29.4205 70.4052 293.6866 

5 29.4205 70.4052 30.6109 96.0844 335.8423 

6 30.6109 96.0844 28.7403 98.6353 128.9104 

7 28.7403 98.6353 19.7271 101.3560 483.6067 

8 19.7271 101.3560 20.5773 118.0220 121.2995 

9 20.5773 118.0220 19.2134 121.2590 113.7895 

10 16.8730 121.9670 13.6843 123.2660 205.4171 

11 13.6843 123.2660 10.7319 121.8490 172.2699 

12 10.7319 121.8490 0.0000 113.2560 607.7260 

13 0.0000 113.2560 0.0000 0.1181 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของของชุดเดรสด้านหลัง 3259.2692 

พื้นที่ Bounding Box ทั้งหมดของของชุดเดรสด้านหลัง 6518.5385 
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ตารางที่ 4-13 แสดงจุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมของเสื้อด้านหน้าชุดเดรสกระโปรงทรงบาน 

เส้นโค้งเส้นที ่
P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 

1 0.0000 -0.2167 4.4643 -0.3250 0.4836 

2 4.4643 -0.3250 5.4935 0.5958 2.2227 

3 5.4935 0.5958 9.6643 19.7168 51.2774 

4 9.6643 19.7168 13.9977 0.5417 -135.3775 

5 13.9977 0.5417 15.0810 -0.2167 -5.6009 

6 15.0810 -0.2167 23.0978 -0.5417 -1.5822 

7 23.0978 -0.5417 24.1811 0.3250 10.3025 

8 24.1811 0.3250 28.0270 21.0710 250.2055 

9 28.0270 21.0710 27.3770 22.2085 22.7884 

10 27.3770 22.2085 22.7728 24.1585 77.8188 

11 22.7728 24.1585 27.1603 23.4544 -61.0149 

12 27.1603 23.4544 28.4061 24.4835 -0.6344 

13 28.4061 24.4835 28.6770 28.3836 52.0770 

14 28.6770 28.3836 27.9186 29.4669 26.2960 

15 27.9186 29.4669 16.3801 38.8443 300.9039 

16 16.3801 38.8443 13.7593 49.6084 139.0601 

17 13.7593 49.6084 12.9316 50.4508 26.3259 

18 12.9316 50.4508 8.9067 51.3868 107.5812 

19 8.9067 51.3868 7.4091 50.2636 33.4767 

20 7.4091 50.2636 7.2219 39.2187 -36.2118 

21 7.2219 39.2187 0.0000 31.2538 112.8561 

22 0.0000 31.2538 0.0000 -0.2167 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของเสื้อด้านหน้า 973.2541 

พื้นที่ Bounding Box ทั้งหมดของเสื้อด้านหน้า 1946.5082 
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 เสือ้ด้านหลงัชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่4-29 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต                   

แบบรูปหลายเหลี่ยมของเสื้อด้านหลังชุดเดรสกระโปรงทรงบาน 

ตารางที่ 4-14 แสดงจุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมของเสื้อด้านหลังชุดเดรสกระโปรงทรงบาน 

เส้นโค้งเส้นที ่
P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 

1 0.0000 -0.5681 7.8621 -0.4545 2.2332 

2 7.8621 -0.4545 9.1034 0.5681 4.3018 

3 9.1034 0.5681 12.7890 20.4513 89.4552 

4 12.7890 20.4513 17.7882 0.3409 -179.7163 

5 17.7882 0.3409 18.8108 -0.4545 -7.2480 

6 18.8108 -0.4545 26.8777 -0.6817 -0.3041 

7 26.8777 -0.6817 27.9003 0.2272 12.5638 

8 27.9003 0.2272 30.0590 25.6778 354.7939 

9 30.0590 25.6778 29.2637 26.8140 27.2873 

10 29.2637 26.8140 20.1105 34.5400 235.7626 

11 20.1105 34.5400 16.5694 48.6666 203.2013 

12 16.5694 48.6666 15.6538 49.5187 29.3390 
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 กระโปรงชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่4-30 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต                     

แบบรูปหลายเหลี่ยมของกระโปรงชุดเดรสกระโปรงทรงบาน 

 

 

 

 

 

 

 

 

 

เส้นโค้งเส้นที ่
P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 

13 15.6538 49.5187 11.5825 50.0868 105.2492 

14 11.5825 50.0868 0.0000 47.0570 272.5189 

15 0.0000 47.0570 0.0000 -0.5681 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของเสื้อด้านหลัง 1149.4377 

พื้นที่ Bounding Box ทั้งหมดของเสื้อด้านหลัง 2298.8753 
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ตารางที่ 4-15 แสดงจุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมของกระโปรงชุดเดรสกระโปรงทรงบาน 

เส้นโค้งเส้นที ่
P_i P_i+1 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 

เส้นโค้งนอก           

1 0.0000 0.0000 68.7306 0.0000 0.0000 

2 68.7306 0.0000 70.1795 132.3300 4547.5601 

3 70.1795 132.3300 0.0000 133.2950 4677.2882 

4 0.0000 133.2950 0.0000 0.0000 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของเส้นโค้งนอก 9224.8484 

พื้นที่ Bounding Box ทั้งหมดของเส้นโค้งนอก 18449.6968 

เส้นโค้งใน      

5 0.0000 55.3436 9.5492 55.3436 -264.2424 

6 9.5492 55.3436 9.5492 68.1535 61.1619 

7 9.5492 68.1535 0.0000 68.3864 326.5163 

8 0.0000 68.3864 0.0000 55.3436 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของเส้นโค้งใน 123.4358 

พื้นที่ Bounding Box ทั้งหมดของเส้นโค้งใน 246.8716 

พื้นที่ทั้งหมดของกระโปรง 18202.8252 
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4.8 ผลการวิเคราะห์หาพื้นที่ เส้นโค้งปิดล้อมวัตถุ โดยการพิจารณาจากเส้นโค้ง                   

ออฟเซ็ต แบบรูปหลายเหลี่ยม 

4.8.1 พ้ืนที่ชุดเดรสกระโปรงทรงสอบ 

 พืน้ที่ชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ภาพที่ 4-31 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมของชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 พืน้ที่ชุดเดรสกระโปรงทรงสอบดา้นหลัง 

 

ภาพที่ 4-32 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมของชุดเดรสกระโปรงทรงสอบดา้นหลัง 
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จากภาพที่ 4-31 และ 4-32 เป็นภาพตารางแสดงพืน้ที่ชุดเดรสกระโปรงทรง

สอบดา้นหน้าและชุดเดรสกระโปรงทรงสอบดา้นหลัง จะเห็นว่าพืน้ที่ชุดเดรสกระโปรงทรงสอบ

ด้านหน้า เท่ากับ 6138.6107 ตารางเซนติเมตร และพื้นที่ชุดเดรสกระโปรงทรงสอบด้านหลัง 

เท่ากับ 6518.5385 ตารางเซนติเมตร ดังน้ันชุดเดรสกระโปรงทรงสอบมีพื้นที่ทั้ งหมด 

10617.1489 ตารางเซนติเมตร เมื่อคิดเปอร์เซ็นการสูญเสียผ้าที่เกิดจากการสร้างเส้นโค้งปิด

ล้อมวัตถุ ส าหรับชุดเดรสกระโปรงทรงสอบ จะได้เท่ากับ 22.8608 % ซึ่งเปอร์เซ็นการสูญเสีย

ผ้าที่เกิดจากการสร้างเส้นโค้งปิดลอ้มวัตถุ จะเพ่ิมขึน้หรือลดลงขึ้นอยู่กับค่า d หรือระยะห่างที่

น้อยที่สุดของเสน้โค้งออฟเซ็ต 

 

4.8.2 ชุดเดรสกระโปรงทรงบาน 

 เสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-33 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 
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 เสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-34 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

 กระโปรงของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-35 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมกระโปรงของชุดเดรสกระโปรงทรงบาน 
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จากภาพที่ 4-33, 4-34 และ 4-35 เป็นภาพตารางแสดงพืน้ที่เสื้อด้านหน้า 

ของชุดเดรสกระโปรงทรงบาน เสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน และ 

กระโปรงของชุดเดรสกระโปรงทรงบาน จะเห็นว่าพืน้ที่เสื้อด้านหน้าของชุดเดรส 

กระโปรงทรงบาน เท่ากับ 1832.1088 ตารางเซนติเมตร พืน้ที่เสื้อด้านหลังของชุดเดรส 

กระโปรงทรงบาน เท่ากับ 2015.6553 ตารางเซนติเมตร และพืน้ที่กระโปรงของชุด              

เดรสกระโปรงทรง เท่ากับ 15996.2845 ตารางเซนติเมตร ดังน้ันชุดเดรสกระโปรงทรง 

บานมีพ้ืนที่ทั้งหมด 19844.0486 ตารางเซนติเมตร เมื่อคิดเปอร์เซ็นการสูญเสยีผ้าที่ 

เกิดจากการสร้างเส้นโค้งปิดลอ้มวัตถุ ส าหรับชุดเดรสกระโปรงทรงบาน จะได้เท่ากับ  

32.7754 % ซึ่งเปอร์เซ็นการสูญเสยีผ้าที่เกิดจากการสร้างเส้นโค้งปิดลอ้มวัตถุ จะ 

เพ่ิมขึ้นหรือลดลงขึน้อยู่กับค่า d หรือระยะห่างที่น้อยที่สุดของเสน้โค้งออฟเซ็ต 

 

4.9 ผลการเก็บข้อมูลจุดควบคุมของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้ง 

ออฟเซ็ต แบบรูปหลายเหลี่ยมและเสน้โค้ง 

เน่ืองจากแบบชุดมสีัดสว่นที่สมมาตร ดังน้ันในการเก็บข้อมูลจุดควบคุมเสน้โค้งปิด 

ลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต แบบรูปหลายเหลี่ยมและเสน้โค้งของ 

แบบชุดจึงเก็บข้อมูลเพียงครึ่งชุดโดยตารางที่เป็นสเีขียว      จะเป็นเสน้โค้งเบซิเยร์ 

อันดับที่ 1 และตารางที่เป็นสเีหลอืง      จะเป็นเสน้โค้งเบซิเยร์อันดับที่ 2 ดังนี้ 

 4.9.1 ชุดเดรสกระโปรงทรงสอบ 

 ชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ภาพที่ 4-36 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต แบบรูป

หลายเหลี่ยมและเสน้โค้งของชุดเดรสกระโปรงทรงสอบดา้นหนา้ 
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ตารางที่ 4-16 แสดงจุดควบคุมเส้นโค้งปิดล้อมวัตถุ โดยการพิจารณาจากเส้นโค้ง  

ออฟเซ็ต แบบรูปหลายเหลี่ยมและเสน้โค้งของชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

 

 

 

 

 

 

 

 

 

 

เส้นโค้ง

เส้นที ่

P_i P_i+1 P_i+2 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

1 0.0000 5.4919 26.2448 5.2723 - - -72.0674 

2 26.2448 5.2723 28.0022 7.2494 - - 21.3116 

3 28.0022 7.2494 28.0022 56.0177 - - 682.8104 

4 28.0022 56.0177 28.1472 63.2671 26.5810 72.7132 459.8881 

5 26.5810 72.7132 28.4874 84.5758 29.2171 98.6352 729.2481 

6 29.2171 98.6352 12.8379 102.8090 23.0661 118.6260 422.0047 

7 23.0661 118.6260 22.2491 121.2620 - - 78.8598 

8 22.2491 121.2620 19.4723 123.0190 - - 187.9060 

8 19.4723 123.0190 11.0118 124.4910 - - 534.7327 

9 11.0118 124.4910 8.8783 122.7990 - - 123.4873 

10 8.8783 122.7990 6.0826 104.9210 - - 92.2881 

11 6.0826 104.9210 0.3864 102.5550 0.0000 99.4142 -11.0891 

12 0.0000 99.4142 0.0000 5.4919 - - 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของชุดเดรสด้านหน้า 3249.3803 

พื้นที่ Bounding Box ครึ่งหนึ่งของชุดเดรสด้านหน้า 6498.7607 
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 ชุดเดรสกระโปรงทรงสอบดา้นหลัง 

 

ภาพที่ 4-37 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต แบบรูป

หลายเหลี่ยมและเสน้โค้งของชุดเดรสกระโปรงทรงสอบดา้นหลัง 

ตารางที่ 4-17 แสดงจุดควบคุมเส้นโค้งปิดล้อมวัตถุ โดยการพิจารณาจากเส้นโค้ง         

ออฟเซ็ต แบบรูปหลายเหลี่ยมและเสน้โค้งของชุดเดรสกระโปรงทรงสอบดา้นหลัง 

เส้นโค้ง

เส้นที ่

P_i P_i+1 P_i+2 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

1 0.0000 0.1181 27.6394 0.0577 - - -1.6321 

2 27.6394 0.0577 30.1194 2.6558 - - 35.8341 

3 30.1194 2.6558 30.6296 53.3339 - - 762.5192 

4 30.6296 53.3339 30.7321 62.5824 29.4205 70.4052 516.8774 

5 29.4205 70.4052 30.8610 85.3705 30.6109 96.0844 777.1712 

6 30.6109 96.0844 28.7403 98.6353 - - 128.9104 

7 28.7403 98.6353 19.7271 101.3560 - - 483.6067 

8 19.7271 101.3560 14.8907 107.1380 20.5773 118.0220 307.3501 

9 20.5773 118.0220 19.2134 121.2590 - - 113.7895 

10 19.2134 121.2590 16.8730 121.9670 - - 148.6988 

11 16.8730 121.9670 13.6843 123.2660 - - 205.4171 

12 13.6843 123.2660 10.7319 121.8490 - - 172.2699 
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เส้นโค้ง

เส้นที ่

P_i P_i+1 P_i+2 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

13 10.7319 121.8490 10.1746 114.5550 0.0000 113.2560 -70.6061 

14 0.0000 113.2560 0.0000 0.1181 - - 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของชุดเดรสด้านหลัง 3249.3803 

พื้นที่ Bounding Box ครึ่งหนึ่งของชุดเดรสด้านหลัง 6498.7607 

 

4.9.2 ชุดเดรสกระโปรงทรงบาน 

 เสือ้ด้านหน้าชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-38 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต แบบรูป

หลายเหลี่ยมและเสน้โค้งของเสื้อด้านหน้าชุดเดรสกระโปรงทรงบาน 

ตารางที่ 4-18 แสดงจุดควบคุมเส้นโค้งปิดล้อมวัตถุ โดยการพิจารณาจากเส้นโค้ง  

ออฟเซ็ต แบบรูปหลายเหลี่ยมและเสน้โค้งของเสื้อด้านหน้าชุดเดรสกระโปรงทรงบาน 

เส้นโค้ง

เส้นที ่

P_i P_i+1 P_i+2 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

1 0.0000 -0.2167 4.4643 -0.3250 - - 0.4836 

2 4.4643 -0.3250 5.4935 0.5958 - - 2.2227 

3 5.4935 0.5958 9.6643 19.7168 - - 51.2774 

4 9.6643 19.7168 13.9977 0.5417 - - -135.3775 

5 13.9977 0.5417 15.0810 -0.2167 - - -5.6009 

6 15.0810 -0.2167 23.0978 -0.5417 - - -1.5822 
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เส้นโค้ง

เส้นที ่

P_i P_i+1 P_i+2 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

7 23.0978 -0.5417 24.1811 0.3250 - - 10.3025 

8 24.1811 0.3250 28.0270 21.0710 - - 250.2055 

9 28.0270 21.0710 27.3770 22.2085 - - 22.7884 

10 27.3770 22.2085 22.7728 24.1585 - - 77.8188 

11 22.7728 24.1585 27.1603 23.4544 - - -61.0149 

12 27.1603 23.4544 28.4061 24.4835 - - -0.6344 

13 28.4061 24.4835 28.6770 28.3836 - - 52.0770 

14 28.6770 28.3836 27.9186 29.4669 - - 26.2960 

15 27.9186 29.4669 19.7897 32.4795 16.3801 38.8443 193.8810 

16 16.3801 38.8443 13.9706 43.8052 13.7593 49.6084 157.9002 

17 13.7593 49.6084 12.9316 50.4508 - - 26.3259 

18 12.9316 50.4508 8.9067 51.3868 - - 107.5812 

19 8.9067 51.3868 7.4091 50.2636 - - 33.4767 

21 7.4091 50.2636 7.2219 39.2187 - - -36.2118 

22 7.2219 39.2187 7.5559 33.1497 0.0000 31.2538 -44.2575 

23 0.0000 31.2538 0.0000 -0.2167 - - 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของชุดเดรสด้านหน้า 673.9741 

พื้นที่ Bounding Box ครึ่งหนึ่งของชุดเดรสด้านหน้า 1347.9481 
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 เสือ้ด้านหลงัชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-39 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต แบบรูป

หลายเหลี่ยมและเสน้โค้งของเสื้อด้านหลังชุดเดรสกระโปรงทรงบาน 

ตารางที่ 4-19 แสดงจุดควบคุมเส้นโค้งปิดล้อมวัตถุ โดยการพิจารณาจากเส้นโค้ง 

ออฟเซ็ต แบบรูปหลายเหลี่ยมและเสน้โค้งของเสื้อด้านหลังชุดเดรสกระโปรงทรงบาน 

เส้นโค้ง

เส้นที ่

P_i P_i+1 P_i+2 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

1 0.0000 -0.5681 7.8621 -0.4545 - - 2.2332 

2 7.8621 -0.4545 9.1034 0.5681 - - 4.3018 

3 9.1034 0.5681 12.7890 20.4513 - - 89.4552 

4 12.7890 20.4513 17.7882 0.3409 - - -179.7163 

5 17.7882 0.3409 18.8108 -0.4545 - - -7.2480 

6 18.8108 -0.4545 26.8777 -0.6817 - - -0.3041 

7 26.8777 -0.6817 27.9003 0.2272 - - 12.5638 

8 27.9003 0.2272 30.0590 25.6778 - - 354.7939 

9 30.0590 25.6778 29.2637 26.8140 - - 27.2873 

10 29.2637 26.8140 22.3612 29.4272 20.1105 34.5400 180.9293 
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เส้นโค้ง

เส้นที ่

P_i P_i+1 P_i+2 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

11 20.1105 34.5400 16.6626 41.9441 16.5694 48.6666 251.5850 

12 16.5694 48.6666 15.6538 49.5187 - - 29.3390 

13 15.6538 49.5187 11.5825 50.0868 - - 105.2492 

14 11.5825 50.0868 6.3699 46.9623 0.0000 47.0570 -24.3451 

15 0.0000 47.0570 0.0000 -0.5681 - - 0.0000 

พื้นที่ Bounding Box ครึ่งหนึ่งของชุดเดรสด้านหลัง 846.1242 

พื้นที่ Bounding Box ครึ่งหนึ่งของชุดเดรสด้านหลัง 1692.2483 

 

 กระโปรงชุดเดรสกระโปรงทรงบาน 

 

ภาพที ่4-40 จุดควบคุมเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต                     

แบบรูปหลายเหลี่ยมและเสน้โค้งของกระโปรงชุดเดรสกระโปรงทรงบาน 
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ตารางที่ 4-20 แสดงจุดควบคุมเส้นโค้งปิดล้อมวัตถุ โดยการพิจารณาจากเส้นโค้ง

ออฟเซ็ต แบบรูปหลายเหลี่ยมและเสน้โค้งของกระโปรงชุดเดรสกระโปรงทรงบาน 
 

 

4.10 ผลการวิเคราะห์หาพื้นที่ เส้นโค้งปิดล้อมวัตถุ โดยการพิจารณาจากเส้นโค้ง                  

ออฟเซ็ต แบบรูปหลายเหลี่ยมและเสน้โค้ง 

4.10.1 พ้ืนที่ชุดเดรสกระโปรงทรงสอบ 

 พืน้ที่ชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

ภาพที่ 4-41 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดล้อมวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมและเสน้โค้งของชุดเดรสกระโปรงทรงสอบดา้นหนา้ 

 

เส้นโค้ง     

เส้นที ่

P_i P_i+1 P_i+2 ผลการ

ค านวณ X_i Y_i X_i+1 Y_i+1 X_i+2 Y_i+2 

เสน้โค้งนอก        

1 0.0000 0.4816 38.4219 0.6477 61.4130 35.3230 1512.6813 

2 61.4130 35.3230 76.3859 65.5771 60.4784 98.1040 4148.9950 

3 60.4784 98.1040 39.7238 131.8330 0.0000 132.7310 1487.4949 

4 0.0000 132.7310 0.0000 0.4816 - - 0.0000 

เสน้โค้งใน        

6 0.0000 55.4908 8.1678 54.9642 9.4410 62.7613 2.2332 

7 9.4410 62.7613 7.4190 69.4643 0.0000 68.0696 4.3018 

8 0.0000 68.0696 0.0000 55.4908 - - 89.4552 

พื้นที่ Bounding Box ครึ่งหนึ่งของเส้นโค้งใน 98.3465 

พื้นที่ Bounding Box ทั้งหมดของเส้นโค้งใน 196.6930 

พื้นที่ทั้งหมดของกระโปรง 14101.6495 
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 พืน้ที่ชุดเดรสกระโปรงทรงสอบดา้นหลัง 

 

ภาพที่ 4-42 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมและเสน้โค้งของชุดเดรสกระโปรงทรงสอบดา้นหลัง 

จากภาพที่ 4-41 และ 4-42 เป็นภาพตารางแสดงพืน้ที่ชุดเดรสกระโปรงทรง 

สอบดา้นหนา้และชุดเดรสกระโปรงทรงสอบดา้นหลัง จะเห็นว่าพืน้ที่ชุดเดรสกระโปรง 

ทรงสอบดา้นหนา้ เท่ากับ 6498.7607 ตารางเซนติเมตร และพืน้ที่ชุดเดรสกระโปรง 

ทรงสอบดา้นหลัง เท่ากับ 7160.4126 ตารางเซนติเมตร ดังน้ันชุดเดรสกระโปรงทรง 

สอบมีพ้ืนที่ทั้งหมด 13659.1733 ตารางเซนติเมตร เมื่อคิดเปอร์เซ็นการสูญเสยีผ้าที่ 

เกิดจากการสร้างเส้นโค้งปิดลอ้มวัตถุ ส าหรับชุดเดรสกระโปรงทรงสอบ จะได้เท่ากับ  

11.0920 % 

4.10.2 ชุดเดรสกระโปรงทรงบาน 

 เสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-43 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมและเสน้โค้งของเสื้อด้านหน้าของชุดเดรสกระโปรงทรงบาน 
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 เสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-44 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมและเสน้โค้งของเสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน 

 กระโปรงของชุดเดรสกระโปรงทรงบาน 

 

ภาพที่ 4-45 ตารางแสดงพ้ืนที่ของเสน้โค้งปิดลอ้มวัตถุ โดยการพิจารณาจากเส้นโค้งออฟเซ็ต 

แบบรูปหลายเหลี่ยมและเสน้โค้งของกระโปรงของชุดเดรสกระโปรงทรงบาน 

จากภาพที่ 4-43, 4-44 และ 4-45 เป็นภาพตารางแสดงพืน้ที่เสื้อด้านหน้า 

ของชุดเดรสกระโปรงทรงบาน เสื้อด้านหลังของชุดเดรสกระโปรงทรงบาน และ

กระโปรงของชุดเดรสกระโปรงทรงบาน จะเห็นว่าพื้นที่เสื้อด้านหน้าของชุดเดรส

กระโปรงทรงบาน เท่ากับ 1347.9481 ตารางเซนติเมตร พื้นที่เสื้อดา้นหลังของชุดเดรส

กระโปรงทรงบาน เท่ากับ 1692.2483 ตารางเซนติเมตร และพื้นที่กระโปรงของชุด               

เดรสกระโปรงทรง เท่ากับ 14101.6495 ตารางเซนติเมตร ดังน้ันชุดเดรสกระโปรงทรง

บานมีพ้ืนที่ทั้งหมด 17141.8459 ตารางเซนติเมตร เมื่อคิดเปอร์เซ็นการสูญเสียผ้าที่

เกิดจากการสร้างเส้นโค้งปิดล้อมวัตถุ ส าหรับชุดเดรสกระโปรงทรงสอบ จะได้เท่ากับ 

7.0569 %



 
 

บทท่ี 5 

 

บทสรุป 

 

ในบทนี้จะท าการสรุปผลของการด าเนินงานทั้งหมดตลอดจนน าเสนอข้อเสนอแนะเพ่ือ

ใช้ส าหรับผู้ที่ต้องการศึกษาค้นคว้าโดยการสรุปผลจะอ้างอิงจากผลการด าเนินงานการศึกษา

อิสระ ในบทที่ 4 

5.1 อภิปรายและสรุปผลการด าเนนิการวิจัย 

การศึกษาอิสระน้ี IS เล่มนี้ มีจุดมุ่งหมายเพ่ือออกแบบชุดใช้เส้นโค้ง Bezier อันดับ 1 

และอันดับ 2 จากโปรแกรม Blender และน าค่าจุดควบคุมของแต่ละเส้นโค้ง Bezier อันดับ 1 

และอันดับ 2 มาวิเคราะห์หาค่าพืน้ที่โดยใช้ทฤษฎีของกรีนและ Bounding box ของแบบชุด และ

ผู้จัดท าได้ท าการสร้างสูตรที่ใช้ในการหาขนาดของมุมระหว่างเวกเตอร์สัมผัสหน่ึงหน่วย และ

สูตรการหาพ้ืนที่โดยใช้ทฤษฎีของกรีน ของเส้นโค้ง Bezier อันดับ 1 และอันดับ 2 โดยสามารถ

สรุปได้ดังน้ี 

1. การออกแบบชุดในโปรแกรม Blender จ านวน 2 ชุด ได้แก่ชุดเดรสกระโปรสทรงสอบ

และชุดเดรสกระโปรงทรงบาน โดยใช้เสน้โค้ง Bezier อันดับ 1 และอันดับ 2 พบว่า การออกแบบ

ชุดที่เสมอืนจริงน้ัน ชุดเดรสกระโปรสทรงสอบตอ้งใช้เสน้โค้ง Bezier อันดับ 1 จ านวน 25  เสน้ 

50 จุดควบคุมและเสน้โค้ง Bezier อันดับ 2 จ านวน 11 เสน้ 33 จุดควบคุม และชุดเดรส                 

กระโปรสทรงบานต้องใช้เสน้โค้ง Bezier อันดับ 1 จ านวน 21  เสน้ 42 จุดควบคุมและเสน้โค้ง 

Bezier อันดับ 2 จ านวน 12 เสน้ 36 จุดควบคมุ ซึ่งข้อมูลของจุดควบคุมทั้งหมดจะรวบรวมไว้ใน

ฐานข้อมูลของ Microsoft Excel 

2. ศึกษาการเช่ือมเส้นโค้ง Bezier ให้ราบเรียบโดยการใช้นิยามของการเช่ือมกันของ

เส้นโค้ง Bezier แบบ 0 0 1 1
C ,G ,C และ G พบว่าเป็นการเช่ือมเส้นโค้ง Bezier แบบ 0 0

C G, โดยใช้

จุดปลายของเสน้โค้ง Bezier เสน้หน่ึงต่อกับจุดเร่ิมต้นของเส้นโค้ง Bezier อีกเสน้หน่ึง ตามแบบ

ชุดที่ได้ท าการออกแบบไว้
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3. น าจุดควบคุมที่รวบรวมไว้ในฐานข้อมูลมาวิเคราะห์หา Cusp Point, Corner Point, 

Inflection Point, Turning Point และ Offset Curves เพ่ือน าค่าที่ได้มาสร้าง Bounding box และ

วิเคราะห์หาพ้ืนที่โดยใช้ทฤษฎีของกรีนและการหาพืน้ที่ของรูปหลายเหลี่ยม เพ่ือทราบพื้นที่ของ

ผ้าที่ต้องใช้ในการตัดชุด ทราบพ้ืนที่ Bounding box ของแบบชุด และเปอร์เซ็นการสูญเสยีผ้าที่

เกิดจากการสร้าง Bounding box 

5.2 ข้อเสนอแนะ 

5.2.1. การออกแบบชุดในโปรแกรม Blender ต้องระมัดระวังในการสร้างให้อยูใ่น                  

จตุภาค ที่ 1 เพ่ือให้สะดวกในการเก็บข้อมูลของจุดควบคุม 

5.2.2. การแปลงสูตรต่าง ๆ ให้อยู่ในรูปของเส้นโค้ง Bezier อันดับ 1 และอันดับ 2 ต้อง

มีความละเอียด รอบคอบ
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ประวัติผู้วิจัย 

 

ช่ือ – สกุล  : นางสาวฐิตาภา จันต๊ะคาด 

วัน/เดอืน/ปีเกิด  : 6 ตุลาคม 2539 

ประวัตกิารศึกษา : ช้ันมัธยมศึกษาตอนต้น  โรงเรียนเชียงของวิทยาคม 

     ช้ันมัธยมศึกษาตอนปลาย โรงเรียนเชียงของวิทยาคม 

     ปัจจุบันศึกษาอยู่ที ่  มหาวิทยาลัยพะเยา 

ที่อยู่ปัจจุบัน  : 56 หมู ่6 ต าบลเวียง อ าเภอเชียงของ จังหวดัเชียงราย 57140 

เบอร์ติดต่อ  : 087-566-4869 

อีเมล   : Nutty.titapa@gmail.com 
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ช่ือ – สกุล  : นางสาวนติยา กล่ินนวล 

วัน/เดอืน/ปีเกิด  : 17 กุมภาพันธ์ 2540 

ประวัตกิารศึกษา : ช้ันมัธยมศึกษาตอนต้น  โรงเรียนกงไกรลาศวิทยา 

     ช้ันมัธยมศึกษาตอนปลาย โรงเรียนกงไกรลาศวิทยา 

     ปัจจุบันศึกษาอยู่ที ่  มหาวิทยาลัยพะเยา 

ที่อยู่ปัจจุบัน  : 28/1 หมู ่4 ต าบลกง อ าเภอกงไกลาศ จังหวดัสุโขทัย 64170 

เบอร์ติดต่อ  : 092-546-4748 

อีเมล   : poynittaya17@gmail.com 
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ช่ือ – สกุล  : นางสาวเมษ์ทิวา แก้วยา 

วัน/เดอืน/ปีเกิด  : 16 เมษายน 2540 

ประวัตกิารศึกษา : ช้ันมัธยมศึกษาตอนต้น  โรงเรียนพะเยาพิทยาคม 

     ช้ันมัธยมศึกษาตอนปลาย โรงเรียนพะเยาพิทยาคม 

     ปัจจุบันศึกษาอยู่ที ่  มหาวิทยาลัยพะเยา 

ที่อยู่ปัจจุบัน  : 141 หมู ่9 ต าบลบา้นใหม่ อ าเภอเมอง จ.พะเยา 56000 

เบอร์ติดต่อ  : 088-291-6595 

อีเมล   : maytiwa.keawya@gmail.com 

 

 

 

 

 

 

 


